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Typographic Conventions 

Type Style Description 

Example Words or characters quoted from the screen. These include field names, screen titles, 

pushbuttons labels, menu names, menu paths, and menu options. 

Textual cross-references to other documents. 

Example Emphasized words or expressions. 

EXAMPLE Technical names of system objects. These include report names, program names, 

transaction codes, table names, and key concepts of a programming language when they 

are surrounded by body text, for example, SELECT and INCLUDE. 

Example Output on the screen. This includes file and directory names and their paths, messages, 

names of variables and parameters, source text, and names of installation, upgrade and 

database tools. 

Example Exact user entry. These are words or characters that you enter in the system exactly as 

they appear in the documentation. 

<Example> Variable user entry. Angle brackets indicate that you replace these words and characters 

with appropriate entries to make entries in the system. 

EXAMPLE  Keys on the keyboard, for example, F2  or ENTER . 
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1 Introduction 

This document helps you to configure Focused Build Requirement-to-Deploy scenario for SAP Solution Manager 

with SAP Solution Manager 7.2. SPS 5 or higher as well as the standalone extensions. You don't have to work 

through the guide from A to Z. Just utilize the chapter with your specific scenario or use case you have in scope. 

• The chapter Configuration of Focused Build Requirement-to-Deploy comprises the configuration for the 

entire requirement to deploy scenario. 

In the chapter Configuration of Standalone Extensions, you find information about the configuration required 

for each standalone extension delivered in ST-OST. 

The document does not cover the following topics: 

• SAP Reporting and Dashboarding Service: Dashboard Factory 

• SAP Solution Manager Rapid Deployment Solution for Change Control Management 

• SAP Solution Manager Rapid Deployment Solution for Solution Documentation 

 Target Group 

This document targets technical consultants, application consultants, and support consultants who plan to 

perform the configuration of the component ST-OST 200 (Focused Build). 

 Overview of Focused Build for SAP Solution Manager 

Focused Build for SAP Solution Manager is a turnkey solution that starts with the creation of requirements in 

Process Management (Solution Documentation). For these requirements, you create work packages, which are 

then broken down to work items, which are subsequently implemented. The go-live process can involve individual 

changes, groups of changes, or planned releases that are in line with a release plan and controlled by release 

phases. 

 General 

You can download the setup and configuration guide for Focused Build 'Refresh Test System' from the SAP 

Software Download Center at support.sap.com/swdc.  

For more information about Focused Build Solutions, refer to the SAP Support Portal at 

https://support.sap.com/en/solution-manager/focused-solutions.html 

https://support.sap.com/swdc
https://support.sap.com/en/solution-manager/focused-solutions.html
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2 Configuration of Focused Build 
Requirement-to-Deploy 

 Basic Configuration of SAP Solution Manager 

2.1.1 Creating a Demo Landscape in SAP Solution Manager 

You create clients, for example, 801 (development system), 802 (quality assurance system), 803 (regression 

testing), and 804 (productive system), in your SAP Solution Manager development system to simulate a 

transport landscape (DEV-QAS-REG-PRD).  

 

The following sections describe how you can generate a new client or copy an existing client. 

Generating Clients 

 Call transaction SCC4 and create a new client. 

 Log off from the system. 

 Log on to the new client with user SAP* and password PASS. 

Copying Clients 

 Call transaction SCCL. 

 Use the following parameters: 

Profile: SAP_CUST (if disk capacity is an issue, you can choose SAP_ALL instead) 

Source Client: 001 

If required, you can copy existing users from the working client with profile SAP_USER. 
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 Note 

Creating transport routes and RFC destinations is described in section Error! Reference source not found.. 

2.1.2 Configuring Transport Management System (TMS) 

The following sections describe how you configure the Transport Management System (TMS).  

 Note 

Make sure that your transport domain has been configured correctly. For more information, call 

transaction STMS and choose Help → Application Help → Transport Management System. 

Existing settings should already have been configured for the working client in SAP Solution Manager. Do not 

change these settings. Create additional entries only for simulation clients. 

Activating Extended Transport Control 

 Call transaction STMS. 

 Choose Overview → Systems. 

 Double-click the row containing your system. 

The Change TMS Configuration: System <system ID> screen appears. 

 Choose the Transport Tool tab page. 

 If it is not already there, add a row for the CTC parameter: In the Parameters column, enter CTC. 

 In the Value column, enter 1 for the CTC parameter.  

 Save your entries.  

 

Configuring the Transport Strategy 

The QA approval procedure is not compatible with the approval procedure used in Change Request Management. 

In the Transport Management System, you therefore must deactivate the QA approval procedure in transport 

tracks in which the software distribution is controlled by Change Request Management.  
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You also activate the single transport strategy because this prevents you from accidentally executing Import All. 

All transports within the system landscape of Change Request Management must be processed by project 

imports.  

Proceed as follows: 

 Call transaction STMS. 

 Choose Overview → Transport Routes. 

 Double-click your system. 

You see the Display System Attributes dialog box. 

 In the Transport strategy group box, select Single transports (because only Import Single and Import Project 

All are used). 

 In the Quality assurance group box, deselect Delivery after confirmation. 

 Choose Continue.  

 

Checking TMS Parameters 

 Call transaction STMS. 

 Choose Overview and then Systems. 

 Double-click your system. 

You see the Display TMS Configuration: System <system ID> screen. 

 Check that the parameters are set as follows: 

Parameter Value 

CTC 1 

IMPORT_SINGLE_ONLY 1 

IMPORT_SINGLE_STRATEGY 1 

NO_IMPORT_ALL 1 

WORKFLOW_STRATEGY 0 



 

12 

CUSTOMER  

© 2018 SAP SE or an SAP affiliate company. All rights reserved. 

Focused Build for SAP Solution Manager 

Configuration of Focused Build Requirement-to-Deploy 

 

Activating TMS Trusted Services for All Transport Domains Involved 

TMS Trusted Services are used by Change Request Management to trigger transports in managed systems 

remotely. You must activate this service in all domain controller systems that may be involved in Change Request 

Management processes. 

 Log on to the domain controller system in client 000. 

 Call transaction STMS and choose System Overview.  

 Choose Goto and then Transport Domain. 

 On the Management tab page in the Security Options group box, set the trusted services to Active. 

 Save and distribute this configuration.  

 

Creating a Transport Layer 

 Call transaction STMS and choose Transport Routes.  

 Switch to change mode and choose Edit.  

 Choose Transport Layer and then Create. 

 Create transport layers ZPRJ (for project) and ZMAN (for maintenance).  

 

Creating a Transport Route 

 Call transaction STMS and choose Transport Routes.  

 Switch to change mode and choose Edit. Choose Transport Route and then Create. 

 Create a consolidation. 
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 Place the cursor on the Transport Routes entry and choose Create. 

 Activate the extended transport control (press F6 ). 

 Create a delivery. 

 Note 

The following screenshots are examples only. 

 

 

 

 

 Adopt the existing transport routes.  
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Assigning a Transport Layer to a Client 

In your simulation landscape, assign the transport layer that you have created earlier to the development system 

client (801). 

 Call transaction STMS. 

 Choose Overview and then Transport Routes. 

 Double-click your system. 

You see the Display System Attributes dialog box. 

 Choose the Standard Transport Layer tab page. 

 Create an entry at the client level for the development system client (801) and the transport layer. 

 Save and distribute.  

 

Setting the Mandatory Project Assignment  

 Call transaction SE03. 

 Under Administration, double-click Display/Change Request Attributes. 

 Double-click the attribute SAP_CTS_PROJECT.  

 Make sure that the client-specific settings contain an entry for the development system client (801) and that 

the Required checkbox is selected. 

 Caution 

Do not activate this parameter system-wide! Only activate it for the development system client. 
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2.1.3 Implementing Mandatory SAP Notes 

 

SAP Note Description SAP 

Solution 

Manager 

Managed 

System 

2395850 CL_AI_CRM_IM_CATE_HELP=>GET_MULT_CATE_LIST_F4 

does not return correct category levels 

X  

1818804 Change Request Management:  

Enable client restriction for import subsets  

 X 

1731806  Change Request Management:  

Support of multi-client import  

 X 

2468171 ChaRM: Dump DBIF_RSQL_TABLE_UNKNOWN for table 

/SDF/TMW_ADM on shadow systems 

X X 

2335056 ChaRM: runtime error PERFORM_PARAMETER_MISSING 

during creation of transport of copies 

 X 

 

2.1.4 Maintaining Number Ranges 

To maintain the number ranges, check that in SAP Solution Manager Configuration (transaction solman_setup) 

in the Change Request Management scenario in the Check Prerequisites step (1.1), the activity Adapt Number 

Ranges is executed successfully. 

http://service.sap.com/sap/support/notes/1818804
http://service.sap.com/sap/support/notes/1731806
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2.1.5 Related Documentation 

For more information about SAP Change Request Management, go to SAP Help Portal at 

https://help.sap.com/viewer/p/SAP_Solution_Manager, select version 7.2 SPS 3. Open the application help and 

select Change Request Management. 

For more information about assigning roles, see the security guides for SAP Solution Manager at 

https://help.sap.com/viewer/p/SAP_Solution_Manager. 

Setting Up Component ST-OST 200 

Where necessary, the support consultant must perform the following activities along with the basis team of the 

customer. 

 Caution 

It is important that you follow the sequence of set-up steps described in the following sections. In 

particular, you have to activate the piece list before you activate the BC sets.  

2.1.6 Activating the Piece List 

Call transaction SCC1 in your working client and activate the piece list /SALM/72_CUSTOMIZING, which will 

supply your system with the predefined customizing. Copy the customizing by putting the piece list into the the 

Transport Request field. The result of this activation can be verified in transaction SCC3. 

2.1.7 Important SAP Notes 

Before you set up component ST-OST 200, make sure that you have read and considered the central SAP Note: 

SAP Note Description 

2541761 Focused Build: Release Planning 

2483056 Central Note for Focused Build 2.0 SP01 for SAP Solution Manager 7.2 

 Note 

SAP Note 2483056 must be implemented via transaction SNOTE after the piece list activation (refer to 

chapter Error! Reference source not found. Error! Reference source not found.). 

2.1.8 Transaction Types 

Focused Build uses the following transaction types: 

Transaction Type Description Usage 

S1MT Master Work Package  

https://help.sap.com/viewer/p/SAP_Solution_Manager
http://help.sap.com/saphelp_sm72_sp03/helpdata/en/4c/3acb82b50843b4e10000000a42189e/content.htm?frameset=/en/2b/614e1cb8204f35b477eac703073589/frameset.htm&current_toc=/en/37/24fe53582e0114e10000000a174cb4/plain.htm&node_id=588&show_children=false
https://help.sap.com/viewer/p/SAP_Solution_Manager
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Transaction Type Description Usage 

S1IT Work Package Project Management without 

Portfolio Management 

S2IT Work Package Project Management with 

Portfolio Management (SAP 

Portfolio and Project 

Management) 

S3IT IT Requirement Without Project Management 

S1CG Work Item Work Item without transport 

requests 

S1CR Request for Change (RM)  

S1HF Urgent Change with TMS (Project 

Management) 

 

S1MJ Work Item  

S1MR Release Release Cycle Document 

S1RK Risk  

S1TM Defect Correction IT Correction of a defect during 

testing 

S1TR Test Request  

S1DM Defect Message  

S3CR Request for Change  

S4CT Request for Change Template for 

Simple Service Request 

Simple Service Request 

S4IT Incident Template for Simple 

Service Request 

Simple Service Request 

S4PT Problem Template for Simple 

Service Request 

Simple Service Request 

S4ST Service Request for Simple 

Service Request 

Simple Service Request 

2.1.9 Setup Steps 

It is important that you follow the sequence of set-up steps in this outline. 

Maintain Transaction Types 

To perform the customization, call transaction DNO_CUST04 and enter the following data: 
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Field Name Sequence No Field Value 

CHARM_ADD According to customer 

requirements 

S1IT 

CHARM_ADD According to customer 

requirements 

S1RK 

CHARM_ADD According to customer 

requirements 

S1CR 

CHARM_ADD According to customer 

requirements 

S1MJ 

CHARM_ADD According to customer 

requirements 

S1CG 

CHARM_ADD According to customer 

requirements 

S1TR 

CHARM_ADD According to customer 

requirements 

S1HF 

CHARM_ADD According to customer 

requirements 

S1BR 

CHARM_ADD According to customer 

requirements 

S1MT 

CHARM_ADD According to customer 

requirements 

S1IR 

PROCESS_TYPE_ADD According to customer 

requirements 

SMFG 

PROCESS_TYPE_ADD According to customer 

requirements 

S1DM 

SMUD_TYPE_S1BR According to customer 

requirements 

FBBR 

Project Management Configuration 

To get the project management working, standard customizing entries from client 000 must be copied into the 

working client. 

 Call transaction /n/RPM/CUST_COPY. 

 Copy all customizing tables, starting with /RPM/* and INM*, to the current / working client from client 000.  

Activating Services 

Activate all services for IT Service Management, Change Request Management, and Product and Portfolio 

Management. 

 Call transaction SICF_INST and activate the following services: 

 SM_CHARM  

 SM_CRM_UI 
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If the services are activated successfully, you see a green traffic light icon. 

 Go to transaction SICF and activate all of the services below the /default_host/sap/bc/bsp/salm  and 

/default_host/sap/bc/webdynpro/salm nodes. 

 Activate all services in  /default_host/sap/bc/ui5_ui5/salm. 

 Activate all services in  /default_host/sap/bc/ui5_ui5/stdf/libs 

 Activate all services in /default_host/sap/bc/webdynpro/rpm. 

 Activate all services in /default_host/sap/opu/odata/salm. 

 Activate the UI5 library services /default_host/sap/bc/bsp/stdf/ui5 and libs. 

 If you like to add the log off page for the SAP Solution Manager launchpad follow the instructions under: 

http://help.sap.com/fiori_bs2013/helpdata/en/c6/a414539196e50be10000000a441470/content.htm?fra

meset=/en/b7/383953fcabff4fe10000000a44176d/frameset.htm&current_toc=/en/fc/4a4c52eea9c871e

10000000a44176d/plain.htm&node_id=8   

 Here you should enter the following URL at Redirect to URL: 

http://<host>:<port>/sap/bc/ui5_ui5/ui2/ushell/shells/abap/Fiorilaunchpad.html  

 

Checking and Maintaining System Roles 

The initially delivered set of customizing is based on the following set of system roles: 

System Role Source Type of Role Description 

C SAP D - Source System Development System 

http://help.sap.com/fiori_bs2013/helpdata/en/c6/a414539196e50be10000000a441470/content.htm?frameset=/en/b7/383953fcabff4fe10000000a44176d/frameset.htm&current_toc=/en/fc/4a4c52eea9c871e10000000a44176d/plain.htm&node_id=8
http://help.sap.com/fiori_bs2013/helpdata/en/c6/a414539196e50be10000000a441470/content.htm?frameset=/en/b7/383953fcabff4fe10000000a44176d/frameset.htm&current_toc=/en/fc/4a4c52eea9c871e10000000a44176d/plain.htm&node_id=8
http://help.sap.com/fiori_bs2013/helpdata/en/c6/a414539196e50be10000000a441470/content.htm?frameset=/en/b7/383953fcabff4fe10000000a44176d/frameset.htm&current_toc=/en/fc/4a4c52eea9c871e10000000a44176d/plain.htm&node_id=8
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System Role Source Type of Role Description 

D SAP O - Target System Demo System 

T SAP O - Target System Quality Assurance System 

E SAP O - Target System Training System 

P SAP P - Production System Production System 

S SAP O - Target System SAP Reference System 

V SAP S - Single System Evaluation System 

0 CUSTOMER R - Post-Processing 

System 

Retrofit System 

1 CUSTOMER O - Target System Pre-Production System 

2 CUSTOMER O - Target System Maintenance Development 

System 

3 CUSTOMER O - Target System Test System 

The existing roles can be checked via transaction SM30 via view SMSY_ROLES. If the given system has a different 

set of system roles there are 2 options: 

 Adjust the release dashboard customizing or 

 Adjust the system roles, if possible. 

Create additional (or adjust) system roles via transaction MAINT_ROLES: 

 

Use up- and down- buttons to change order of system roles according to sequence transport landscape. If of an 

already defined set of system roles at the customer the customizing of the release dashboard and batch import 

must be adjusted accordingly. 

In the Customizing of SAP Solution Manager, choose SAP Solution Manager → Focused Build → Dashboard 

Configurations → Document KPI Framework you can adjust the system role dependencies. 
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 Recommendation 

It is recommended to have different system roles for different systems, e.g. the development system in 

the development branch gets the system role C-Development System and the other development system 

in the maintenance branch 2-Maintenance Development System. 

Maintain the Table HTTPURLLOC 

Go to transaction SE16 and maintain the new /WEBDYNPRO/SALM/* entry in table HTTPURLLOC. 

Depending on the current configuration in table HTTPURLLOC, a new entry needs to be maintained to open Web 

Dynpro applications of Focused Build with the correct URL. 

If the table is maintained, add the new /WEBDYNPRO/SALM/* entry after the entry /WEBDYNPRO/SAP/*, but 

before entry /*. 

 Note 

Further information can be found here: How to maintain the table HTTPURLLOC 

Background Processing 

Import Control in Requirement-to Deploy 

The Import Control in requirement-to-release scenario provides various options for mass deployment. Standard 

Import Customizing defines deployment rules for imports executed from a task list that import normal changes as 

preliminary import status and urgent changes. 

Batch Import Customizing defines deployment rules for imports in a release context. 

/SALM/BATCH_IMPORT_TRIGGER manages the import of normal changes. 

After successfully activating the piece list you can continue with adjustments of the standard customization and 

maintaining the system related data. The following import variants are delivered via the piece list: 

• /SALM/COLLECTIVE_IMPORT 

For imports between 2 releases. 

• /SALM/RELEASE 

For imports into PRE-PRD and PRD of everything included into 1 release.  

• /SALM/INTEGRATION_TEST 

For imports of Defect Corrections while release test phase into PRE-PRD.  

• /SALM/QAS 

For imports into QAS.  

https://wiki.scn.sap.com/wiki/pages/viewpage.action?pageId=462054974
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Proceed as follows: 

 In the Customizing of SAP Solution Manager, choose SAP Solution Manager → Focused Build → Release 

Deployment and Batch Import → Configure Release Deployment & Batch Import. A default customization is 

already provided by the piece list. Thus, an adjustment of the Batch Import Variants node is not mandatory. 

Data you can adjust are Date & Time Validity and Weekday Specifications. 

 Recommendation 

If you would like to adjust the batch import variants, you should copy the respective variant to avoid any 

interferences with future Support Packages and piece lists of ST-OST. 

 Configure the Import Strategies according to your requirements and system landscape. A standard 

customizing is already provided after the activation of our piece list. But the Import Config of the Import 

Strategies is depending on the system role (SysRole ID). If the given system roles are different from our 

recommended set of system roles, the Import Config must be copied to adjust the SysRole ID. For further 
information in terms of recommended system roles refer to chapter Error! Reference source not found.. 

 

 Select Maintain Landscape Data and maintain your system landscape per Import Config which has been 

defined previously. As Solution ID you can maintain '*' or any dedicated solution. Usually there are more than 

1 system per Import Config. For special use cases where imports must be performed sequentially system 

after system (e.g. ERP and BW) the Sequence column can be utilized. If such a use case is not given the 

sequence can always be '10'. If of a non-ABAP system check the Non-ABAP check-box. 

 

 The next step is to maintain the clients per Import Config and system. There is again a Sequence which can be 

utilized in the same way as for the systems previously and the standard RFC Type is Trusted RFC. 
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Additional authorization is required for communication (for example, for reading the import buffer etc.). The 

user of the RFC that connects to the managed system (TMW RFC for the communication client) must have 

authorization for the TMW_PROJECT_LOCK function group in the managed system for the S_RFC authorization 

object. The fallback solution is a client 000 connection. 

 Recommendation 

If you configure several systems for batch import (ideally parallel imports), several background processes 

must be available with job class C. For example, 10 parallel systems require ideally 10 background 

processes.  

 Caution 

If you have several valid systems or clients for the same variant, you must maintain the Batch Import: 

Parameters accordingly in terms of the sequence.  

 

 Recommendation 

For the described use case, we recommend that you use only one single sequence number. 

 If you like to execute /SALM/BATCH_IMPORT_TRIGGER regularly, check the automatic rescheduling flag and 

define the frequency. 

 Go to transaction SE38, execute /SALM/BATCH_IMPORT_TRIGGER. Afterwards select relevant Release to 

Import.  

 

 Note 

The first release in the context of your release component is always the active one. Completed releases 

are not shown in this list. 
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 The next step is to select the relevant Import Variant. 

 

 Repeat the previous step for all required variants. In standard for /SALM/QAS. 

Data Extraction for Solution Readiness Dashboard 

/SALM/DATA_EXTRACTION_PPMITSM extracts data for the dashboard. We recommend that you run this job daily, 

or manually before meetings. If project activity is high, run the job hourly. You can use the following variants as of 

SP02: 

Variant Description 

Focused_Build1 With Project and trend data without 

Portfolio 

Focused_Build2 With Project but without trend data and 

portfolio 

Focused_Build3 With projects and portfolio as well as 

trend data creation 

R2D Without PPM and trend data 

 

Before you can configure easily as shown below: 



 

Focused Build for SAP Solution Manager 

Configuration of Focused Build Requirement-to-Deploy 

 CUSTOMER  

© 2018 SAP SE or an SAP affiliate company. All rights reserved.  25 
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For the Solution Readiness Dashboard trend (or historical) data is required. Select the relevant variant and 

schedule the report in background as recommended earlier. 

Additionally, it is recommended to run a data compression for the trend data on monthly, quarterly and yearly 

basis. Therefore, schedule a job for /SALM/DATA_EXTRACTION_DELETE avoiding performance impacts.  
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Additional Job for Release Dashboard 

With SP01 we are introducing 2 additional jobs which are triggered by the event SAP_EXTRACTOR_EXTENT thrown 

by /SALM/DATA_EXTRACTION_PPMITSM: 

• /salm/transport_buffer_fill 

This job reads all open transports contained in the transport buffer. This job is only valid for ST-OST SP01. 

•  /salm/create_release_cache 

After the job /SALM/DATA_EXTRACTION_PPMITSM has run, all caches are invalidated. The scheduling of this 

job is optional, because it could run quite long, and it is just required if you require very high performant 

dashboards. 

Data Extraction for Test Management Dashboard 

Schedule /SALM/TSD_DATA_EXTRACTION daily by utilizing transaction SM36 Job Wizard. 

  

ABAP program name: /SALM/TSD_DATA_EXTRACTION 

Date/time: <end of day> (recommended) 

Period: daily 

Transferring Recorded Times 

Schedule DPR_CATS_CPR_TRANSF to run daily (overnight) to transfer recorded times back into the project. 

2.1.10 Activation of Virus Scan Profiles 

To activate the virus protection in your development system, go to transaction /IWFND/VIRUS_SCAN, search and 

activate the virus scan profile /UI5/UI5_INFRA_APP/REP_DT_PUT.  
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Can be checked upfront in transaction VSCANPROFILE. 

 

 Note 

Just in case you have not configured any virus scanner for your SAP Solution Manager system you can 

deactivate it easily. 

 

2.1.11 Multilevel Categorization 

Multilevel categorization lets you sort business transactions (for example, incidents) into as many as four levels. It 

integrates functions such as auto-completion and item determination based on categories, and searches for 

related problems, knowledge articles, and change requests. Schema samples can be found attached to SAP Note 

2483056. 

For more information, see the Multilevel Categorization guide on the SAP Community Network at 

http://wiki.scn.sap.com/wiki. 

http://wiki.scn.sap.com/wiki
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To set up multilevel categorization for Focused Build proceed as follows: 

 Call transaction SM_CRM  

 Choose Service Operations and then Categorization Schemas. 

 

 Create a new categorization schema and call it FOCUSED_BUILD.  

 

 Assign the application areas as follows:  

 

 Application ID: Service Order 
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 Parameter: Transaction Type / Catalog Category 

 Choose all S1*/D except S1TR/D (test requests) and save your selection. 

 Assign the application areas as follows: 

 Application ID: Service Request 

 Parameter: Transaction Type / Catalog Category 

 Choose S1DM/D and save your selection. 

 Upload the categorization schema FB_General.txt: 

 Call transaction CATEGOTOOL and import the schema. 

 

 Import the uploaded schema into the schema previously created in the WebClient UI.  

 

 In transaction SM_CRM, navigate to the categorization schema search and choose FOCUSED_BUILD.  
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 Choose a future date and time, and then release the schema. 

 Repeat steps 1–4 to create a second categorization schema and call it FOCUSED_BUILD_TESTING for S1TR 

(test requests). Also repeat step 5 but upload the categorization schema FB_TESTING_EN.txt or 

FB_TESTING_DE.txt.   

 Configuration and Customizing 

2.2.1 Maintaining AGS_WORK_CUSTOM 

Goto transaction SM30 and maintain the following entries in table AGS_WORK_CUSTOM: 

Parameter Key Parameter Value 

IM_CRM_UI_PPF_900 HF_SET_STATUS 

IM_CRM_UI_PPF_901 /SALM/COPY_DOCUMENT 

PARTNER_FCT_DEVELOPER_S1CG  

PARTNER_FCT_DEVELOPER_S1MJ  

PARTNER_FCT_OWNER_S1BR  

UIC_PROC_TYPE_SPECIFIC_01 AIC_CMCD_H/AICCMCDOverview_S1MR 

UIC_PROC_TYPE_SPECIFIC_02 AIC_CMCD_H/AICCMCDHeaderEF_S1MR 

UIC_PROC_TYPE_SPECIFIC_03 /SALM/CMCR_H/CMCROVERVIEW_S1MT 

UIC_PROC_TYPE_SPECIFIC_04 /SALM/CMCR_H/CMCRDETAILS_S1MT 
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Parameter Key Parameter Value 

UIC_PROC_TYPE_SPECIFIC_05 /SALM/REL_TRANS/RELATEDTRANSACTIONS_S1MT 

UIC_PROC_TYPE_SPECIFIC_SALM_01 /SALM/CMCD_H/CMCDOVERVIEW_S1MR 

UIC_PROC_TYPE_SPECIFIC_SALM_02 /SALM/CMCD_H/CMCDDETAILS_S1MR 

USER_STATUS_DESIGN_COMPL_S1BR  

/SALM/BI_MULTIPLE_RELEASES X 

 

2.2.2 Customizing Requirements Management 

There are several options to customize Requirements Management, because requirements and work packages 

can relate in various ways to each other. The main purpose of this customizing activity is to check if the work 

packages and the business requirements transaction types are customized correctly and maintain them if 

needed. 

In the customizing of SAP Solution Manager, choose SAP Solution Manager → Focused Build → Work Package 

Configuration → Define IT Requirements. 

Attributes Value 

Process Type: BR Requirement S1BR 

Process Type: Defect Message S1DM 

Process Type: Work Item (with TR) S1MJ 

Process Type: Work Item (without TR) S1CG 

Process Type: Urgent Change S1HF 

Process Type: Work Package S1IT 

Process Type: Master Work Package S1MT 

Process Type: CR for IT Requirement S1IR 

Process Type: Risk S1RK 

Process Type: Defect Correction S1TM 

Process Type: Test Request S1TR 

Required relationship between requirement and work 

packages 

n:m 

For the last attribute Required relationship between requirement and work packages there are several customizing 

options: 

• 1:1 

• 1:n 

• n:m 
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2.2.3 Activation of Required BadIs 

In the customizing of SAP Solution Manager execute SAP Solution Manager → Focused Build → Work Package 

Configuration → Activation of required BadIs 

 

and activate the implementation /SALM/ITR_PARTNER. 

2.2.4 Release Management 

To use the enhanced Release Management functionalities of Focused Build, you have to perform the following 

steps: 

 In the customizing of SAP Solution Manager, choose SAP Solution Manager → Focused Build → Release 

Management Configuration → Activate Release Cycle BadI Implementation 

 

 Afterwards you should maintain the release transaction type S1MR in the Customizing of SAP Solution 

Manager, choose SAP Solution Manager → Focused Build → Work Package Configuration → Define IT 

Requirements. 

Attributes Value 

Process Type: BR Requirement S1BR 

Process Type: Defect Message S1DM 

Process Type: Work Item (with TR) S1MJ 

Process Type: Work Item (without TR) S1CG 
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Attributes Value 

Process Type: Urgent Change S1HF 

Process Type: Work Package S1IT 

Process Type: Master Work Package S1MT 

Process Type: Release Management S1MR 

Process Type: CR for IT Requirement S1IR 

Process Type: Risk S1RK 

Process Type: Defect Correction S1TM 

Process Type: Test Request S1TR 

Required relationship between requirement and work 

packages 

n:m 

 

 Caution 

If your SAP Solution Manager system is on Support Package level 6 the BadI 

AI_CM_RELEASE_MGMT_BADI isn’t functional anymore. Thus you have to goto the customizing of SAP 

Solution Manager, choose SAP Solution Manager → Capabilities → Change Control Management → 

Change Request Management Framework → Change Cycles → Configure Transaction Type for 

Sublandscapes and maintain your Solution Sublandscape ID with the relevant cycle transaction type; e.g. 

 

Once the release planning itself is completed you can start with this task. Further information can be found on 

http://help.sap.com. 

Define Release Profile Mapping 

Check Definition of Release Management Profiles 

If a new release management profile is required, perform the following customizing activity: 

 In customizing for SAP Solution Manager, choose SAP Solution Manager → Focused Build → Release 

Management Configuration → Define Release Management Settings.  

 Choose the Define Release Management Profiles activity.  

 

https://help.sap.com/viewer/8b923a2175be4939816f0981b73856c7/7.2.05/en-US/95eda3533039cd46e10000000a44538d.html
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 Check if all entries are available (if no entries are available check chapter Activating the Piece List) 

 

Define Release Profile Mapping 

If you are creating a new release component or change control landscape, you have to define a release profile 

mapping.  

 In customizing for SAP Solution Manager, choose SAP Solution Manager → Focused Build → Release 

Management Configuration → Release Management Configuration. → Define Release Management Settings. 

 Choose the Define Release Profile Mapping activity. 

 You map the release type together with the release component.  

 

 Use F4 help to select Solution Name and Branch Type. For the Branch Type you have the following options: 

 MASTER - Production Branch (Used for Production Branch mapping) 

 MAINT - Maintenance Branch (Used for Maintenance Branch mapping) 

 STD - Standard Branch (Used for all other branch mapping like development, design or import branch) 

 Use F4 help to select Release Profile 

 /SALM/MAINT for Releases in the Maintenance Branch 

 /SALM/STANDARD for Standard Branches like development branch 

 Use F4 help to select Batch Import Var(iant) which should be used if you execute the Release Import from 

task list. 

 Use F4 help to select Collective Import Var(iant) which should be used if you execute the Collective Import 

from task list. 

 

Activation of Cross-System Lock for Development Clients for the dedicated development system (maintenance 

and project development systems), you should switch on CSOL (Legacy CSOL). To do so, go to SAP Solution 

Manager Launchpad: 
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 Note 

Prerequisites: 

RFC Connections (incl. CSOL_BACK RFC Destination) are generated, 

Required entry in table BCOS_CUST on the managed development system has been created 

Customizing Release Dashboard 

 Goto transaction SE16 and table /SALM/RD_CUSTOM 

 Adjust the CUST VALUE with the correct client 
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2.2.5 Defining System Aliases for oData Services 

You configure OData Services for the UI5 applications of Focused Build. 

 Run transaction /n/IWFND/MAINT_SERVICE.  

 In the ICF Nodes service sub-screen, mark the OData entry.  

 Search for services beginning with /SALM/* and select one after the other as is appropriate for your use case. 

Select one System Alias per service. 

Technical Service Name Use Case Optional 

AI_RELEASE_PLANNING_SRV Release Planning (Standard)  

/SALM/RELEASE_DASHBOARD_SRV Release Dashboard  

/SALM/SOL_READINESS_ODATA_SERVICE Solution Readiness Dashboard  

/SALM/SERVIC_ITSM_DASHBOARD ITSM Dashboard X 

/SALM/TM_SERVICE Test Management Dashboard  

/SALM/TM_TWL_SRV Tester Worklist  

/SALM/TM_TS_DESIGNER_SRV Test Step Designer  

/SALM/BUSINESS_REQUIREMENTS_SRV Requirements Management  

/SALM/MC_SRV Mass Change App  

/SALM/MANGOCRMUI Work Package Management 

and Work Item Management 

 

/SALM/DROP_DOC_SRV Integrated dropDoc  

/SALM/MY_DOCS_SRV My Documents X 

/SALM/PARA_CACHE_SRV Focused Build - Parameter 

Cache 

 

/SALM/CRMGENERICAPPCONFIG My Requirements App  

/SALM/CRM_GENEREIC_SRV My Requirements App  

 Choose Add System Alias and confirm.  
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 Choose New Entries. Use the input help to search for and insert the services: 

 /SALM/RELEASE_DASHBOARD_SRV _0001 

 /SALM/SOL_READINESS_ODATA_SERVICE_0001 

 /SALM/SERVIC_ITSM_DASHBOARD_0001 

 /SALM/TM_SERVICE_0001 

 /SALM/TM_TWL_SRV_0001 

 /SALM/TM_TS_DESIGNER_SRV_0001 

 /SALM/BUSINESS_REQUIREMENTS_SRV_0001  

 /SALM/MC_SRV_0001 

 /SALM/MANGOCRMUI_0001 

 /SALM/DROP_DOC_SRV_0001 

 /SALM/MY_DOCS_SRV_0001 

 /SALM/PARA_CACHE_SRV_0001 

 /SALM/CRMGENERICAPPCONFIG_0001 

 /SALM/CRM_GENERIC_SRV_0001 

 Use the input help to search for and insert a local connection. The Default System flag should not be set 

unless you have several system aliases. Save your selection. The system alias appears on the overview 

screen. 

2.2.6 Creating Groups 

Go to SCPR20 and activate bc-set /SALM/72SP01/STATUS_GROUPS. 

2.2.7 Configuring Test Suite Extensions 

To configure the Test Suite extensions for Focused Build, use the following views in customizing for SAP Solution 

Manager → Focused Build → Test Suite Extensions: 

• Map Test Plan Status to Test Request  

• Map Test Classification to CRM Categories 

• Defect Status Aggregations 

• Define Work Package Status Values for Test Preparation Tiles 

• Test Steps 

Alternatively, you can start the Test Suite Administration from the SAP Solution Manager launchpad and access 

and maintain the views on the Test Suite Extension tab page: 

• Check Report - Check configurations and user authorizations 

• Mapping Test Classification to Test Request Category -Maintain the mapping between test classifications and 

test request categories 

• Mapping Test Request Status to Project Task - Maintain the mapping between test request statuses and 

project task statuses 
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• Mapping Test Plan Status to Test Request Status - Maintain the mapping between test plan status and test 

request status 

• Defect Status Aggregations - Maintain the defect status aggregation 

• Work Package Status Values for Test Preparation Tiles - Maintain Work Package Statuses for Test Preparation 

Tiles of the Test Suite Dashboard 

• Test Steps 

 Define general settings for the Test Steps application such as execution mode, available languages, 

status based execution lock and others 

 Define status settings for status of steps such as label, default status, or evidence required 

 Define custom fields which can be used as result attributes during design of test steps documents 

 Define folders in order to group and organize test steps documents in the designer application 

 Define status aggregation rules which will aggregate step status to test case status during test execution 

 Define settings of the test steps table view showing steps in design time and execution time 

Checking Test Suite Configurations and User Authorizations  

You can use the Check Report view to check Test Suite configurations and user authorizations. 

 Start the Check Report from the SAP Solution Manager launchpad. 

Select the following: 

 To check if the assignments between the Test Suite and the project or the solution are correct, select General 

Checks and a solution or project. 

 To check configurations for the Test Suite, select Test Suite Checks.  If you select this option, the following 

status information is displayed: 

 Activations for ICF services 

 Customizing for the Test Suite 

 Activations for the SAP Business Warehouse 

 Activations for Business Explorer Queries (BEx-Queries) for the Test Suite Dashboard 

 To check the authorizations related to Test Suite applications for a user, select User Authorization Checks and 

select a user. 

Mapping Test Classifications to Test Request Categories 

When a test plan is assigned to a project, this automatically creates a test request in the SAP CRM. The Test Suite 

uses a test classification to categorize test plans. You map the values of the test classifications to the multilevel 

categorization schema of the test requests.  

Prerequisites 

• You have configured the test request transaction type S1TR.  

• You have enabled a multilevel categorization schema for the test request transaction type.  

 Caution 

Make sure that the multilevel categorization schema for test request transaction type uses only one level.  

Test classification can only be mapped correctly to multilevel categorization schemas that use only one 

level. 
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Procedure 

 In the Customizing for SAP Solution Manager, choose SAP Solution Manager → Focused Build → Test Suite 

Extensions → Map Test Classification to CRM Categories.  

Alternatively, you can access this table by choosing Mapping Test Classification to Test Request Category on 

the Test Suite Extension tab page of the Test Suite Administration. 

 Map the test classification values to the category IDs of the multilevel categorization schema assigned to test 

request transaction type S1TR. 

Mapping Test Request Statuses to Project Task Statuses  

When a test plan is assigned to a project, this automatically creates a test request in the SAP CRM and a project 

task in the project management. To map the test request statuses to the project task statuses, do the following: 

 Start the Test Suite Administration from the SAP Solution Manager launchpad  

 On the Test Suite Extension tab page go to Mapping Test Request Status to Project Task and choose Maintain. 

 Map the test request status values to project task status values. 

Mapping Test Plan Statuses to Test Request Statuses 

When a test plan is assigned to a project, this automatically creates a test request in the SAP CRM. You map test 

plan statuses to test request statuses to make sure that after an update of a test plan status the test request 

status is automatically updated.   

 In the customizing for SAP Solution Manager choose SAP Solution Manager → Focused Build → Test Suite 

Extensions → Map Test Plan Status to Test Request.  

Alternatively, you can access this mapping table by choosing Mapping Test Plan Status to Test Request Status 

on the Test Suite Extension tab page of the Test Suite Administration.   

 Map the test plan statuses of one or multiple release schemas to the test request statuses. 

Defect Status Aggregations 

Customers can use a customized schema for defect processing that uses multiple defect statuses. To get a 

simplified representation of these defect statuses, you consolidate the multiple customized defect statuses to a 

limited set of aggregated statuses.   

Example 

The customer uses a customized schema for the defect transaction types S1DM or SMIN. There are multiple status 

values. Focused Build, however, uses only five aggregated values: 

• Created  

• In Progress  

• Awaiting Information  

• Closed  

• Confirmed 

For example, you could decide to map several defect statuses, such as Solution Provided, Complete and Resolved 

to the aggregated status Closed. 

Procedure 

 In the Customizing for SAP Solution Manager, choose SAP Solution Manager → Focused Build → Test Suite 

Extensions → Defect Status Aggregations.  
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Alternatively, you can access this mapping table by choosing Defect Status on the Test Suite Extension tab 

page of the Test Suite Administration. 

 Map the detailed statuses of the defect transaction types to the aggregated values. 

Define Work Package Status Values for Test Preparation Tiles 

Customers can define additional tiles for the Test Preparation view of the Test Suite dashboard to display the 

number of work packages without test cases for a given status values of a work package. 

Example 

The customer can customize the status values of work packages (S1IT) for which he would like to see tiles. 

Typically, the following status values are from interest: 

• To be developed 

• In development 

• To be tested 

Procedure 

 In the customizing for SAP Solution Manager, choose SAP Solution Manager → Focused Build → Test Suite 

Extensions → Define Work Package Status Values for Test Preparation Tiles.  

Alternatively, you can access this mapping table by choosing Define Work Package Status Values for Test 

Preparation Tiles on the Test Suite Extension tab page of the Test Suite Administration. 

 Add the work package status values for which tiles should be displayed. 

Maintain folders for Test Steps Designer 

In customizing activity “Folders for Test Steps Designer” customers can maintain folders to group Test Cases of 

type Test Steps within the application Test Steps Designer. A sample folder could be “UAT” with label “User 

Acceptance Tests” which would then comprise test cases related to UAT tests. 

Maintain custom fields 

In the customizing activity “Customer Fields for Test Steps Result Attributes” customers can maintain fields that 

can be used in Test Steps Test Cases in order to store result values during execution time. A sample field could be 

“MATERIAL_DOC” with the label “Material Document”, Data Element “CHAR10”, Rendering “Input Field”, and 

Multiple “true”. 

 

For continuative configurations please refer to the documentation in the IMG. 

Activation of BEx-Queries 

 Call transaction RSOR .  

 Open the BI content. 

 Display the Object Types. 

 Expand the Query Elements. Under Query, choose Select Objects. 

 Select all BEx queries (Business Explorer queries) with the technical name /SALM/SMT*: 

1. Navigate to SAP Solution Manager → Test Management → Test Management MultiProvider. 

2. Display the technical name by choosing  (Technical Name off/on) (F7 ). 

3. Select the following entries: 
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Entry Technical Name 

Defect Status /SALM/SMT_DF_STATUS 

Defect Status Detail /SALM/SMT_DF_STATUS_DETAIL 

Defect Status Progress /SALM/SMT_DF_STATUS_PROGRESS 

Test Package Status Detail /SALM/SMT_TG_STATUS_DETAIL 

Test Plan Status /SALM/SMT_TP_STATUS 

Test Plan Status Detail /SALM/SMT_TP_STATUS_DETAIL 

Test Plan Status Progress /SALM/SMT_TP_STATUS_PROGRESS 

4. To transfer the selected entries, choose Transfer (F2 ) 

The queries should be listed in the right area of the window.  

 

 When all queries are selected for installation, choose Install and then Install in Background.  

 

 Recommendation 

Use the installation in the background because the option Install might fail. 
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2.2.8 Configuring Project Management 

Creating Projects Templates 

 Download the project template XML files from SAP Note 

SAP Note Description 

2483056 Central Note for Focused Build 2.0 SP01 for SAP Solution Manager 7.2 

 To start Project Management, on the SAP Solution Manager Launchpad, choose My Projects. 

 Choose Projects and then choose Import Project.  

 In the Application field, select XML File. 

 

 In the File field, choose Browse to navigate to the file that you want to import.  

 Choose Import Selected Data. 

 Under Data for Import, select Structures and Resources.  

 Choose Check. 

 Choose Import.  
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 After uploading all XML project files, convert them into a project template. 

 In the Project Management, go to Portfolio and Project Administration and choose Project Management 

Templates. Then create template derived from the imported files: 

 On the left navigation pane, choose Project Management Templates. 

 

 Choose Project Administration in the top navigation area. 

 Choose Create.  

 Enter the following settings to create your template project: 

Field Value 

Proj. Template <Your choosing> 

Template Type Project 

Template One of the projects provided, for example, <Template: Focused 

Build_Build_Project> 

New Checklist Templates None 

Original Language  English 

 

 Release the project template by setting the status to released. 

 After the creation of the templates you can delete the previously uploaded projects again. Please refer to 

chapter 5.8 Delete of obsolete projects. 

 Important Links 

Batch job scheduling: 

https://help.sap.com/saphelp_nw70/helpdata/EN/c4/3a7f87505211d189550000e829fbbd/frameset.htm 

 

https://help.sap.com/saphelp_nw70/helpdata/EN/c4/3a7f87505211d189550000e829fbbd/frameset.htm
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Learning Map including How to's: 

https://service.sap.com/sap/bc/bsp/spn/esa_redirect/index.htm?gotocourse=X&courseid=70324959 

https://service.sap.com/sap/bc/bsp/spn/esa_redirect/index.htm?gotocourse=X&courseid=70324959
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3 Project Preparation 

 Target Group 

This chapter targets Methodology and Tool Coach who plans to prepare the project preparation for a Focused 

Build based implementation project.  

 Prerequisites 

3.2.1 Technical prerequisites 

Technical Prerequisites and Configuration 

• Solution Manager Configuration 

 General (SOLMAN_SETUP: Mandatory Configuration, Managed Systems Configuration (per System 

under Test), Embedded Search  

 Involved standard capabilities (Solution Documentation, ChaRM basic setup, Test Suite, IT PPM) 

• Users with required roles and authorization and Business Partners 

• Focused Build specific configuration (see Configuration Guide) 
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3.2.2 Content related prerequisites 

Required customer master data for planned Focused Build Project. 

The data should be the results of conceptual discussion with the customer on how Process Management / 

Solution Documentation and Landscape as well as Release Management and Project definition should look like. 

 

Solution 

Name  e.g. Corporate Solution 

Technical Name e.g. CORP_SOL 

Branches (at least Development and 

Design) 

Production 

  Maintenance 

  Development 

    Design 

    Import 

Document Types and templates 

 

e.g. (BPD) Business Process Description 

e.g. (CG) Configuration Guide 

e.g. (FIT) Functional Integration Test 

e.g. (FS) Functional Specification type WRICEF 

e.g. (FS) Functional Specification type Gap 

e.g. (FS) Functional Specification type Interface 

e.g. (SFT) Single Functional Test 

e.g. (TD) Technical Design 

e.g. (UAT) User Acceptance Test 

e.g. (UC) Use Case 

e.g. (UG) User Guide 

e.g. (MO) Mock-up 

e.g. (TM) Training Material 

Content to be imported (e.g. Best 

Practice for S/4HANA  x.xx US) 

e.g. "SAP Best Practices for SAP S/4HANA, on-premise edition 1602 

US" 

Involved Systems / Landscape (Logical 

Component Group(s), Technical 

Systems) 

Log Comp 

Grp. 

System Role SID Client 

S4HANA Sandbox <SID> <CLNT> 

Development <SID> <CLNT> 

Quality 

Assurance 

<SID> <CLNT> 
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Pre-

Production 

<SID> <CLNT> 

Production <SID> <CLNT> 

 

Release Management 

Number of planned Releases 2 

Duration in days 180 

Go-Live Date for 1st Major Release October 1st 2017 

 

 Project Management 

Project Templates Lean or Activate Roadmap based template 

Master Project e.g. S/4HANA 

Build Project 1 e.g. Financials  

Build Project 2 e.g. Logistics 

Number of Waves per Project  2 

Start date of 1st wave  April 1st 2017 

Duration of waves 90 

Number of Sprints per Wave 3 

Project/Wave/Release Mapping Project Wave Release Number 

Build Project 1 Wave 1 1.0 

 Wave 2 1.0 

Build Project 2 Wave 1 1.0 

 Wave 2 1.0 

 Create Solution with Branches, System Landscape and 
Document-Type assignment 

3.3.1 Create Solution 

Definition:  

The solution is the sum of a company’s systems, applications and processes. It acts as a container for versions of 

solution documentation, one of which is the production version. 
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The general recommendation is to use only one solution to reflect the entire system landscape and its 

documentation also for large and interconnected companies.  

 

Assumption: 

The customer is not using any Solution yet in his SAP Solution Manager system. At the end of this  

section, we describe how to deal with customers, who are already using Solution(s) in their system.  

 

How to create a Solution: 

 Enter “Solution Administration” either via transaction code SOLMADM or via the SAP Solution Manager 

Launchpad (Section “Project and Process Management” => Solution Documentations). See screenshot 

below. 

 

Figure 1 - Navigating to Solution Administration 

 To create a Solution, click on the “Global Functions” icon on the appearing screen and select “Create 

Solution”.  

Figure 2 - Create Solution 

 To finalize the Solution creation, provide a name (and technical name) and confirm.  
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Figure 3 – Provide Solution Names 

 Now the Solution is created and always accessible via transaction SOLADM or the SAP Solution Manager 

Launchpad.  

3.3.2 Setup up branches 

 

Definition: A branch represents a version of the solution documentation containing processes, libraries and 

systems. 

 

With the branch concept, it is e.g. possible to distinguish between documentation, which describes productive 

processes and documentation, which describes processes currently in design or build.  

 

Typically, a solution contains a production branch, a maintenance branch and a development branch. 

 

The production branch represents the productive version of the entire solution documentation. 

The maintenance branch represents the editable version of the productive solution documentation. It provides a 

safe environment for performing changes. 

The development branch represents the documentation of a future solution documentation. 

 

For a S/4HANA implementation, we recommend the following branch structure. 

 

Figure 4 – Branch Setup 
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 Caution 

The development branch must be enabled for Change Control.  

 

Production branch 

Production branch represents the productive solution  

Operations branch 

Operations branch to apply monitoring instrumentation 

For a new implementation the Operations branch is not required during the implementation project. 

Maintenance branch 

Maintenance branch to change the productive solution 

For a new implementation the Maintenance branch is not required during the initial implementation project. But it 

will be anyway created with the creation of a new Solution.  

Innovation branches 

Import branch to import new best-practice processes 

Design branch to design customer target operating model 

Development branch to build the actual operating model 

 

The design is the branch to be used during Build Design Support.  

 

How to create the best practice branch structure? 

 Ensure that you are in the correct Solution in transaction SOLADM.  

 Click on tab “Branches”. The below screen will appear showing the production and maintenance branch.  

Figure 5 - Creating a Branch 

 Mark the Production Branch and click on “Create” 

The below screen will appear will appear, confirming the parent branch (in this case Production branch). 

Select the usage as Development branch and not Operation branch (Operation would be used for Business 

Process and Interface Monitoring), and as name of the new branch “Development” (Technical Name 

“DEVELOPMENT”. 
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Figure 6 - Branch Creation 1 

 Enable Change Control for Development branch 

 

    

Figure 7 – Activate Change Control for Development Branch 

 To create the Design branch, mark the development and click again on Create. In the appearing pop up 

window, ensure that the Development branch is displayed as parent branch. Then enter as name Design and 

provide a technical name.  

 

Figure 8 - Branch Creation 2 

 

 Repeat Step 5 to create the Import branch with the Design Branch as parent.  
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 Finally, the branches for the Solution should look like in the below screenshot.  

Figure 9 - Branch Setup 

Please note: For Focused Build Setup it is mandatory that you create at least one additional branch (e.g. Design) 

below Development branch. 

3.3.3 Setup system landscape 

Certain functions of SAP Solution Manager (like Solution Documentation) is referring to certain system (e.g. the 

documentation of a S/4 process in the Design branch refers to a S/4 sandbox system). In the SAP Solution 

Manager logical component groups and logical components are used to model the system landscape for the use 

of SolMan functions like Solution Documentation.  

 

Definitions: 

A logical component group (LCG) is a high level view on an application. It is a group of logical components which 

contain systems of a kind e.g. S/4HANA, ERP Logistics, ERP Human Resources, CRM or PORTAL. 

LCGs are used to depict the execution runtime of e.g. process steps. The LCG is a release independent 

placeholder for concrete systems 

 

A logical component (LC) refers to the concrete technical systems of a system track typically belonging to the 

same transport landscape and having the same product version. 

  

The technical systems assigned to logical components are classified according to their system role e.g. 

development system, quality assurance system. 

 

Assumption: 

For the prototype we use a Demo landscape which is a simulation of transport landscape using different clients in 

the same system. Creating of Demo Landscape is described in the appendix. 

Create additional System Roles for Sandbox and Preproduction via transaction MAINT_ROLES: 
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Figure 10 - System Roles 

Use up- and down- buttons to change order of system roles according to sequence transport landscape 

 

How a to create a Logical component group (LCG)? 

 

 Ensure that you are in the correct Solution in transaction SOLADM.  

 Click on tab “System Landscape”. The branches created will be displayed (see below). 

 Click on “Maintain Logical Component Groups” 

 

Figure 11 - Logical Component Group Creation 1 
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 A screen appears showing all LCGs, which are available for this Solution. Click on “Create” to create a new 

LCG for the S/4HANA landscape.  

 

Figure 12 - Logical Component Group Creation 2 

 In the next screen, provide a name and description of the logical component group to be created. Also select 

the technical system type. For a S/4HANA system the ABAP Application server is applicable.  

 

Figure 13 - Logical Component Group Creation 3 

 Close the next screen. 

The result is a logical component group, which is assigned to all branches of the Solution. See below. 
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Figure 14 - Logical Component Group Creation 5 

 With this you can already implement best practice content.  

 

How to assign a system? 

At the beginning of a S/4HANA project, the customer might not have built up the full system landscape yet. But 

the customer will most probably have a S/4HANA sandbox to perform the fit-gap analysis. That means the 

Sandbox system would be the relevant system for the activities to be documented in the branches Import and 

Design.  

 

In this example, we assume that a system S4H / client 100 acts as S/4HANA sandbox. In order to assign the 

system, it must be known to SAP Solution Manager. That means the system must exist in LMDB and an RFC 

exists (preferable the managed system setup was executed).  

 

For the prototype we use the Demo Landscape instead of a S/4HANA system 

 Ensure that you are in the correct Solution in transaction SOLADM.  

 Click on tab “System Landscape”. The branches and the logical component group created will be displayed 

(see below). 

 Click on “Assign Technical Systems” 
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Figure 15 - LCG: Assign Technical Systems 1 

 In the following screen, select the Import branch and as logical component “Import-Global”. Then navigate to 

the field Sandbox System and open the search help to get related system/client for Sandbox role. .  

Figure 16 - LCG: Assign Technical Systems 2 

 Click OK and then again 'Assign Technical Systems' 

 For the Design branch we assign the same system/client like for sandbox. 
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Figure 17 - LCG: Assign Technical Systems 3 

 On the previous window click “OK”. 

 Repeat steps 4 to 6 for all branches according to the systematic of this table and the input from customer's 

landscape entered in chapter 3.2.2 

Logical Component System:Client (Role) 

Import SMD:900 (Sandbox) 

Design SMD:900 (Sandbox) 

Development SMD:901 (Development) 
 

SMD:902 (QA) 
 

SMD:903 (Preproduction) 

Production SMD:904 (Production) 

 

 In our example, the result looks like this: 

Figure 18 - LCG: Assign Technical Systems 4 
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3.3.4 Related Documentation 

For more information about SAP Change Request Management, go to SAP Help Portal at 

https://help.sap.com/viewer/p/SAP_Solution_Manager, select version 7.2 SPS 3. Open the application help and 

select Change Request Management. 

For more information about assigning roles, see the security guides for SAP Solution Manager at 

https://help.sap.com/viewer/p/SAP_Solution_Manager. 

3.3.5 Considerations, if process management is already in 
use 

If the customer is already using process management in SAP Solution Manager, there will be already a Solution, 

which is actively used by the customer. In the very beginning there should be a discussion with the customer, if 

the same – already created Solution – should be used for the S/4HANA implementation. Keeping the definition of 

the Solution in mind, it’s very likely that the S/4HANA project will use the (or an) already existing Solution. 

If there are good reasons to create a separate Solution, the steps described in the previous sections are 

completely valid.  

If an existing Solution should be used the following general considerations apply. If you are unsure, what is the 

best approach on how to deal with the Solutions/branches in a certain customer situation, please reach out to 

MCC to request support. 

Branch Setup 

Basically, we recommend to separate the S/4HANA implementation from other implementation project or the 

maintenance of the current Solution. That means that we recommend a branch structure “Development” => 

“Design” => “Import” (as described in xxx) as a child of the production branch. That can co-exist with other – 

already existing – child branches to the production branch.  

The screenshot below shows an example, how such a branch structure could look like. 

In green is an example for two branches, which were already existing and which are used by the customer for 

maintenance and other projects than the S/4HANA implementation project.  

In red is the branch structure for the S/4HANA implementation project.  

Both branch structures release their content to the production branch. If the same processes, process steps or 

other objects are changed in different branches at the same time, there must be a conflict resolution latest when 

releasing the changes. As the S/4HANA implementation is working with a different set of systems, there shouldn’t 

be the need to invest much efforts in conflict resolution. 

https://help.sap.com/viewer/p/SAP_Solution_Manager
http://help.sap.com/saphelp_sm72_sp03/helpdata/en/4c/3acb82b50843b4e10000000a42189e/content.htm?frameset=/en/2b/614e1cb8204f35b477eac703073589/frameset.htm&current_toc=/en/37/24fe53582e0114e10000000a174cb4/plain.htm&node_id=588&show_children=false
https://help.sap.com/viewer/p/SAP_Solution_Manager
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Figure 19 - Branch Setup 

Setup system landscape 

There are not too much differences compared to the greenfield situation. Basically, there is the need for a logical 

component group(s) for the S/4HANA landscape(s), including logical components and systems.  

If those are already created by the customer, they should be re-used. If not they must be created as it is described 

in section xxx. 

Import Best Practice Content 

No changes compared to the greenfield situation, the best practice import should be done in the import branch. 

3.3.6 Create and assign Document Types to Solution 

In order to ensure a smooth transition to Build Execution, all results documents should be available (and uploaded 

to Solution Manager) at the end of the FitGap / Delta Design. The management of these documents obviously 

becomes easier if… 

• All necessary document types are available 

• There is no ambiguity in regard to which document type to use 

• It is clear where a document of a type should be stored. 

• The correct templates for each document type are readily available. 

• Examples for Docu Types and Templates are shipped in the name range '0SAP_XX' 

Description Document Type Status Schema 

Functional Specification type Gap 0SAP_01 SAP Default Status Schema 

Functional Specification type WRICEF 0SAP_02 SAP Default Status Schema 

Functional Specification type Interface 0SAP_03 SAP Default Status Schema 

Use Case 0SAP_11 SAP Default Status Schema 

Technical Design 0SAP_20 SAP Default Status Schema 

Configuration Guide 0SAP_25 SAP Default Status Schema 
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Description Document Type Status Schema 

Single Functional Test 0SAP_30 SAP Default Status Schema 

Functional Integration Test 0SAP_31 SAP Default Status Schema 

Business Process Description 0SAP_40 SAP Default Status Schema 

User Guide 0SAP_41 SAP Default Status Schema 

Mock-up 0SAP_42 SAP Default Status Schema 

Training Material 0SAP_50 SAP Default Status Schema 

To create your own document types based on standard types: 

Go to Solution Administration  ‘Global Functions’  Document Type Administration: 

 

Figure 20 - Accessing Document Type Administration 

Reduce the list of document type by entering '0SAP' in the search field and press Enter. Right click on the entry to 

be copied and select “Copy”: 
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Figure 21 - Creating a new Document Type (1) 

In the pop-up enter target document type (e.g. ZSAP_XX) and related description and confirm with OK: 

 

Repeat this for all standard Document Types (0SAP_XX) 

Enter search term that reflects you naming convention (e.g. ZSAP), press Enter, select one of the listed entries 

and choose 'edit' button  
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Choose the 'Upload' button to upload your own document template for the selected document type.  

 

Use pop-up to browse for the document template and select 'Upload' 

 

Switch back to view mode (click on the glasses symbol) to save the new document type. 

Repeat the upload for all customer Document Types (ZSAP_XX) 
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When done exit the 'Document Type Administration' and continue in 'Solution Administration' screen while 

selecting the 'Document Type' tab. Ensure that 'All' is selected on the right side, enter the search term based on 

your naming convention (e.g. ZSAP), press Enter and select all relevant entries to put into the scope for your 

Solution: 

 

Figure 22 – Add Document Types to Scope of Solution 

3.3.7 Adjust Customizing for Document KPI Framework 

To be able to use the KPI reporting for the created document types you need to adjust the related customizing. To 

do so start SPRO and open the IMG note for Document KPI Framework: 
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For following KPIs the Document Types need to be changed from 0SAP_XX to the new types created in the 

previous chapter: 

KPI 

FSSPEC 

SFTEST 

TSPEC 

 Select entry of KPI and then double-click on 'Define relevant transaction types' 

 

 Select transaction type and then double-click on 'Define Classification Mapping' 

 

 Select the first entry and choose 'Copy' button 
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 Adjust Doc. Type entry and press 'Enter' 

 

 Scroll up the table and delete the original entry with '0SAP_XX' Doc. Type 

 

 Repeat steps 3-5 for all Classifications in this table so it looks like this 
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 Repeat steps 1 - 6 for KPI 'SFTEST'  

 Repeat steps 1 - 6 for KPI 'TSPEC' for each transaction type S1CG and S1NC 

 

3.3.8 Import Best Practice Content into Import Branch 

With the steps described above the best practice content can be imported. It is not mandatory to have technical 

system assigned to the logical component and logical component group. It is enough, if a suitable LCP exists.  

Furthermore, it is mandatory that SAP note 2194123 is implemented.  

How a to create import best practice content?  

 Ensure that you are in the correct Solution in transaction SOLADM or go via Launchpad group Focused Build - 

Tool Lead  Solution Administration 
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Figure 23  – Launch Solution Administration 

 Select tab "Imports" and then "Import” on the left side.  

 

Figure 24 - Importing Best Practice Content (1) 

 In the next screen, select the appropriate best practice package and click “Next”.  

 

Figure 25 - Importing Best Practice Content (2) 
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 In the next screen, please select the right branch to import the best practice content to (that’s the Import 

branch), select 'New  deployment' and provide a name for the deployment for your first deployment. 

 

Figure 26  - Importing Best Practice Content (3) 

 Click in “Import”. A background job will be triggered to perform the actual import. 

 

 

Figure 27 -  - Importing Best Practice Content 4 

 

 A success message indicates that the import was successfully done. 

3.3.9 Release Scope-relevant Processes into Design-Branch 

 

 First, let’s look at what we just imported. From the SAP Solution Manager Launchpad (“Focused Build - 

Architect”) click the “Solution Documentation” Tile. 
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Figure 28 – Launch Solution Documentation  

 The top of the screens indicates which solution/branch is selected. Make sure you are looking at the Import 

branch of the newly created solution. To switch to another solution, click ‘Global Functions’  Solution. To 

switch to a different branch in the selected solution, use the branch dropdown field. 

Figure 29 - Solution Documentation Overview 1 

 Once a package is imported into Solution Manager you will see a folder called SAP Best Practice Import – 

under the folder Business Processes. Within the folder there is a scenario per package – in case you imported 

multiple best practices. All packages are listed here, the name of the scenario is the name of the best practice 

package. You can now browse the content by going through the processes (so called scope items) which have 

a 3 letter code e.g. BD9 and name. For each process you can open the process diagram or navigate to the 

linked documents, like test cases and configuration guides. 

 Expanding the Import branch’s content (Business Processes  Best Practices Import  <Best Practice 

Package>  <Best Practice Process>  Process Step) reveals the imported best practice content. In the 

lower half of the screen the elements of the selected item are displayed. Here you can find for example all 

executables/transactions and configuration relevant for a process but also assets such as process diagrams 

or links to documentation including test scripts which can be used in scope of the solution validation 

workshops. 
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Figure 30 - Solution Documentation Overview 2 

 Once the imported best practice processes have been scoped and it is clear, which are relevant for the 

customer they can be released to the DESIGN branch (The IMPORT branch is merely a staging area for 

scoping purposes, nothing is changed or modeled here).  

 

 

Figure 31 - Release to Design Branch 

 To do so, right click on a relevant best practice process, then chose “Subtree Changes”  “Release Changes” 

and confirm the popup. The selected process has now been released to the DESIGN branch, where gaps will 

be documented and best practice process can be adjusted. 

3.3.10 Create Change Control Landscape  

Create Change Control Landscape in SOLADM: 

 Select right solution and the tab Change Control Landscape 

 Right-click on empty area in the table and select new in the drop-down menu 

Business Process 
Elements (Configuration, 

Diagrams, Executables, 

Documentation, Links, …) 

Scenario / Best 

Practice 

Package 

Right click 
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Figure 32 - Creating Change Control Landscape (1) 

 Enter name and technical name 

 

Figure 33 - Creating Change Control Landscape (1) 

 

 Assign Logical Component Group which is reflected by the Change Control Landscape while selecting the 

check box 'scope'. 

 

Figure 34 - Creating Change Control Landscape (3) 
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3.3.11 Define Branch Mapping (SPRO) 

Except for the maintenance branch and the production branch, all branches are standard type branches. 

Therefore, you have to define the design and development branch of your solution sub landscape:  

 In the Customizing of SAP Solution Manager, choose SAP Solution Manager → Focused Build → 

Documentation → Define Branch Mapping.  

 Select 'New Entries' 

 

              Figure 35 - Branch Mapping for Design Branch  (1) 

 

  

 

              Figure 36 - Branch Mapping for Design Branch  (2) 

 

              Figure 37 - Branch Mapping for Design Branch (3) 
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              Figure 38 - Branch Mapping for Design Branch (4) 

 

              Figure 39 - Branch Mapping for Design Branch (5) 

 

Figure 40 - Branch Mapping for Design Branch (6) 

 

Figure 41 - Branch Mapping for Design Branch (7) 
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 Setup Release Management 

3.4.1 Release Planning 

 Select Release Management tile in the Launchpad  

 

Figure 42 – Navigate to Release Management 

 In the navigation area select 'Focused Build'  Release Planning 

 

Figure 43 – Navigation to Release Planning (1) 

 Select Create  Major and Minor Releases  

 

Figure 44 –  Navigation to Release Planning (2) 

 Select created Change Control Landscape assign Major Release to Development Branch enter further 

relevant data 
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Figure 45 – Define Major Release schedule 

 Check Major Release schedule and select 'Release Versions' you want to create Release Cycles for 

 

Figure 46 – Display Major Release schedule 

 Select Create  Release Cycles 

 

Figure 47 – Create Release Cycle (1) 

 Confirm creation of Release Cycle 
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Figure 48 – Create Release Cycle (2) 

 Navigate to Release Cycle while clicking on the related entry in the release table 

 

Figure 49 – Open Release Cycle 

 Select Business Role of Release Manager 

 

Figure 50 – Select Business Role - Release Manager 

 Change to Edit Mode and confirm to assign your Business Partner 
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Figure 51 – Change Release Cycle 

 Select Actions  Switch to "Prepare Phase" 

 

Figure 52 – Switch Release Cycle to "Prepare Phase" 

 Confirm to create the task list 

 

Figure 53 – Confirm Task List creation 

 Click next and check status of prerequisites 
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Figure 54 – Check prerequisites of Task List 

 Check that Task List Variant is 'S1RL', branch is Development, assign development system, transport 

landscape and continue with Next 

 

Figure 55 – Define Scope of Task List 

 To complete Task List creation select 'Create' 
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Figure 56 – Complete Task List creation 

 Check message that Task List has been created and Release has been switched to "Prepare" Phase. 

 

Figure 57 – Task List created  

 Select 'Edit' and then 'Related Transactions' tab and click on the create Task List entry in the column 

'Transaction ID'. 

 

Figure 58 – Open Task List 

 In the Task List drill down to node 'Track (Source System…)', select it, and select 'Lock/Unlock Group' 
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Figure 59 – Unlock Task Group 'Track' 

 Check that status is unlocked for Task Group 'Track' 
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Figure 60 –Task Group 'Track' unlocked 

 Close screen and then Save and close also previous screen 

 

Figure 61 –Release Cycle  

3.4.2 Define Release Profile Mapping 

Check Definition of Release Management Profiles 

If a new release management profile is required, perform the following Customizing activity: 
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 In Customizing for SAP Solution Manager, choose SAP Solution Manager → Focused Build → Release 

Management Configuration → Define Release Management Settings.  

 Choose the Define Release Management Profiles activity.  

 

Figure 62 – Release Management Profile 

 Check if all entries are available (if no entries are available check chapter  Activate the Piece List in Config 

Guide) 

 

Define Release Profile Mapping 

If you are creating a new release component or change control landscape, you have to define a release profile 

mapping.  

 In Customizing for SAP Solution Manager, choose SAP Solution Manager → Focused Build → Release 

Management Configuration → Release Management Configuration. → Define Release Management Settings. 

 Choose the Define Release Profile Mapping  activity. 

 You map the release type together with the release component.  

 

Figure 63 – Release Profile Mapping (1) 

 Use F4 help to select Release Type for Major Release, Sublandscape and Release Profile and press Enter 

 

Figure 64 – Release Profile Mapping (2) 
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 Save and exit Details view 

 

Figure 65 – Release Profile Mapping (3) 
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 Project Setup 

For the prototype example, we create: 

 1 master project 

 2 build projects 

3.5.1 Create Projects 

Following template projects can be used for setting up the project structure of the prototype: 

 

Figure 66 – Available Projects Templates for Focused Build 

 From Solution Manager Launchpad select group ‘Focused Build - Project Manager’ and then tile ‘My Project – 

Project Management’  

 

Figure 67 – Open Project Management in Launchpad  

 In the Project Management dashboard select 'Create' and enter target project number, select Template Type 

'Project Template' as well as Project Type, select related template project as source project and then select 

'Create'. 
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Figure 68 – Create Projects 

 Adjust Project Name and save 

 

Figure 69 - Adjust Project Name 

 Repeat step 2 and 3 for all projects required for the prototype 

3.5.2 Assign Release to Projects 

 Assign Actual Release to Build Projects and Master Project 
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Figure 70 – Assign Actual Release 

 Check if the Solution that was assigned to the Release has been assigned to Project accordingly: 

 

Figure 71 – Assignment of Solution 

3.5.3 Assign sub projects to master project 

 Assign both Build projects to the Master project while using 2 sub tasks of type ‘Common Task Type for FB 

Projects’ for  

- Build Project 1  

- Build Project 2 

 

For each Task select it in Structure and assign Sub Project in Basic Data tab and assign Sub Project 
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Figure 72 – Assign Sub Projects 

3.5.4 Maintain project data (optional) 

The Template Build Projects are shipped with 2 Waves and 3 Sprints which should be fine for a prototype. If you 

would like to have additional Waves, please follow the following optional procedure  

 In both Build Projects copy the existing Wave so you get 4 Waves with 3 sprints each. To copy a wave, select 

an existing wave and select ‘Copy’ 

 

Figure 73  – Copy Wave 

 Select Phase Build and click on ‘Insert’ 
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Figure 74  – Insert Wave 

 Select the copied Wave and rename it accordingly 

 

Figure 75  – Rename Wave 

 Use the drag and drop via mouse to move the wave to the right place in the structure 
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Figure 76  – Move Waves 

 Repeat step 1-4 until you have 4 waves per build project 

 To rename the underlying tasks like sprints select ‘Table’ view and edit the entries. 

 

Figure 77  – Rename Tasks in Table view 

3.5.5 Define Wave Relationships between Master and Build 
Projects 

 In Master Project select Project node in Structure  Wave Relationship  Wave in Header area and then add 

Waves from Sub Projects to the related wave in Master Project 
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Figure 78  – Wave Relationships 

 Define further relationships according to this table 

Master Project Sub Project 

Wave 1 BUILD 1 - Wave 1 

 BUILD 2 - Wave 1 

Wave 2 BUILD 1 - Wave 2 

 BUILD 2 - Wave 2 

Cross Wave  All Waves from all sub projects 

 

 Check Start / End dates and duration of related waves between master and sub projects and adjust if needed 
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Figure 79  – Wave Relationships and time line 

3.5.6 Link Q-Gates of Master and Build Projects  

 To Link Q-Gates from Build Projects to Master Project select the relevant Milestone Task in Master Project  

Create  - Same Level – Mirrored Task 

 

Figure 80  – Create Mirrored Tasks 

 Select ‘Assign Original Task by Project’, enter Project ID and then select ‘Find Task’ 
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Figure 81  – Assign Original Tasks to Mirrored Task 

 Drilldown and select corresponding Q-Gate from Build Project and select OK 

 

Figure 82  – Select Original Tasks 

 Adjust Name of Mirrored Task and Save 
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Figure 83  – Adjust name of Mirrored Task 

 Repeat step 1-4 for all Q-Gates from Sub Projects that should be visible to Master Project 

3.5.7 Maintain Project Milestones 

If the Solution Readiness Dashboard should provide meaningful data regarding overdue, the related dates for the 

milestones should be maintained. 

Single update of milestone 

 This can be done for each milestone separately while navigating in the structure to the related milestone 

 

Figure 84 - Maintain Milestones (1) 
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 Then selecting the 'Dates and Work' tab and enter the date in 'Finish Constraint'. Constrain type (e.g. Must 

finish on' is set automatically after pressing Enter or Save. 

 

Figure 85 - Maintain Milestones (2) 

Mass update of milestones 

 To update multiple milestones in a table view select view 'Table' and then the 'List Display' button 

 

Figure 86 - Maintain Milestones (3) 

 As the table contains many columns we need to create a view to simplify the maintenance via 'Settings' 

button 
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Figure 87 - Maintain Milestones (4) 

 Select view 'Milestone Due Date Maintenance' 

 

Figure 88 - Maintain Milestones (5) 

 Now you see just the relevant columns to be able to enter / adjust the milestone dates 

 

Figure 89 - Maintain Milestones (6) 

 To make it even more simple you can select a filter for the table that you only see milestones 
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Figure 90 - Maintain Milestones (7) 

 

Figure 91 - Maintain Milestones (8) 

3.5.8 Release Q-Gate(s) 

To get the date for the next Q-Gate visible in the Solution Readiness Dashboard you need to change the status of 

that Q-Gate to ‘Released’.  



 

98 

CUSTOMER  

© 2018 SAP SE or an SAP affiliate company. All rights reserved. 

Focused Build for SAP Solution Manager 

Project Preparation 

 

 

3.5.9 Assign dedicated Release Numbers to Waves (optional) 

This chapter is only relevant if you have several waves per project and you would like to deploy to production after 

end of a wave instead of end of the project. 

 

Standard approach without the need of Wave / Release Number mapping 

 

Figure 92 - Example: 2 Waves per Release Number and Project 
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Special Approach that requires Wave / Release Number mapping 

 

Figure 93 - Example: Project is planned with  2 Waves and 2 Releases 

To define Wave / Release Number mapping for this special approach please execute following steps: 

 In the Build Project select the root Project Element in the Structure  'Work Package'  Schedule 

 

Figure 94 - Adjust Release assignment to wave (1) 

 Open search help of field Release Number for the relevant Wave and select corresponding Release Number 

entry in the list.  
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Figure 95 - Adjust Release assignment to wave (2) 

 New assignment of Release to Wave 

 

Figure 96 - Adjust Release assignment to wave (3) 

3.5.10 Prepare first Wave and Sprint 

To be able to start Wave or Sprint execution the related Wave and Sprint need to be released in the project 

structure. To do so please follow the describe procedure below: 

 Navigate to the related Wave / Sprint in the project structure 
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 In the 'Details' view tab 'Basic Data' click on 'Change Status' and select 'Release' in the drop-down list 

 

 Wave / Sprint is now released so Work Packages / Work Items can be handed over to development. 
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4 Configuration of Standalone Extensions 

 Activities Valid for all Standalone Extensions 

4.1.1 Activating the Piece List 

Call transaction SCC1 in your working client and activate the piece list /SALM/CHARM_EXT, which will supply 

your system with the predefined customizing. The result of this activation can be verified in transaction SCC3. 

 Configuration of Refresh Test System 

The configuration for the Test System Refresh scenario consists of the following steps: 

 

 Adjust Task List 

 Create a Task List Variant for a new customer, 

 Copy Task List Variant SAP0 to the new Task List Variant, 

 Copy Header and Footer Tasks of Task List Variant SAP0 to the new Task List Variant, 

 Register the new Task Refresh Test System, 

 Add the Task List Activity Refresh Test System to the newly created Task List Variant. 

 Adjust the Phase Controller Configuration accordingly. 

 Assign new Task List Variant to Participant, 

 Assign new Task List Variant to Phase Model. 

 Create a Change Cycle and assign the appropriate Landscape and Branch, 

 Assign your new Task List Variant to your new Change Cycle and create a Task List. 

 

The detailed configuration steps, which are described in this Configuration Guide are based on an example 

Simulation Landscape for Focused Build Refresh Test System. 

4.2.1 Prerequisites for Refresh Test Systems 

 The Task List only scenario has been established, 

 Transports have been created for the Simulation Landscape via the Task List only scenario, 

 The Tracking functionality has been activated for the Simulation Landscape, 

 Grant the authorization object S_CTS_ADMI to the TMSADM user. 
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4.2.2 Simulation Landscape for Refresh Test System 

The Simulation Landscape for Focused Build Refresh Test System looks as follows: 

 

4.2.3 Activating the Piece List 

Call transaction SCC1 in your working client and activate the piece list /SALM/CHARM_EXT, which will supply 

your system with the predefined customizing. The result of this activation can be verified in transaction SCC3. 

4.2.4 Adjusting Task List 

Creating the Task List Variant 

As first step a new Task List Variant should be created. In the customizing of SAP Solution Manager, choose SAP 

Solution Manager → Capabilities (Optional) → Change Control Management → Schedule Manager → Create 

Customer-Specific Variant for Task Lists. 

The new Task List Variant <GPN1> is a copy of the Task List Variant SAP0: 
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The new customizing has been saved to the following transport request: 

 

Copy Variant SAP0 to Task List Variant <GPN1> for Project Type Continual Cycle 

In the customizing of SAP Solution Manager, choose SAP Solution Manager → Capabilities (Optional) → Change 

Control Management → Schedule Manager → Define Additional Tasks for Task Lists 

Mark all entries with Task List Variant SAP0 and Project Type Continual Cycle: 

 

Then press the button Copy: 

 

Perform this step for each selected task of the SAP Task List Variant SAP0 with Project Type Continual Cycle and 

replace it with the new Task List Variant <GPN1>. 

As result all tasks of Task List Variant SAP0 are copied to the new Task List <GPN1>: 
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Copy Variant SAP0 to Task List Variant <GPN1> for Project Type Urgent Changes 

If you are using Urgent Change, the referring tasks in Task List Variant SAP0 must be copied to the new Task List 

<GPN1> as well. 

Click on the IMG node Define Additional Tasks for Task Lists and mark all entries with Task List Variant SAP0 and 

Project Type Urgent Change.  

Then press the button Copy. 

Perform this step for each selected task of SAP Task List Variant SAP0 with Project Type Urgent Change and 

replace it with the new Task List Variant <GPN1>. 

As result all Urgent Change related tasks of Task List Variant SAP0 are copied to the new Task List Variant 

<GPN1>. 

Copy Variant SAP0 to Task List Variant <GPN1> for Project Type Phase Cycle 

If you are using Phase Cycle, the referring tasks in Task List Variant SAP0 must be copied to the new Task List 

<GPN1> as well. 

Click on the IMG node Define Additional Tasks for Task Lists and mark all entries with Task List Variant SAP0 and 

Project Type Phase Cycle. 

Then press the button Copy. 

Perform this step for each selected task of SAP Task List Variant SAP0 with Project Type Phase Cycle and replace 

it with the new Task List Variant <GPN1>. 

As result all Phase Cycle related tasks of Task List Variant SAP0 are copied to the new Task List Variant <GPN1>. 

Copy Variant SAP0 to Task List Variant <GPN1> for Project Type Release Cycle 

If you are using Release Cycle, the referring tasks in Task List Variant SAP0 must be copied to the new Task List 

<GPN1> as well. 

Click on the IMG node Define Additional Tasks for Task Lists and mark all entries with Task List Variant SAP0 and 

Project Type Release Cycle. 

Then press the button Copy. 

Perform this step for each selected task of SAP Task List Variant SAP0 with Project Type Release Cycle and 

replace it with the new Task List Variant <GPN1>. 

As result all Release Cycle related tasks of Task List Variant SAP0 are copied to the new Task List Variant <GPN1>. 
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Copy Variant SAP0 to Task List Variant <GPN1> for Header and Footer Tasks 

Launch transaction SPRO and choose the following customizing of SAP Solution Manager: SAP Solution Manager 

→ Capabilities (Optional) → Change Control Management → Schedule Manager → Create Customer-Specific 

Header and Footer Tasks Mark all entries with Task List Variant SAP0 and Project Type Continual Cycle: 

  

Then press the button Copy: 

  

Perform this step for each selected Header and Footer Task of SAP Task List Variant SAP0 with Project Type 

Continual Cycle and replace it with the new Task List Variant <GPN1>. 

As a result all header and footer Tasks of the Task List Variant SAP0 are copied to the new Task List <GPN1>: 
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Copy Variant SAP0 to Task List Variant <GPN1> for Urgent Change Related Header and Footer 
Tasks 

If you are using Urgent Changes, the referring header and footer tasks in the Task List Variant SAP0 must be 

copied the new Task List <GPN1> as well. 

Click on the IMG Node Create Customer-Specific Header and Footer Tasks and mark all entries with Task List 

Variant SAP0 and Project Type Urgent Change. 

Then press the button Copy. 

Perform this step for each selected header and footer task of SAP Task List Variant SAP0 with Project Type Urgent 

Change and replace it with the Task List Variant <GPN1>. 

As result all Urgent Change related header and footer tasks of Task List Variant SAP0 are copied to the Task List 

<GPN1>. 

Copy Variant SAP0 to Task List Variant <GPN1> for Phase Cycle Related Header and Footer 
Tasks 

If you are using Phase Cycle, the referring header and footer tasks in the Task List Variant SAP0 must be copied 

the new Task List <GPN1> as well. 

Click on the IMG Node Create Customer-Specific Header and Footer Tasks and mark all entries with Task List 

Variant SAP0 and Project Type Phase Cycle. 

Then press the button Copy. 

Perform this step for each selected header and footer task of SAP Task List Variant SAP0 with Project Type Phase 

Cycle and replace it with the Task List Variant <GPN1>. 

As result all Phase Cycle related header and footer tasks of Task List Variant SAP0 are copied to the Task List 

<GPN1>. 

Copy Variant SAP0 to Task List Variant <GPN1> for Release Cycle Related Header and Footer 
Tasks 

If you are using Release Cycle, the referring header and footer tasks in the Task List Variant SAP0 must be copied 

the new Task List <GPN1> as well. 

Click on the IMG Node Create Customer-Specific Header and Footer Tasks and mark all entries with Task List 

Variant SAP0 and Project Type Release Cycle. 

Then press the button Copy. 
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Perform this step for each selected header and footer task of SAP Task List Variant SAP0 with Project Type 

Release Cycle and replace it with the Task List Variant <GPN1>. 

As result all Release Cycle related header and footer tasks of Task List Variant SAP0 are copied to the Task List 

<GPN1>. 

Registering the New Task Refresh Test System 

Launch transaction SM30 

Enter table SCMAPROGRAMS and press the button Maintain: 

 

Add new entry for the report /SALM/RTS_REFRESH_SYSTEM: 

 

Adding the Task List Activity Refresh Test System to the Task List Variant <ZSRE1> 

As next step, you must add the new Task List Activity Refresh Test System to the customer own Task List Variant 

<ZSRE1>. In the customizing of SAP Solution Manager, choose SAP Solution Manager → Capabilities (Optional) → 

Change Control Management → Schedule Manager → Define Additional Tasks for Task Lists. This configuration 

step can only be performed after the SAP Add On Package ST-OST 200, SP01 has been successfully implemented 

in your SAP Solution Manager System. 

Press the button New Entries and create the new entry with 

• Project Type = Continual Cycle, 

• Type of Role = O, 

• Number = 4000, 

• Description = Refresh Test System, and 

• Program Name = /SALM/RTS_REFRESH_SYSTEM. 

• Task Type = Transaction/Online Program 
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The new task Refresh Test System calling the program /SALM/RTS_REFRESH_SYSTEM is now available for target 

systems with Role Type O: 

 

Repeat this activity for each Project Type in scope. 

4.2.5 Creating Change Cycle and Assign Task List Variant for 
New Customer to Task List 

Next, one or several change cycle(s) need to be defined for your Change Controlled Landscape. 

To do this, launch the SAP Fiori Launchpad via transaction SM_WORKCENTER and go to Change Management. Then 

click on the tile Change and Release Management. 

Select one of the business roles SOLMANPRO, or ZSOLMANPRO,  

Click on Create  Change Cycle in the left navigation frame, 

Two types of change cycles available with SAP Solution Manager Release 7.2 will be offered for selection: 

 

• SMAI Continual cycle 

• SMIM Phased cycle 

 

The phased cycle (Transaction Type SMIM) can be used for 

Implementation projects, as well as for Maintenance and is based on a Consolidated Import for the Change Cycle.  
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Urgent changes, Preliminary imports and Status-dependent imports can be processed in parallel. The import is 

executed as Import Subset. The assigned transport requests will stay in buffer for re-import and will be taken into 

account by the Consolidated Import again. 

 

In contrast, the continual cycle (Transaction Type SMAI) should only be used if a deployment of transports on 

Demand, or daily, or on regular defined weekdays is required. 

 

Transports will be imported only once and will not stay in buffer. 

Create a Change Cycle 

Launch the SAP Fiori Launchpad via transaction SM_WORKCENTER, go to Change Management and click on the tile 

Change and Release Management: 

 

Select SOLMANPRO as Business Role, the CRM WebUI opens, next, select Create  Change Cycle from the left 

navigation frame, and then choose Phase Cycle from the Pop up: 

 

Enter a meaningful description for your new Change Cycle and assign the relevant landscape and maintenance 

branch: 
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Assign Your Task List Variant and Create a Task List for Your Change Cycle 

To create a Task List for your phase cycle, press the button Actions and select Set Phase to Scope: 

 

Quit the next Pop up with Yes: 

 

Next, a guided procedure opens. 

In the first step Check Prerequisites the system automatically shows if all technical prerequisites to generate a 

Task List for your change cycle are met: 
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In Step 2 of the guided procedure you define the Scope: 

For the mandatory field Task List Variant, you must select your Task List variant GPN1 via the F4-Help: 

 

Proceed with the guided procedure up to Step 4 Complete, 

Lastly, select Create: 
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As the scope of your new phase cycle is fully defined, the referring Task List will now be generated automatically: 

 

4.2.6 Executing the Refresh Test System Scenario 

Execute Delta Run: Calculate the Delta to another System 

First, execute the new task Refresh Test System which is available for the Target System TRG:  

 

Choose D: Delta Run: Calculate Delta to another System from the Drop Down List in the Pop up and press Run: 



 

114 

CUSTOMER  

© 2018 SAP SE or an SAP affiliate company. All rights reserved. 

Focused Build for SAP Solution Manager 

Configuration of Standalone Extensions 

 

 

On the next Pop up, select the source system (Production System SRD, Client 001) from the list and press the 

button Select: 

  

At this point in time, you have the option (recommended) to let the system update the central transport tracking 

information, which the Delta Calculation will be based on. To do so, press Yes: 

 

You receive a system message confirming the Delta Calculation was performed successfully: 

  

The Delta Calculation of transports is saved to the following tables: 

/SALM/DELTA_C, 

/SALM/DELTA_H 

Perform the System Copy 

As a next step, perform the System Copy itself. 
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Execute Refresh Run: Add Calculated Delta to Another System 

Execute the Task Refresh Test System again. 

Select the option Refresh Run: Add Calculated Delta to another System from the drop down list in the pop up and 

press Run: 

 

As a next step, select the Source System (Production System SRD, Client 001) from the list and press the button 

Select: 

 

You can now choose the existing Delta Calculation(s): 

 

Select one of the available Delta Calculations. If more than one exists, you would choose the most current one. 

Mark the selected Delta Calculation with your cursor, and then press the button Continue: 
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As a result, the list of transports, which is being displayed in the next pop up, will be re-added to the import buffer 

of the refreshed Test System TRG, if you press the button ok: 

 

4.2.6.1 Perform the Import via SAP Change Request 
Management (Import Project All) 

As last step, trigger the import to system TRG via the Task List. 

4.2.7 Available BADI Definition: 
/SALM/RTS_FILTER_DELTA_BAdI 

If of specific customer requirements, the Delta Calculation for another system can be influenced with the help of a 

BAdI Implementation for the BAdI definition /SALM/RTS_FILTER_DELTA_BADI. 

The coding in the BAdI Method must be developed based on the individual customer requirements. 
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Please refer to documentation of the BAdI /SALM/RTS_FILTER_DELTA_BADI. 

 Configuration of Retrofit Automation 

4.3.1 Required Activities 

Implement or verify the correct implementation of the central SAP Solution Manager Note depending on the SP 

level of your SAP Solution Manager system. 

Before you start the configuration ensure that your Solution Manager 7.2 system has software component ST-

OST 200, SP01 installed.  

Use path System  Status… 
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4.3.2 Basic Configuration for SAP Solution Manager 

Before starting with the basic configuration of your SAP Solution Manager system you should read the 

documentation and initial descriptions available in the Implementation Guide (transaction SPRO).  

Therefore, navigate to SAP Solution Manager Implementation Guide  SAP Solution Manager  Mandatory 

Configuration  Basic Configuration: Guided Procedure 

 

Via the transaction SOLMAN_SETUP, you start the initial configuration of the SAP Solution Manager system. In the 

navigation area on the left under Mandatory Configuration, you can access the following guided procedures which 

contain configuration steps relevant for the Change Request Management scenario:  

System Preparation: In this guided procedure, you define settings preliminary for the Solution Manager 

Configuration, such as creation of dialog users with the required authorizations, implementation of the central 

Correction Note and Web Service configuration. 

Infrastructure Preparation: Within the Infrastructure Preparation, you set up the SLD connections, establish 

LMDB synchronization and set up the Java connectivity. Furthermore, you will set up SAP BW as well as the E-Mail 

communication and enable the gateway services.  

Basic Configuration: This guided procedure leads you through all configuration steps which you have to perform 

to enable basic scenarios in SAP Solution Manager. As part of the basic configuration, you set up the connection 
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to SAP, schedule relevant background jobs and activate piece lists which contain important settings, such as 

standard customizing. 

Managed Systems Configuration: In the Managed System Configuration, you connect Managed Systems to SAP 

Solution Manager via RFC. This is important, since SAP Change Request Management requires a READ, TMW and 

TRUSTED RFC connection to every Managed System/Client. In order to ensure that SAP Change Request 

Management works perfectly with Managed Systems a minimum SP Level is required. Please check SAP Note 

907768 for further details. 

 

Confirm that you have successfully performed those three configuration steps according to the guided procedure 

documentation. 

In addition to the basic configuration for SAP Solution Manager you have to perform the basic configuration for 

SAP Change Request Management. 

4.3.3 Piece List Activation 

The standard customizing of SAP Change Request Management and all other IT Service Management relevant 

areas is delivered via a so called customizing piece list. This piece list needs to be activated as part of transaction 

SOLMAN_SETUP and will copy the standard customizing from Client 000 into the working client of SAP Solution 

Manager. 

 

Activating the piece list again will overwrite all existing standard customizing with the content of the piece list – 

therefore it is highly recommended to copy all transaction types into the customer namespace before starting to 

use SAP Change Request Management.  

 

 Caution 

The existing BC-Sets of SAP Change Request Management are not supposed to be activated within a 7.2 

system, since they are replaced by the customizing piece list. 
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In addition, it is required to activate a dedicated piece list for the standalone enhancement. Therefor call 

transaction SCC1 in your working client and activate the piece list /SALM/CHARM_EXT, which will supply your 

system with the predefined customizing. The result of this activation can be verified in transaction SCC3. 

4.3.4 Checking for Correct Retrofit Setup: NO_CSOL 
Parameter Must be Active 

SPRO  SAP Solution Manager Implementation Guide  SAP Solution Manager  Capabilities (Optional)  

Change Control Management  Retrofit  Define Retrofit Parameters 

 

As writing a CSOL entry could trigger a CSOL popup resulting in the cancellation of the background job, we need 

to set the parameter No Cross-System Object Lock for import Objects. 
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4.3.5 Activating Retrofit Automation Scenarios 

 

 

Create new entries: 
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The following scenarios are available: 

AUTO_BW 

Retrofit for BW: Retrofit enablement for critical BW Objects (supported object types: ISFS, ISMP, ISTS, ROUT, 

RSDS, RSFO, TRFN) 

 

AUTO_FULL 

Full Scope: extend the Retrofit automation scope by auto-import objects from mixed transports 

 

AUTO_STOP_AT_ERROR 

Stop at failed Retrofit (Auto-Import): The Retrofit Automation report will cancel the processing of further 

transports if the auto-import for a transport was not successful. 

 

AUTO_TOC 

Transport of Copies (ToCs) as Retrofit Target: Transports without conflicts are retrofitted via the Retrofit 

automation job. The retrofitted objects are recorded into a ToC which can be released and imported into the test 

system automatically. 

 

 IMG Activity: Define Target Systems for Importing Retrofit Transport of Copies is needed for this Scenario (see 

chapter 3.7). 

 

AUTO_TR 

Original Transport as Retrofit Target: Transports without conflicts are retrofitted via the Retrofit automation job. 

The retrofitted objects are recorded into an automatically created transport. 

 

 IMG Activity: Specify Retrofit Target Task List for Retrofit Automation is needed for this Scenario (see chapter 

3.5). 

 

AUTO_CD 

Change Document as Retrofit Target: Transports without conflicts are retrofitted via the Retrofit automation job. 

The retrofitted objects are recorded into an automatically created transport. The transport is linked to an 

automatically created Change Document. 

 

 IMG Activity: Specify Mapping Rules for Target Change Document Creation is needed for this Scenario (see 

chapter 3.6). 
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4.3.6 Specifying Retrofit Target Task List for Retrofit 
Automation 

 

Specify which Task List should be used as Target Task List for the Retrofit Target transport. These settings are 

relevant for the Retrofit Automation scenario Original Transport as Retrofit target (AUTO_TR) only. 

Create an entry for each Source Task List ID and the referring Source and Retrofit system combination including 

clients and enter the Target Task List ID from the implementation line that you want to use as receiving target. 
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4.3.7 Specifying Mapping Rules for Target Change Document 
Creation 

 

These settings are only relevant for the Retrofit Automation scenario Change Document as Retrofit Target 

(AUTO_CD). 

Transports without conflicts are retrofitted via the Retrofit automation job. The retrofitted objects are recorded 

into an automatically created original transport request. The transport is linked to an automatically created 

Change Document. 

Create an entry for each relevant Source- and Target Transaction Type. If required, define which additional data, 

such as  

• Appointments,  

• Texts, or  

• Partner Functions 

 should be mapped on change document creation. 

 

Example for mapping of texts between relevant Source- and Target Transaction Type: 
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Exemplary mapping of partner functions between Source- and Target Transaction Type: 

 

4.3.8 Defining Target Systems for Importing Retrofit 
Transport of Copies 

 

The configuration activity is relevant for the Retrofit automation scenario Use Transport of Copies as Retrofit 

Target (AUTO_TOC) only. 

Define target system(s) for import of Retrofit ToCs for each source development system in your 

implementation/project landscape. 

Enter a target system/client for each source system/client (Project Development System) in your 

implementation/project landscape. 
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4.3.9 Defining Retrofit Automation E-Mail Settings 

Configuring Standard Texts 

The following Standard Texts are configured as a global definition: 

TA-Code SE61 

 

/SALM/RETRO_MAIL_SUCCESS for the success mail (successful retrofits) 

 

/SALM/RETRO_MAIL_ERROR for the error mail (failed retrofits) 

 

Defining Retrofit Automation E-Mail Settings 

With AddOn Package ST-OST 200 based on SAP Solution Manager Release 7.2 the new IMG Node Define Retrofit 

Automation E-Mail Settings, including a detailed Documentation, is available: 
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With a click on the IMG node, the database table /SALM/RETRO_MAIL is called:  

 

Use GLOBAL as default or individual Task Lists. Then enter the text objects you want to use for Success and/or 

Error Mail. 

To switch off both email notifications (Success- and Error Mail), set the Switch mail off flag.  

To switch off a specific type of email notification (Success- or Error Mail), leave the corresponding Mail Text 

Object field empty. 

Further Prerequisites: 

• Email will only be send out if the email address is maintained properly in the relevant business partner, and 

the business partner is linked to the USER who is the owner of the TR to be retrofitted, 

• In addition, email setup SCOT needs to be setup properly 

 Use TA SOST to preview the mail before it is send out 
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4.3.10 Activating Relevant Business Add-In Implementations 

 

Retrofit Release BAdI 

Activate BAdI implementation /SALM/RETRO_RELEASE if you use the Retrofit for BW scenario on top of the 

retrofit Automation (Parameter AUTO_BW). 

Also, the BAdI Implementation /SALM/RETRO_RELEASE has to be activated in case you want to navigate to the 

Change Documents which a Transport to be retrofitted or a Retrofit Target Transport is assigned to. (Please refer 

to chapter 3.10). 

During Retrofit BAdI 

You don't need a retrofit automation scenario. 

However, if you intend to utilize Additional Functions from the Menu of the Retrofit List, the BAdI Implementation 

/SALM/DURING_RETROFIT must be activated. 

After Retrofit BAdI 

Activate BAdI implementation /SALM/AFTER_RETROFIT if you choose to use ToCs as targets (AUTO_TOC) and 

want to automatically release and import them. 

Also in combination with the BW scenario this Badi Implementation must be activated. 

BAdI for Automatic Transport Assignment 

Activate BAdI implementation BAdI implementation /SALM/RETROFIT_AUTO_IMPL which generates one of the 

following transport types as Retrofit target: 

Transport of Copy 

Original Transport 

Depending on the Retrofit Automation scenario, parameter you choose: 

AUTO_TR (Use Original Transport as Retrofit target) 

AUTO_TOC (Use ToC as Retrofit target) 
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4.3.11 Optional: Enabling Navigation to Change Document 

If you use the Full ChaRM Scenario with the Retrofit Automation Scenario AUTO_CD, you might wish to navigate 

from a transport request (in Status: To be Retrofitted) or a Retrofit target request to the Change Document, 

In the following chapter, the configuration steps, which are required to enable this functionality, are described in 

detail. 

Activating Standard Retrofit Parameter Show Change_ID Field 

As a first step, navigate to the IMG Node Define Retrofit Parameters: 

 

Activate the Retrofit standard parameter Show Change_ID Field: 

 

Result: The Column Change_ID will be displayed on the Retrofit list. 

Adding Additional Function Display Change Document (Parameter DISP_CD) to the Menu of 
the Retrofit Tool 

Go to database table /TMWFLOW/ADDFUNC and ensure that an entry for the Code DISP_CD (Additional 

Function: Display Change Document) is available. 

Result: The Additional Function will be added to the Retrofit list's menu / Additional Functions. 

Next, launch database table /SALM/RFIT_PARAM and make a New Entry for Code DISP_CD. 
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Then go to the IMG Node Activate Retrofit Automation Scenarios: 

 

The Code DISP_CD should now be displayed as Retrofit automation parameter. Finally, set this Parameter to 

Active. 

Result: The navigation to the referring Change Document is now enabled. However, the full technical enablement 

of this additional function still requires the activation of the BAdI implementation '/SALM/DURING_RETROFIT', 

which is described in chapter 3.10.3. 

In addition, the BAdI implementation /SALM/RETRO_RELEASE must be Active as well in order to fill the field 

Change ID on the Retrofit list. (This will be described in chapter 3.10.4). 

Activating the BAdI Implementation /SALM/DURING_RETROFIT 

The BAdI method contains the coding for the technical enablement of additional functions in the Retrofit list's 

menu.  

If you intend to use additional functions in the menu of the Retrofit tool, you have to set the BAdI implementation 

/SALM/DURING_RETROFIT to Active: 
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Result: The additional function Display Change Document is now technically fully enabled. 

Activating the BAdI Implementation /SALM/RETRO_RELEASE 

The activation of the BAdI implementation /SALM/RETRO_RELEASE is a prerequisite for the additional function 

Display Change Document as the field Change ID on the Retrofit list is automatically filled with the referring 

Change ID, when an original transport is released and put to the Retrofit list. 

(Relevant method: /TMWFLOW/RELEASE_IF~EDIT_CHANGE_ID). 

 

4.3.12 Calling Report /SALM/ENH_RETRO_AUTOMATION 

SE38: report /SALM/RETRO_AUTOMATION  F8  

 

Field Task List ID: Enter the current Task List ID for maintenance here 

Start the retrofit automation via this report. 
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4.3.13 Creating a Regular Job for Retrofit Automation 

The following general recommendations can be made for scheduling the report: 

Variants 

• Create a variant for each retrofit queue 

Multiple steps 

• Do not create multiple jobs 

• Create multiple steps in one job with the same program, but different variants which have been defined 

• Create only different jobs when there is a different scheduling requirement 

Scheduling interval and period 

• Schedule the job at least daily 

• Fast scheduling is possible, e.g. hourly run 

• Watch the steps and queue size which should be processed, as some runtime is required 

Monitor job logs 

 Configuration of Retrofit for BW 

4.4.1 Enhanced Retrofit Without Implemented Focused Build 
‘Retrofit for BW’ 

Before implementing the Focused Build Retrofit for BW, the SAP Standard Scenario for Enhanced Retrofit will 

always classify the following critical BW objects as Manual Retrofit: 

 

• File Data Source (ISFS), 

• Transfer Rule (ISMP), 

• Transfer Structure (ISTS), 

• Data Source (RSDS), 

• Transformation (TRFN), 

• Routine (ROUT), 

• BW Formula (RSFO). 

 

This is also valid in case these critical BW objects were newly created in the Maintenance Development System, as 

the Enhanced Retrofit Scenario cannot detect conflicts between the Source- and the Retrofit Target System. 
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4.4.2 Setup of a Simulation Landscape for Focused Build 
Retrofit for BW 

The detailed configuration steps which are described in this Configuration Guide are based on an exemplary SAP 

BW Simulation Landscape for Focused Build Retrofit for BW: 

 

SAP Solution Manager System:    XSC, Client 100, 

Maintenance Development System for SAP BW:  XB1, Client 285, 

Retrofit Target System for SAP BW:   XB3, Client 885, 

Source System for SAP BW MAINT DEV System:  XR3, Client 286, 

Source System for SAP BW Retrofit Target System:  XR7, Client 286. 

 

Be aware, that for successful testing of Focused Build Retrofit for BW, the Simulation Landscape must 

comprise the Source Systems (e.g SAP ERP) of the SAP BW Development Systems as well. 

For instance, if you intend to create a data source (for instance for a specific database table) in the SAP BW 

Maintenance Development System (System XB1, Client 285), this object should exist in the referring Source 

System (System XR3, Client 286) first. 

 

For the Retrofit itself the same prerequisite is valid: This means that, the Source System XR7, Client 286 must be 

provided with the object in question before the Retrofit of the referring data source from XB1, Client 285 to the 

SAP BW Retrofit Target System XB3, Client 885 can be executed successfully. 

 

Exemplary Simulation Landscape for Focused Build Retrofit for BW: 
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4.4.3 Configuration Steps for Focused Build Retrofit for BW 

Implementing Required SAP Notes 

SAP Note Description SAP 

Solution 

Manager 

Managed 

System 

2180454 Retrofit: all requests from the project are displayed in the 

Retrofit window when processing Retrofit action from one 

Change Document 

X  

2199925 Retrofit: error "comparison not supported for object type 

TABU" is raised when comparing source and target system 

X  

2205606 Retrofit: incorrect categorization for customizing requests 

with language key '*' 

X  

2208176 Retrofit: error about nonexistence of function module 

TRINT_GET_TLOGO 

X X 

2211446 Retrofit: sequence dependency of transport request is 

incorrectly calculated when generate Retrofit data again 

X  
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SAP Note Description SAP 

Solution 

Manager 

Managed 

System 

2216032 Retrofit: runtime error DBIF_RSQL_INVALID_RSQL during 

Retrofit data creation 

X  

2223092 Retrofit: error TK103 during auto-import language objects X X 

2311560 Function module RSO_GET_RELATED does not work  X 

2316496 Errors in retrofit autoimport of BW objects X  

2339934 Saving queries takes a very long time in retrofit scenario  X 

2355901 SP36:Determination of Transformations for Retrofit  X 

2362842 Retrofit for BW: Various corrections for ST-OST 100 SP4 X  

2395235 SP37:Determination of Transformations for Retrofit (II)  X 

2401952 730SP17:Development class of transformation is reset to 

$TMP during re-import 

 X 

 

SAP Note 2362842 includes manual activities and dependent SAP Notes. 

Preparation of SAP BW-Environment 

For the usage of SAP Change Request Management (ChaRM) and Focused Build Retrofit for BW the BW Transport 

Connection Tool cannot be used. In the tool, it is possible to store all changed objects locally before they are 

assigned to a transport request.  

 

Impact: When the objects are later assigned to a transport request, the Cross-System Object Lock Entries are not 

created.  

Therefore, it is mandatory to activate the SAP Standard Transport Management Connection (SAP TMS) for SAP 

BW. In order to do so, perform the following steps in transaction RSA1: 

 

Press the button Transport Connection in the left navigation frame of transaction RSA1. 

 

Menu: Go to Edit  Transport  Switch-On Standard: 
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Switch to the SAP Standard Transport Management Connection (SAP TMS) for both the 

• SAP BW Maintenance Development System, as well as on the 

• SAP BW Project-/Release Development System. 

Maintenance of Database Table RSLOGSYSMAP 

For source system dependent BW objects in table RSLOGSYSMAP it is maintained how the source system should 

change after a transport is imported with such a source system dependent object.  

For instance, the connected SAP ERP source system is different for SAP BW Development and SAP BW QAS 

system. In this table the original source system (Field: 'LOGSYSORG') must be the source system for SAP BW 

Development (e.g. SAP ERP DEV) and the target source system (Field: 'LOGSYSNEW') must be the source system 

for SAP BW QAS (e.g. SAP ERP QAS). 
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To maintain this mapping, launch transaction SM30 of your SAP BW systems and make the required entries in 

table RSLOGSYSMAP. 

 

Importing Remote API for Focused Build Retrofit for BW to Source-and Retrofit System 

The following transport (Retrofit for BW Extension Remote (Remote API)) was bundled on the SAP Solution 

Manager System XSC and needs to be imported in both the  

• SAP BW Project Development System XB3 (Retrofit Target System), as well as in the  

• SAP BW Maintenance Development System XB1 (Source System): 

 

Proceed in the following way: 

 

 Go to Transport Organizer (Transaction SE09) in the Customer SAP Solution Manager, choose Request/Task 

 Create from the menu and create an empty transport of copies (in our example: XSCK900055). 

 Next, save the development package for the Retrofit for BW Extension Remote API's to your newly created 

transport of copies:  

Launch transaction SE80,  

Enter /SALM/* as package and press the Input Help (Arrow icon),  

Select Development Package /SALM/RETRO_BW_MS on the following pop up and press the button ok, 

Mark Development Package /SALM/RETRO_BW_MS with the cursor, do a right mouse click and press the 

button Write Transport Entry from the menu, 

Press the button All Entries (All objects of the Development Package are saved to the transport request) on 

the following pop up 

On the next pop up you have to enter the Transport Order No. of your newly created transport of copies as 

transport order, 

By saving Development Package /SALM/RETRO_BW_MS to the transport of copies, the required Function 

Group /SALM/ FGR_RETRO_BW_MS (R3TR FUGR /SALM/FGR_RETRO_BW_MS) will be saved to the ToC as 

well. 

 Release the objects of your transport of copies. 

As target for the transport of copies you can enter the QAS SAP Solution Manager System. 
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 Put the transport of copies to the Import Queues of the Source- and Retrofit Target System 

Launch transaction STMS on the QAS SAP Solution Manager System and select Overview  Imports from the 

menu. 

Display the Import Queue of the SAP Solution Manager System,  

Mark your Transport of Copies (XSCK900055) with the Cursor and choose Request  Forward  System 

from the Menu, and enter the Source System (XB1) 

As next, forward the Transport of Copies to the Import Queue of the Retrofit Target System as well.  

 Import the Retrofit for BW Extension Remote API's in the Source System and the Retrofit Target System 

Launch Transaction STMS in the Source System XB1 and choose Menu: Overview  Imports 

The Import Queue of the Source System XB1 is displayed: 

 

        Mark the Transport of Copies (XSCK90055) with the Cursor and press the Icon 'Import request'. 

 

Launch Transaction STMS in the Retrofit Target System XB3 and choose Menu: Overview  Imports 

The Import Queue of the Retrofit Target System XB3 is displayed: 
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Mark the Transport of Copies (XSCK90055) with the Cursor and press the Icon 'Import request'. 

Activate BAdI Implementation /SALM/RETRO_RELEASE 

In order to activate the BAdI Implementation /SALM/RETRO_RELEASE (Enhancement Implementation: 

/SALM/RETRO_EXTENSIONS) use the following IMG path of SAP Solution Manager, choose SAP Solution 

Manager → Focused Build → Retrofit → Business Add-Ins → Activate Retrofit Release BAdI Implementation. 

 

Set the Actve(IMG) flag to activate the BAdI implementation. 

The BAdI Implementation /SALM/RETRO_RELEASE_BW is required in order to apply additional logic for the 

successful conflict detection and object classification at Transport Release regarding the described critical BW 

Object Types. 

Activate BAdI Implementation /SALM/AFTER_RETROFIT 

In order to activate the BAdI Implementation /SALM/AFTER_RETROFIT (Enhancement Implementation: 

/SALM/RETRO_EXTENSIONS) use the following IMG Path path of SAP Solution Manager, choose SAP Solution 

Manager → Focused Build → Retrofit → Business Add-Ins → Activate Retrofit Release BAdI Implementation. 

 

Set the Actve(IMG) flag to activate the BAdI implementation. 

In a non-conflict case, the BAdI Implementation /SALM/AFTER_RETROFIT is required to delete the old BW Object 

GUID after successful Retrofit, and, in a second step, assign the adequate GUID to the critical SAP BW Object. 

In addition, the Original System is adjusted automatically and the critical SAP BW Object is saved to the Retrofit 

Target Transport Request. 

Maintain Retrofit-Critical Objects 

As next, you must maintain the Retrofit-Critical Objects. In the customizing path of SAP Solution Manager, choose 

SAP Solution Manager → Capabilities (Optional) → Change Control Management → Retrofit → Define Values for 

Retrofit Scenarios. 

In the control table for Objects used in Retrofit Scenarios, you will find an entry for each Critical SAP BW Object 

Type, as the Enhanced Retrofit cannot perform a conflict detection for these objects. In consequence, the 

Enhanced Retrofit will put all critical SAP BW Objects to Manual Retrofit. 

As we are implementing the Focused Build Retrofit for BW, we must delete the following entries from the table: 
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Deactivate Retrofit Parameter SCEN_BW (BW Scenario for Retrofit) 

In addition, check if the Parameter BW Scenario for Retrofit is set to Active. In the customizing path of SAP 

Solution Manager, choose SAP Solution Manager → Capabilities (Optional) → Change Control Management → 

Retrofit → Define Retrofit Parameters. 

The Retrofit Parameter SCEN_BW (BW Scenario for SAP Standard Functionality of Enhanced Retrofit), is set to 

Active by default. As we do not want to use the BW Scenario for SAP Standard Retrofit, but the Focus Build 

Retrofit for BW, we must deactivate this Retrofit Parameter: 

 

Additional Authorizations for TMW RFC USER on Retrofit Target System required 

The TMW RFC User (in our case: SMTMXSC) requires additional authorization for the new Function Group 

/SALM/FGR_RETRO_BW_MS on the Retrofit Target System XB3: 

 

In addition, the TMW RFC User also requires the authorization for the Function Module 

'RS_TRFN_GET_RETROFIT_TRANIDS'. This RFC Authorization has been embedded in the newest Authorization 

Profile 'SAP_SOLMAN_TMW_702'. 
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4.4.4 Retrofit with Implemented Focused Build Retrofit for 
BW 

After implementation of the Focus Build ‘Retrofit for BW’ non-conflicting critical SAP BW Objects will be classified 

with ‘Green’ ('Auto-Import'). 

 

In Conflict Case, a critical BW Object will still be put to Manual Retrofit (Classification: ‘Red’). 

 Configuration of Repack for Change Request 
Management 

4.5.1 Overview 

The purpose of this document is to describe the Repack functionality and configuration. 

This functionality addresses complex system landscapes where you may work with dual development tracks 

delivering one or more production systems.  

For example, there is one development track used for maintenance of the production system(s) and another 

development track used for implementation and enhancement projects. As part of the preparation of the Go-Live 

of such a project, you need to document this as a change to your up and running production system(s). Therefore, 

this project needs to be passed as a change through the maintenance track, which would add additional benefit of 

performing dress rehearsal in this track. 

 

The project that needs to be passed through the maintenance track will consist of many - likely up to 100 and 

more - changes respectively its transport requests. 



 

142 

CUSTOMER  

© 2018 SAP SE or an SAP affiliate company. All rights reserved. 

Focused Build for SAP Solution Manager 

Configuration of Standalone Extensions 

 

To improve the performance during the technical transport and the handling during cut over and go live, the 

transport requests of the implementation project can be repacked into one change (respectively its transport) of 

the maintenance cycle. 

4.5.2 Roles and Authorization 

TMW User 

The TMW User, maintained in the RFC connection, needs the authorization object S_RFC with the following values: 

 

S_RFC 

• Activity: Execute 

• Name of RFC to be protected: /SALM/CHARM_REPACK 

Type of RFC object to be protected: Function Module 

 

Change Manager 

The user who performs the Repack requires the authorization object SM_FIELD with the following values: 

 

SM_FIELD 

• Business Transaction Type: SMHF, SMMJ 

• Field name: /SALM/REPACK, /SALM/XLD 

 

The authorization is included in the role SAP_OST_CM_TRANSPORT_M. 

4.5.3 Package Distribution for Managed System 

The Package /SALM/CHARM_REPACK_MS must be deployed to each managed system, where the Repack is to be 

performed. 

4.5.4 Repack Options 

During the Repack process, the guided procedure offers several options: 

 

Step 1: Scenario 

• Repack by Transport 

In the next step, you will be able to select Transport Requests freely from the Source System. 

 

• Repack by Change Cycle 
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In the next step, you will be able to select Transport Requests assigned to a given Change Cycle. 

 

Step 2: Source (Repack by Transport) 

• Source System 

Select the relevant source system (if multiple are available). The Source System is the system where the 

Repack takes place. 

 

• Start Date 

Select a Start Date to show transports requests that were imported into the Source System during a 

particular period of time. 

 

• End Date 

Select an End Date to show transports requests that were imported into the Source System during a 

particular period of time. 

 

• Show Open Transports 

Select if open transport requests should be shown in the result list (Start and End Date have no effect here). 

 

• Show ToC 

Select if Transport of Copies should be shown in the result list. 

 

Step 2: Source (Repack by Change Cycle) 

• Source System 

Select the relevant source system (if multiple are available). The Source System is the system where the 

Repack takes place. 

 

• Change Cycle 

Select the Change Cycle to display all assigned transport requests that were imported into the Source 

System. 

 

Step 3: Target 

• Workbench Request 

Select a target workbench request (if multiple are available). 
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• Customizing Request 

Select a target customizing request (if multiple are available). 

 

• Change Originality 

Change Originality of workbench objects to the Source System. 

 

• Add Directory Locks 

If transport locks exist for objects that should be repacked in the Source System, the function will delete these 

locks in order to add the locks for the repack target transport request. 

 

• ToC into Customizing 

Repack Transports of Copies into target customizing transport (otherwise, they will be repacked into target 

workbench transport). 

 

• Add CSOL 

Add Cross System Object Lock for the target repack transport request 

 

4.5.5 Activating the Piece List 

Call transaction SCC1 in your working client and activate the piece list /SALM/CHARM_EXT, which will supply 

your system with the predefined customizing. The result of this activation can be verified in transaction SCC3. 

4.5.6 Configuration 

This section describes the customizing parameters in the table /SALM/REPACK_CUS. 

The parameters allow you to set default values for the Repack Options. 

 

Customizing table /SALM/REPACK_CUS contains the following parameters: 

 

• SET_CSOL 

Defines the default value for Add CSOL option. Set to 'X' if this option should be checked by default. 
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• SET_DIRLOCK 

Defines the default value for Add Directory Locks option. Set to 'X' if this option should be checked by default. 

 

• SET_ORIGINALITY 

Defines the default value for Change Originality option. Set to 'X' if this option should be checked by default. 

 

• SHOW_OPEN 

Defines the default value for Show Open Transports option. Set to 'X' if this option should be checked by 

default. 

                                                                                                                                                                                                                                                    

• SHOW_TOC 

Defines the default value for Show ToC option. Set to 'X' if this option should be checked by default. 

                                                                                                                                                                                                                                                              

• SHOW_TODAY_MINUS_DAYS  

Defines the default value for Start Date option. Enter a numeric value: Number of days subtracted from the 

current date. 

 

• TOC_TO_CUSTOMIZING 

Defines the default value for ToC into Customizing option. Set to 'X' if this option should be checked by 

default. 

 Configuration of Simple IT Request 

4.6.1 Overview 

The purpose of this document is to describe the functionality of Simple IT Request and its configuration. 

 

With Simple IT Request Business Users can consume any (Solution Manager based) IT Service via a single point of 

entry (Catalog Fiori Application) including an intuitive user interface for postprocessing of consumed services (My 

Requests Fiori Application). 
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The IT Organization can create and maintain the respective service catalog and its services via CRM UI in SAP 

Solution Manager. The service catalog is based on the multi-level categorization of CRM transactions and can be 

structured with respect to the business user perspective. The services are based on CRM transaction templates. 

They can be created and maintained using standard ITSM and ChaRM functions in SAP Solution Manager. 

The service consumption starts in the service catalog where predefined content of transaction templates is 

displayed as services. When a service is consumed, a defined transaction is created based on predefined data 

from the template and additional information submitted by the service consumer. For example, the service 

Missing Authorization is defined via an Incident template. The service consumer finds this service in the catalog, 

adds information about the authorization he is missing and submits the request. This generates an Incident 

transaction with predefined information such as the support team as well as additional information added by the 

service consumer. 

 

The processing of requests is handled just like any other transaction via CRM UI by assigned message processors, 

support teams and others. Communication in terms of queries to the requester (and vice versa) is done via the My 

Requests Fiori Application from requester perspective and CRM UI from request processor perspective. 
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4.6.2 Roles and Authorizations 

Depending on the role different user interfaces/applications are relevant for Simple IT Request: 

 

Service Requester 

The service requester can access the service catalog via a Fiori App. Furthermore, the requester can access his 

own services which he requested via the My Requests app. With the My Requests app, the requester can review 

the status of his request, answer to questions raised by the processor, edit/delete/create attachments and set 

user status via action buttons (withdraw, reject, confirm, etc.). Both apps are accessible via transaction 

SM_WORKCENTER. 

 

For Service Requesters, the following composite role is available: SAP_OST_SSR_REQUESTER_COMP 
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Service Manager 

The service manager maintains the service catalog and its hierarchy via CRM UI and a dedicated business role 

(/SALM/SM_PRO). Within this business role he can create, maintain or delete transaction templates (=services) 

such as Incident Template, Service Request Template, and others. Besides the basic definition of the service 

including its pre-defined data (such as involved parties, priority, and long text) he also defines the layout of the 

service form in the catalog application. Furthermore, he can maintain the categorization schema in order to define 

the structure of the services that appear in the catalog application. The service manager also has access to the 

service catalog via a Fiori App. Both UIs (catalog maintenance in CRM UI, service catalog application) are 

accessible via transaction SM_WORKCENTER. 

 

For Service Managers, the following composite role is available: SAP_OST_SSR_MANAGER_COMP 

 

4.6.3 Configuration 

Simple IT Request is delivered with predefined customizing, business roles and authorization roles which must be 

activated via piece list /SALM/SIMPLE_IT_REQ (refer to chapter Error! Reference source not found. Error! Re

ference source not found.). This predefined configuration allows direct usage of Simple IT Request without any 

further adjustments. 

However, it is recommended and in most cases, also necessary to adapt the standard configuration to the 

customer specific implementation of SAP Solution Manager. The following areas need to be considered when 

adapting the standard configuration: 
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Service Catalog Structure 

The service catalog structure is maintained by means of categorization schemas via CRM UI. This can be done 

with the authorizations of the service manager role and CRM business role /SALM/SM_PRO. In standard 

configuration, the standard categorization schema SAP_SM_TEMPLATE_V2 is used. If this schema does not 

reflect the structure of your set of services you can create a custom specific categorization schema. This schema 

then needs to be assigned to the transaction templates and transactions representing services and service 

requests used in Simple IT Request. 

You can also define 2 separate categorization schemas to reflect two different perspectives on your services: 1) to 

organize your services within the catalog and provide an intuitive navigation for business users. 2) to categorize 

requested services with IT internal attributes for, e.g., internal routing or reporting. Accordingly, you find two 

sections of multi-level categorizations in each template transaction (Incident Template, Problem Template, 

Service Request Template, Request for Change Template). 

 

Business Role 

The standard configuration delivers the CRM business role /SALM/SM_PRO for maintenance of services and 

catalog structure by the service manager role via CRM UI. If you would like to include functions of this business 

role into custom specific business roles you need to take into account the specific navigation bar profile 

/SALM/S1SOLMANPRO. In particular, this profile includes the work centers S1-CHANGE, S1-SUPPORT, and SRV-

OPERAT which are relevant for activities of the service manager mentioned above. For instance, the work center 

S1-SUPPORT includes the link groups S1-IM-CR, S1-IM-SR to create and search for Incident related 

transactions and templates. These groups contain links such as S1-IMT-CR to create Incident Templates. The 

latter refers to CRM UI component /SALM/INCIDENTM via Target ID S1TIMTCR. 

In addition, the UI configuration(s) also need to be adjusted in case other business roles are used. Therefore, you 

need to include the assignment block Simple IT Request Setup referring to CRM UI component 

/SALM/ITSMSSRFS into the configuration of the corresponding business role. 
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Transaction Templates and Transactions 

In standard configuration, the following transaction types and templates are defined and can be used out of the 

box: 

 

• S4IT: Incident Template 

• S4PT: Problem Template 

• S4ST: Service Request Template 

• S4CT: Request for Change Template 

 

Based on these template types, services can be created with the service manager role. These services then 

trigger the generation of a transaction of the defined type (see table /SALM/ITSM_SSRTM): 

 

• S4IT triggers SMIN 

• S4PT triggers SMPR 

• S4ST triggers SMRQ 

• S4CT triggers SMCR 

 

This mechanism follows the general approach of Simple IT Request as described above. If customers would like to 

integrate custom specific templates or transaction types, this can be done straightforward just like for the 

standard configuration mentioned above. Please see the chapter Customizing Options below where all relevant 

tables are highlighted which need to be maintained in this case. Adjustments to authorization roles, categorization 

schemas and CRM business roles including UI configurations also might be necessary in case new/other 

transaction types will be used for Simple IT Request. Further details can be found in this configuration guide in the 

referring chapters. 

Authorization Role 

Two composite authorization roles are delivered with Simple IT Request covering the activities of service 

requesters and service managers as described above.  

Service Requester 

SAP_OST_SSR_REQUESTER_COMP 

 

Including the following single roles: 

• SAP_OST_SSR_REQUESTER 

• SAP_SM_CRM_UIU_FRAMEWORK 
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• SAP_SM_CRM_UIU_SOLMANPRO_PROC 

• SAP_SOCM_REQUESTER 

• SAP_SUPPDESK_CREATE 

Service Manager 

SAP_OST_SSR_MANAGER_COMP 

 

Including the following single roles: 

• SAP_OST_SM_CRM_UIU_SM_PRO 

• SAP_OST_SSR_MANAGER 

• SAP_SM_CRM_UIU_FRAMEWORK 

• SAP_SM_CRM_UIU_SOLMANPRO_CHARM 

• SAP_SM_CRM_UIU_SOLMANPRO_CREA 

• SAP_SM_CRM_UIU_SOLMANPRO_PROC 

• SAP_SOCM_REQUESTER 

• SAP_SUPPDESK_CONFIG 

• SAP_SUPPDESK_CREATE 

 

It is recommended to copy these roles into customer namespace, adjust them in case necessary to customer 

specifics and generate the referring profiles. 

The adjustments to customer specifics typically cover the following authorization objects and use cases: 

Service Requester 

Role: SAP_OST_SSR_REQUESTER 

Object: /SALM/SSRG 

Use Case: restrict access to services by definition of authorization groups (customizing table 

/SALM/ITSM_SSRAG) which can be assigned on transaction template level by the service manager. 

 

Role: SAP_OST_SSR_REQUESTER 

Object: CRM_SSCCAT 

Use Case: restrict access to groups of services based on the categorization schema. 

 

Role: SAP_OST_SSR_REQUESTER 

Object: CRM_ORD_LP, CRM_ORD_PR 

Use Case: restrict access to transaction types of transaction templates and transactions. Especially when having 

custom specific transaction types such as ZMIN, ZMIT and others, these need to be added here. 

Service Manager 

Role: SAP_OST_SSR_MANAGER 

Object: /SALM/SSRG 

Use Case: restrict access to services by definition of authorization groups (customizing table 

/SALM/ITSM_SSRAG) which can be assigned on transaction template level by the service manager. 
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Role: SAP_OST_SSR_MANAGER 

 

Object: CRM_SSCCAT 

Use Case: restrict access to groups of services based on the categorization schema. 

 

Role: SAP_OST_SSR_MANAGER 

Object: CRM_ORD_LP, CRM_ORD_PR 

Use Case: restrict access to transaction types of transaction templates and transactions. Especially when having 

custom specific transaction types such as ZMIN, ZMIT and others, these need to be added here. 

4.6.4 Customizing Options 

This section describes the customizing options of Simple IT Request which can be defined in different customizing 

tables. Further details, standard customizing settings and configuration examples can be found in the 

corresponding documentation and customizing tables in your SAP Solution Manager system. 

 

Option Table Description 

Definition of Service 

Templates for Catalog 

Selection 

/SALM/ITSM_SSRSR Define the template transaction types that can 

be used to create catalog services 

Template Mapping to Simple 

IT Request Transaction Type 

/SALM/ITSM_SSRTM Define the mapping between template 

transaction type and transaction type which is 

created in case a service is consumed 

Copy Control for Transaction 

Types 

CRMV_PR_COPY_MA Define standard copy control between template 

transaction types and transaction types 

Customizing of General 

Settings 

/SALM/ITSM_SSRST Define the categorization type which is used to 

build the catalog hierarchy referring to a 

selected reference transaction template 

Definition of available Layout 

Fields for Simple IT Request 

Apps 

/SALM/ITSM_SSRLF Define the transaction fields that can be selected 

within the layout component during 

maintenance of a service (e.g., Description, 

Priority, Urgency, Contact Person, …) 

Define Activities for Simple IT 

Request 

/SALM/ITSM_SSRAC Define status activities which are visualized as 

buttons in the My Request App depending on the 

current user status of the transaction (e.g., 

“Withdraw” to set a transaction to status 

“Withdrawn”). 
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Option Table Description 

Definition of Partner 

Functions as Requestor by 

Trans. Type 

/SALM/ITSM_SSRRQ Define the partner function “requester” which 

will be used during consumption of a service in 

order to set the consumer as requester. 

Customizing of 

Communication in My 

Requests App 

/SALM/ITSM_SSRCO Define text type and status (optional) which is 

set when end users communicate with the IT 

organization using the My Request App 

Visible Tabs in My Requests 

App by Trans. Type 

/SALM/ITSM_SSRRT Define the tabs which are displayed in the My 

Request App (e.g., Request, Conversation, 

Attachments, …) 

Customizing of Authorization 

Groups 

/SALM/ITSM_SSRAG Define authorization groups that can be used to 

restrict access to services on transaction 

template level 

 Configuration of dropDoc 

dropDoc helps as a part of Solution Documentation to manage numerous file types, which simplifies the default 

usability of file management inside Solution Documentation. dropDoc can be integrated as a part of work 

package (WP), work item (WI), and business requirement (BR) applications. In addition, dropDoc can be 

implemented directly, as a standalone option in the Solution Documentation scenario.  

An extract of dropDoc features are: 

• insert files using drag and drop 

• mass maintenance of documents and documents type 

• change the document status  

• delete one or more documents at the same time 

• optimized for different screen resolutions  

 

Moreover, the dropDoc is partial web application. The frontend functionality of dropDoc is based on a browser UI 

technology SAPUI5. We strongly recommend that you always use the latest browser versions for Google Chrome, 

Firefox, Safari, and especially Internet Explorer. 

In addition to the standard behavior, the dropDoc allows more detailed configuration, you can define the 

documentation store type and the expected document types in different surroundings. 

4.7.1 Prerequisites 

Created a solution and assigned document types. 
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4.7.2 Overview of dropDoc Variants 

dropDoc is a well-rounded application and it can be used in different variants. 

 

 

 

 

 

 

 

 

 

 

 

 

 

There are three variants of dropDoc:  

• First, the attachments variant is used to upload and manage attachments for a solution. It is displayed as 

Attachments Tab as a part of WP or WI. For this dropDoc variant, the Allowed document types for Attachments 

table has to be customized. (For more information, see chapter Document Types of Attachments.) 

 

• Second, integration variant is the main dropDoc application for Solution Documentation for the managing of 

documentation. It is displayed as Documentation Tab in WP or WI. In the BR application, this variant is 

integrated in an attachment panel of a requirement. In addition, it is easily accessible via context menu. For 

this dropDoc variant, customize the general Document types for solution. These are the documents for which 

the digital signature should be applied and the characteristics of the digital signature in general and the KPI 

properties must be defined. (For more information, see chapters 3.3 KPI Customization for Work Package 

and Work Item, 3.4 Overview of digital signature.) 

 

• Third, the standalone variant is displayed in a pop-up window directly in Solution Documentation column 

browser. For this dropDoc variant, define the Document types for solution only.  

 Note 

All dropDoc variants could be used for the same solution or separately. 

4.7.3 Activation of BSP Services 

Run transaction SICF, select the execute icon (or F8 ), and follow the path: 

/default_host/sap/bc/bsp/salm/drop_doc. As shown in the screenshot below, activate the service 

DropDocs ui5 component for WP integration/SMUD. 

UI VIEW 

Attachments Tab 

Documentation 
Tab 

Pop-Up Window 

VARIANTS USAGE 

WP/ WI 

SolDoc 

WP/ WI/ BR 

CUSTOMIZING 

dropDoc  

Integration 

dropDoc  

Attachments 

dropDoc  

Standalone 

Document Types for 
Attachments  

Document Types for  

Solution 

Digital Signature 

KPI 
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4.7.4 Activation of ICF Services 

BSP Services 

Run transaction SICF, select the execute icon (or F8 ), and follow the path: 

/sap/opu/odata/salm/drop_doc_srv. Activate service DROP_DOC_SRV. 

 

Activation of OData Services 

Run transaction SICF, select the execute icon (or F8 ), and follow the path: 

/sap/opu/odata/salm/drop_doc_srv. Activate service DROP_DOC_SRV. 

 

Definition of a system alias for OData service 

Run transaction /IWFND/MAINT_SERVICE, select OData service /SALM/DROP_DOC_SRV, and add a system alias 

as described in chapter 1. 



 

156 

CUSTOMER  

© 2018 SAP SE or an SAP affiliate company. All rights reserved. 

Focused Build for SAP Solution Manager 

Configuration of Standalone Extensions 

 

 

4.7.5 Document Types of Attachments 

The only types of documents that are allowed as attachments for the solution are defined in the table Allowed 

document types for Attachments. This table is accessible by running transaction SM30 and then using transaction 

/SALM/ALLWD_DOCT. The table displays a list of allowed document types of attachments for each solution ID. 

 

The table is divided into three columns: 

• The first column, Trans.Type, stands for transition type. These values determine the usage of document 

types. There is the possibility to define different document types for different usage areas, separated for the 

WP, WI, or BR. 

• The second column, Solution ID, displays required identification values for selecting a specific solution. 

• The third column, Doc.Type, displays values for the documentation types. 

 

 Note 

As an example, if five document types have to be defined for the solution, then each document type has to 

be maintained individually in the table. 

 

 Recommendation 

To attach documents without any specific document type, use the wildcard (*) for all the three 

parameters in the table. 
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Configuration of Document Types for Attachments 

 To navigate to the customizing table for document types, run transaction SM30.  

 In the Table/View field, use transaction /SALM/ALLWD_DOCT, and choose Maintain. 

 Here you can select a customized document type from the list. Select the value help icon to the right of the 

list for a short description of each document type.  

 Choose New Entries. Define one or several of the allowed document types. 

 Define the Solution ID, choose transaction type and document type.  

 Save the parameter and confirm the prompt for workbench request or create a new one with the create 

request option. 

 Note 

Use following transaction types: 

o S1IT for WP  

o S1CG for WI  

o S1BR for BR 

 

 Recommendation 

If you want to upload documents without any specific document type, just type in the documents 

type table the wildcard (*) for all the three parameters (Solution ID, Transaction and Doc.Type). 

 

Now the defined document types for attachments will be available in the selected solution. You see 

the document types in the pop-up window in the dropdown menu of document type’s field. The pop-

up window is opening by creation of attachment. 

4.7.6 KPI Customization for Work Package and Work Item 

 To navigate to the customizing table for KPI, run transaction SM34.  

 In the input field for a Table/View, use transaction /SALM/VC_KPI and choose Maintain. 

 Choose New Entries, define your new KPI (description is optional), and save the settings. Select the Relevant 

option, because only relevant KPIs are considered. 
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 Select your newly-created KPI and choose Define relevant transaction in the tree structure on the left side. 

Select the type of your relevant KPI documents: work package or work item. 

 

 Note 

Following two transaction options are available: 

o S1IT for WP 

o S1CG for WI 

 Select your KPI, choose Define Classification Mapping, and define the mapping. In first column, select the 

classification type of WP or WI, then Sub Classification in the third column.  

If no sub classification is selected, default settings for empty sub classification take effect. Default settings 

must be defined beforehand. 

In the last column, determine the document types for which the KPI should apply. Save your parameters. 

Select the mapping and navigate to Define transaction status and document status.   

Now you can see your created KPI for your document type under the documentation tab for the WP or WI 

application in the Current Status area. 
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 Define the status of WP/WI in first column UsrSt. Afterwards select Solution Manager Document Status, the 

status of your document type that you defined in step 5. Then specify the KPI behavior in relation to 

document status in the last column KPI. The KPI can have four different states: red, yellow, green, and not 

applicable. 

 Recommendation 

You can see these parameters in WP/WI applications on the first Details tab. 

 

4.7.7 Overview of Digital Signature 

Digital signature can be defined for one or more specific document types. Digital signature includes a relationship 

of several parameters of a document. It is defined to control the status change of a document. One or more users 

with certain roles must digitally sign a document. dropDoc offers two digital signature modes. The single 

signature and the double signature mode.  In a double signature mode, two different user roles must confirm the 

document status change.  

Example: When changing the status of the document type configuration guide from in preview to released, the 

user with the developer role signs the document and confirms the change. 

Double signature settings can specify that the status change has to be confirmed by two different roles, and this 
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can include, for example, a single user with both the developer role and manager role. Only when both roles have 

signed, can the document complete its change to its new status. 

 

The definition of a signature can be divided into three large work blocks: 

 Defining a digital signature including authorization groups 

 Defining a status schema 

 Assigning a status schema to document type 

Configuration of Digital Signature Settings 

Run transaction solman_setup. Navigate to Process Management in the scenarios field on the left side. Select 

the step 3. Configure Digital Signature. In the Steps area, choose Define Signatures and Authorization Groups.  

OR 

Run transaction spro, choose SAP Reference IMG, and navigate to the path:  

SAP Solution Manager ->Technical Settings -> Digital Signature -> Signature Strategy 

 

• Definine the digital signature: 

 

• Define authorization groups 
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Enter the authorization groups you want to generate. Those groups represent different departments that need to 

sign a document in order to release it. 

• Define individual signatures 

 

The individual signatures represent the roles you define in the authorization groups. 

• Define signature strategies 

 

Those entries describe how a document is signed. Set the method to System signature with Authorization by SAP 

User ID/Password. This means that the signature will be based on the currently logged-in user, who has to enter 

his or her password to proceed. 

1. Select the newly-created signature strategy and choose Assign individual signatures. Enter every 

individual signature that is needed for the scenario. 

2. Go back to the strategy overview and select your strategy. Choose 123 Signatures on the right side of the 

table. Check the predecessors accordingly to your signing scenario. Save your changes.  

Note 

Note, that the signature sequence controls the order in which a document needs to be signed by the 

different authorization groups. 

3. Go back to the strategy overview and select your strategy. Choose Release on the right side of the table. 

Check the release states accordingly to your signing scenario. Save your definitions. 

In this context, release means that the signing procedure is finished and the document is locked. The 

right side displays every combination of individual signatures that can be made. This also takes the 

Signature Sequence into account. 
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By following the above steps, you define a signing strategy as abstraction of your business use case. 

 

The next step is to assign this to a status schema, which is used for a certain documentation type.  

 Run the transaction solman_setup.  Choose Process Management from the navigation area on the left. 

Navigate to 4. Customize Document Handling. Choose the step 4.4 Define Values for Document and execute. 

Choose the second step Define Document Status Schema. 

 

 

 Enter the value for the signature strategy you want to use, and select the Locked checkbox. 
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 Enter values for the end status and the cancellation status. 

 Fill in the highest sequences, so that the last status can only be reached from the last but one status. 

 Save the changes.  

 

Finally, you must create a new document type for your solution, or just select one of the existing document 

types and assign to this document your status schema. 

 Run transaction slan.  Select the solution and navigate to Document Types. 

 

 Click on the menu icon in the upper right corner. 

 Choose Document Type Administration from the drop-down menu. Here, you can select or create a document 

type. 

 Select the document type and choose Edit. Navigate to Properties and select your status schema.  
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 End the specification by choosing the toggle edit mode icon. 

 

 Configuration of Multitenancy Enhancement 

Use Case Description 

The multitenancy function is an enhancement, that allows customers to fully control all data that is used for 

CHARM and ITSM, to be separated by respective authorization objects. 

Some of these authorization objects are already available in SAP Standard and only reused in this configuration 

guide or added at respective spots where data was not correctly handled. 

There are 2 different options available as splitting criteria: 

• Configuration item (system-specific) 

• Business partner (customer-specific) 

The different data available for a normal end-user: 

• Transaction Data (Tickets from CHARM and ITSM) 

• Business Partner (BP) 

• Configuration Items (CI) 

• Change Cycles (CHARM Only) 

• Process Management Data 

All applications within the WebUI for CHARM and ITSM are applicable to splitting criteria. For example, without 

authorizations it is not possible to see data objects in their respective search queries. 
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4.8.1 Activating the Piece List 

Run transaction SCC1 in your working client and use the piece list /SALM/CHARM_EXT, which will supply your 

system with the predefined customizing. The result of this activation can be verified in transaction SCC3. 

4.8.2 Status Check for Transaction Types 

The status check for transaction types adds an additional authorization check. It provides status-specific control 

regarding read and write access to a ticket.  

The system checks whether a user has the needed authorization when the user performs an action such as: 

• Open/display a document 

• Change into edit mode 

• Set next status 

It will be checked, whether the type of the current document belongs to the configured types. In this case, it will be 

checked the user is authorized display or edit the ticket in the current status. 

This chapter describes the necessary configuration you need to do to use the business partner dependent check. 

They can be combined with Business Partner Dependent Checks and Configuration Item Dependent Checks. You 

also need to perform the steps described in chapter Activation. 

Specify Transaction Types 

It is possible to activate the status check only for specified transaction types. Each transaction type, where this 

additional check should be applied, has to be added to a configuration table. 

1. Run transaction SPRO and open SAP Reference IMG.  

2. Go to SAP Solution Manager Implementation Guide → SAP Solution Manager →Focused Build → Change 

Control Management Extensions → Multi Tenancy Extensions.  

3. Start Define Multi Tenancy Settings.  

4. Select node Statuscheck in Transaction Types.  

5. Add all transaction types to be checked. 

 

6. Save. 
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Necessary Adaption to Roles 

Authorization Object /SALM/MTST 

The authorization object /SALM/MTST must be added to all process roles used to control access to tickets in 

WebUI. Otherwise, none of tickets of the added transaction types can be accessed. Depending on their tasks in 

the process, the values for the authorization fields has to be set. 

The authorization object /SALM/MTST has 3 fields: 

• STSMA: Status profile of the transaction type to be checked 

• ESTAT: User status which can be displayed or created 

• ACTVT: Permitted activities are create and display 

The object consists of the fields Activity, Status Profile, and User Status. 

• Activity 

Here you define which activities are permitted. Possible values: 

 02 = Change 

 03 = Display 

 *    = All activities 

• Status Profile  

Here you define the status profiles of the checked transaction types. 

• User Status  

Here you define the user status values where the user will get authorization to display or edit. 

 

 Caution 

The values for field User Status may be not unique for different transaction types and their status profiles. 

Therefore, it might be necessary to add different entries of this authorization object for each transaction 

type. 

Changes to Roles 

This new object must be added to the authorization roles of each process role, such as requester, developer, and 

change manager. Depending on their tasks in the process the values for the authorization fields has to be set. 

 Run transaction PFCG and open your authorization role in edit mode. 

 Choose Change Authorization Data on tab Authorization 

 Add new entries for authorization object /SALM/MTST (or edit existing ones) 

 Save your changes and generate the profile. 

 

 Example 

The following screenshot shows authorizations for transaction type ZMAD.  

The first entry is for granting display access to the specified status of status profile ZMADHEAD. The 

second one adds edit authorization. 
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 Caution 

For each status that the user has edit authorization, we recommend you also assign the display 

authorization. 

 Caution 

If the user can set the next status of a ticket, we recommend you assign display authorization for the 

target authorization too. 

4.8.3 Business Partner Dependent Checks 

Business partner dependent checks help to control access to: 

• Business partners in search help 

• CRM transactions via assigned sold-to party 

The authorization object for the business partner authorization group, B_BUPA_GRP, is used for these checks. 

The results of the checks display only those business partners within a group to which the user has authorization. 

To access a ticket, the user needs to have the authorization for the sold-to party’s authorization group. The user 

doesn’t need to be assigned to the same organization.  

This chapter describes the necessary configurations to use the business partner dependent check. They can be 

combined with status check for transaction types and configuration item dependent checks. You also need to 

perform the steps described in chapter 3.8.12, Activation. 

Organizational Structures 

To maintain the master data, also maintain an organizational model in the SAP Solution Manager with one of the 

two structures.  

 

Simple Relationship Model: 

 

Tenancy 1

Member 1 Member 2

Tenancy 2

Member 3 Member 4
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Team-based Relationship Model: 

Create Root Organizations and their Structures 

Create your organizational model first. One root organization is needed for each tenant. 

Start CRM WebUI, use a business role with access to Master Data / Organization Model (for example, 

/SALM/SM_PRO or  SOLMANPRO). 

 

 Choose Create Root Organizational Unit / Open your root organization (if it exists already). 

 Create Organizational Units and Positions within your root organization according your needs. You will need 

at least one position to assign all employees. 

Assign Employees 

All employees working for one tenant have to be assigned to a root organization responsible for one of their 

organizational units. This assignment is then used to assign the business partner authorization group 

automatically by report. As each business partner has only one authorization group assigned to it, the business 

Tenancy 1

Team 1

Member 1

Member 2

Team 2

Member 3

Member 4

Tenancy 2

Team 3

Member 5

Member 6

Team 4

Member 7

Member 8
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partner should be assigned to more than one root organization. Otherwise, the report will take only one 

assignment into consideration and log an error. 

Users need to have the authorization to access the corresponding business partner groups. This can be added 

independent from the current organizational assignment. 

 Start CRM WebUI, use a business role with access to Master Data / Organization Model (for example, 

/SALM/SM_PRO or SOLMANPRO). 

 Open your root organization. 

 Navigation to the position, where the employee should be assigned. 

 Choose Add Employee. 

 

 Search for the business partner to be assigned.  

 Select the business partner in the search result list. 

 Repeat for all needed assignments. 

 Save. 

 

Alternatively, it is possible to assign the business partner in the SAP GUI transaction PPOMA_PRM.  

 Navigate to the position, choose Assign and select Owner. 

 

 

 Search for the business partner to be assigned.  

 Select the business partner in the search result list. It is possible to select more than one business partners. 

 Save. 

4.8.4 Add Role Sold-To Party to Business Partner 

To control the access to the tickets, each ticket should have the root organization entered as Sold-To Party. This is 

only possible, if the corresponding business partner has the role Sold-To Party.  

 Start CRM WebUI, use a business role with access to Master Data / Organization Model (such as 

/SALM/SM_PRO or SOLMANPRO). 

 Open the business partner your root organization. 

 Go to assignment block Roles, select the edit list and add new entry for Sold-To Party. 
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 Save. 

 

Alternatively, run transaction BP in SAP GUI, open the business partner and add the BP role. 

  

4.8.5 Business Partner Authorization Groups 

You can use authorization groups to stipulate which business partners a user is allowed to process. 

The system only checks this authorization if you made an entry in the authorization group field for the business 

partner. Otherwise, any user may process the business partner. 

Create Authorization Groups 

Create the authorization groups for business partner first: 

 Run transaction SPRO, open SAP Reference IMG 

 Navigate to SAP Customizing Implementation Guide → Cross Application Components → SAP Business 

Partner → Basic Settings → Authorization Management 

 Choose Maintain Authorization Groups 
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Create one authorization group for each tenant and one, which can be used for all business partners, who are not 

assigned (known as the default authorization group). 

Customize Default Authorization Group 

The default authorization group will be assigned to the business partners. Please note that the business partners 

are not part of a root organization defined in customizing. This is a precondition to execute the report to assign 

the authorization groups to all business partners automatically. 

 Run transaction SPRO, open SAP Reference IMG 

 Navigate to SAP Solution Manager → Focused Build → Change Control Extensions → Multi Tenancy 

Extensions 

 Choose Define Multi Tenancy Settings 

 Choose General Parameters 

 Select or create an entry for parameter DEFAULT_BP_AUTHGRP. Please note that only one entry is applicable. 

 Enter your default authorization group as parameter value. 

 Save. 

Assign Authorization Groups to Root Organizations 

You need to define your root organization and assign them an authorization groups. This is a precondition to 

execute the report to assign the authorization groups to all business partners automatically. 

 Run transaction SPRO, open SAP Reference IMG 

 Navigate to SAP Solution Manager → Focused Build → Change Control Extensions → Multi Tenancy 

Extensions 

 Start Define Multi Tenancy Settings 

 Select Organizations and Authorizations 

 For each root organization create a new entry, select the corresponding business partner. You may enter a 

description.  

 Assign the corresponding business partner authorization group. 

 Save. 

4.8.6 Assign Authorization Groups to Business Partners 

Business partners without an authorization group can be accessed by all users with display authorization. 

Therefore, we recommend you assign business partners in your system to an authorization group according to 

their root organization (tenancy). This recommendation also applies to unassigned business partners with 

restricted visibility (see Assignment by Report section below for more information). 

Manual Assignment 

The authorization group can be assigned manually for each business partner: 

 Run the transaction BP. 

 Select the business partner to be changed. 

 Go to the Control tab. 

 Enter value for field Authorization group. 
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 Save. 

Assignment by Report 

The system can process a multitude of business partners, and as such, a maintenance report automatically 

assigns authorization groups based on a customizing table where each tenancy is assigned to a specific 

authorization group. The report assigns a default authorization group to every business partner not otherwise 

assigned to a tenancy. This prevents unwanted visibility of unassigned business partners. 

 Caution 

The user who runs this report may require additional authorizations. The Necessary Authorizations 

chapter contains a detailed list. 

 

 Run transaction SPRO, open SAP Reference IMG. 

 Navigate to SAP Solution Manager → Focused Build → Change Control Extensions → Multi Tenancy 

Extensions. 

 Start Update Business Partner Authorization Groups. 

 Execute the report with the prefilled values first. 

 Testmode activated (no changes will be saved) 

 Assign authorization groups (authorization group will be updated by analyzing the organizational 

assignment of existing business partners) 

 Only assigned business partners deactivated (Unassigned business partners will get the configured 

default authorization group 

 Root organizations (taken from customizing, see chapter 3.8.5 Assign Authorization Groups to Root 

Organizations) 

 Business partner (prefilled with * to check all business partners) 

 

 Check execution log. All needed changes regarding the assigned authorization groups are listed. 

 Repeat execution with deactivated test mode to make permanent changes to business partners. 

Schedule assignment report as background job 

Keeping the assigned authorization groups up-to-date is important to control the access to business partners and 

business partner dependent data. Therefore, it's recommended to schedule a background job which updates the 

assignments on a regular basis. 
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Create a variant for report execution 

 Open report via transaction SPRO (SAP Solution Manager → Focused Build → Change Control Extensions → 

Multi Tenancy Extensions → Update Business Partner Authorization Groups) or transaction SE38 (Report 

Name: /SALM/ITSM_MT_BP_AUTH_GRP) 

 Deactivate Testmode. 

 Save Variant. 

 Enter name and description for variant 

 Within Objects for selection screen table, change the Save field without values  field for entry SO_ROOT to 

ensure that all root organization from customizing are taken into account  

 

 

 

 Save. 

Schedule Background Job 

 Run transaction SM37. 

 Enter job name. 

 Create step. 

 ABAP program name: /SALM/ITSM_MT_BP_AUTH_GRP 

 Select your variant 

 Define Start Condition. 

 Choose Date/Time 

 Enter Start Date and Time (if possible, outside business hours) 

 Activate Periodic Job. 

 Choose Period Values and select a period 

 Save. 

 Save job definition to release the job. 

Check the result of the last job run in transaction SM37 by opening the spool list. 
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4.8.7 Partner Function to Be Checked 

Normally the partner function Sold-To Party is used to check the accessibility of a ticket. The checked partner 

function can be changed in customizing. This configuration is valid for all transaction types. 

 Run transaction SPRO, and open SAP Reference IMG. 

 Navigate to SAP Solution Manager → Focused Build → Change Control Extensions → Multi Tenancy 

Extensions. 

 Start Define Multi Tenancy Settings. 

 Select General Parameters. 

 Select or create an entry for parameter SOLD_TO_PARTNER. There must be only one entry. 

 Add the technical key for the used partner function as parameter value.  

 

If there is no entry for SOLD_TO_PARTNER, or if the parameter value is empty, the default value 00000001 

(meaning Sold-To Party) is used. 

 Caution 

If the partner function does not exist or has no value for the current ticket, the user can still access the 

ticket, but it won’t be found by any search. Therefore, you need make sure that the business partner of 

the root organization is added to each transaction. 

All used transactions types of ITSM, ChaRM and Requirements Management should have this partner 

function available within their partner profile and it is defined as mandatory. 

Adapt Partner Profiles 

To access the partner profiles customizing, use transaction SOLMAN_SETUP: Change Request Management. Go to 

Step 3.6 Setup Business Partner and select Define Partner Determination Procedure. 
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Alternatively, you could use the corresponding transaction SPRO activity.  

 

 Select your transaction type(s).  

 Choose Partner Functions in Procedure.  

 Add the partner function, if necessary. 

 Set Minimum value to 1. 
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 Repeat for all used transaction types. 

 Save your changes. 

4.8.8 Necessary Adaption to Roles 

Authorization Object B_BUPA_GRP 

With the authorization object B_BUPA_GRP, define which business partners can 

be edited based on the authorization group. 

 

The object consists of the fields Activity and Authorization group. 

• Activity 

Here you define which activities are permitted. 

Possible values: 

   01 = Create 

   02 = Change 

   03 = Display 

   06 = Delete 

   *  = All activities 

• Authorization group 

Here you define the groups of business partners for which the above activities are permitted. 

Changes to Roles 

The object B_BUPA_GRP must be added to your authorization roles.  

The concrete values for this authorization object are based on the assignment of the business partner of a user to 

one of the organizations/tenant and not to the business partner's process role. It is recommended to manage this 

authorization in separate roles per tenant. If necessary, further tenant-dependent objects can be added to these 

roles. 

In this document, only the display permission is taken into consideration since it is assumed that only this is 

needed within ChaRM and ITSM. 

 Run transaction PFCG and open your authorization role in edit mode. 

 Choose Change Authorization Data on the Authorization tab.  

  Add new entries for authorization object B_BUPA_GRP (or edit existing ones) 

 Activity: 03 (= Display) 

 Authorization Group (refer to 3.6.5 Create Authorization Groups) 

 Save your changes and generate the profile. 



 

Focused Build for SAP Solution Manager 

Configuration of Standalone Extensions 

 CUSTOMER  

© 2018 SAP SE or an SAP affiliate company. All rights reserved.  177 

 

In general, a user should have the authorization for the authorization group he or she is assigned to. This is the 

only possibility to access all BP that are assigned to the same organization. 

In exceptional cases, a user must access the BP of different organizations. This may apply, for example, for 

administrators and support staff. In this case, all corresponding (organization) authorization roles should be 

assigned to the user. 

4.8.9 Configuration Item Dependent Checks 

Configuration item dependent checks help to control access to:  

• Systems in search help  

• CRM transactions via assigned systems 

The authorization object SM_SDK_IBA used for these checks.  

4.8.10 Configuration for Business Partner Dependent Check 

This chapter describes the necessary configuration to use the business partner dependent check. They can be 

combined with Error! Reference source not found. and Business Partner Dependent Checks. You also need to p

erform the steps described in chapter 3.8.12 Activation. 

Organizational Structures 

For using this function, it is required to have an organizational structure with employees assigned. If this has 

already been done as described in chapter 3.8.1 Organizational Structures, it can be reused here. 

 

 Caution 

The organizational units are later assigned to the systems. Each unit with assigned employees must also 

be assigned to the system. Higher-level units are not considered. 

This makes it possible to differentiate the accessible systems within one root organization. However, 

there might be a higher effort, because several units have to be assigned to the same systems. 

Assign Business Partners to LMDB Objects 

Each organizational unit that has employees assigned to it, must also have employees assigned access to the 

respective systems. 

 Start CRM WebUI, use a business role with access to Master Data / LMDB Objects ( /SALM/SM_PRO or 

SOLMANPRO). 

 Search for the system the business partner(s) should be assigned to. 

 Open system. 

 Go to assignment block Parties involved.  

 Choose Edit List if you want to add a business partner. 

 Press Insert 

 Select the business partner  
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 Set Partner Function to Service Employees Group 

 Repeat for all business partners. 

 Save LMDB Object. 

Adaptions to Roles 

Authorization Object SM_SDK_IBA 

This authorization object SM_SDK_IBA is being used to restrict the IBase components that are being shown to the 

user. 

 

The object only has the field Restrict visibility for IBase components.  

Possible values: 

 ALL  all IBase Components 

 USERS_ORG IBase Components that the BP's organizations are assigned to 

 USERS_OWN IBase Components that the BP itself is assigned to 

Changes to Roles 

The object SM_SDK_IBA has to be contained in your authorization roles.  

The concrete values for this authorization object are based on the assignment of an organizational unit to a 

system and not to his process role. It is recommended to manage this authorization in separate roles per tenant. If 

necessary, further tenant-dependent objects can be added to these roles. 

 Run transaction PFCG and open your authorization role in edit mode. 

 Press Change Authorization Data on tab Authorization. 

 Add new entries for authorization object SM_SDK_IBA (or edit existing ones). 

 Restrict visibility for IBase components USERS_ORG,USERS_OWN. 

 Save your changes and generate the profile. 

 

In general, a user should have the authorization for the systems their organizational unit is assigned to. 

In exceptional cases, a user must access systems of different organizations. Here are two applicable options 

available for administrators and support staff, for example. There are two option for that:  

• Assign authorization object SM_SDK_IBA with full authorization (Restrict visibility for IBase components = 

ALL or *) 

• Assign the organizational units of these employees to each system they should have access. 

4.8.11 Restricting Access to Solutions and Documentation 

It is possible to restrict the access to solutions and their documents. Even the change cycles belonging to a 

solution/branch can be restricted. For example, a user can be restricted to assign documentations that belong to 

the user's organization only.   

Access the application security guide for your specific SP level in SAP Solution manager 7.2: The security guides 

can be found when you expand the Operation column header, chapter Process Management, and Test Suite / 

https://websmp105.sap-ag.de/~form/handler?_APP=00200682500000002672&_EVENT=DISPLAY&_SCENARIO=&_HIER_KEY=501100035870000015092&_HIER_KEY=601100035870000179416&_HIER_KEY=601100035870000179443&_HIER_KEY=701200252311000003762&
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Scenario Specific Guide: Process Management. Also, navigate to the section for Main Authorization Objects > 

Solution Documentation SM_DOC 

Also, see SAP note 2440107 - How to determine Authorization objects for Element Types, Group Type and 

Attribute Type for Solution Documentation 

This document concentrates on the authorization objects needed for ChaRM and ITSM: 

• To add documentation to tickets 

• To select change cycles in ChaRM transactions 

To do so, no activation is necessary, but an adaption of your authorization roles. 

Adaption to Roles 

Authorization Object SM_SDOC 

This object controls the solution documentation maintenance. 

Defined fields 

• SLAN restricts authorization by solution. 

• SBRA restricts authorization by branch. 

• SMUDAREA restricts authorization by sections of a solution, by specifying authorization areas within a 

solution and assigning them to structure elements. Authorization areas are maintained with view cluster 

SMUD_AUTHG, in transaction SM34. A structure element can be assigned to only one authorization area. Child 

elements inherit the area of their parent, if they do not have their own authorization area. Elements that have 

no parent assigned to an authorization area, have the virtual authorization area DEFAULT. 

• SMUDAUTHGR restricts authorization to groups of specified element types or attribute types. Authorization 

groups are maintained with view cluster SMUD_AUTHG, in transaction SM34. The virtual authorization group 

DEFAULT contains all combinations of objects and attributes that are not in a user-defined authorization 

group. 

• ACTVT allows restricting authorizations to certain user activities like create, change, display, delete, activate, 

release, move, discard, override and copy. Display is only checked for elements, not for attributes. If a user is 

allowed to see an object, all of its attributes are visible to him. For operations on structure elements some 

activities are only checked for the top element as the following table shows. There you also can see that some 

complex operations that a source and a target elements trigger multiple elementary authorization that all 

have to be passed successfully to finish the operation. 

 Display elements 03 Display   All elements  

 Create elements 01 Create   All elements  

 Delete elements 06 Delete   Elements and Sub-elements  

 Change attributes 02 Change   All attributes  

 Sort elements 02 Change   Parent element  

 Release changes 43 Release for current branch 07 Activate, generate for parent branch Selected and 

dependent elements  

 Discard changes 69 Discard   Selected and dependent elements  

 Mark conflict as resolved   94 Override Selected and dependent elements  

 Move elements 50 Move  01 Create Only moved elements and target parent  

 Copy elements D1 Copy  01 Create Only copied elements and target parent  

 Merge elements 06 Delete for parent  02 Change for attributes of target element  

  50 Move direct child elements  

https://i7p.wdf.sap.corp/sap/support/notes/2440107
https://i7p.wdf.sap.corp/sap/support/notes/2440107
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 Change target 02 Change   Only reassigned element  

Forbidden actions are hidden in the context menu. For some actions such as delete or reference to executable 

library the context menu does only a dirty pre-check because a full check would too long or is not possible, since 

the context menu entry does not fully define the complete action . Then it can happen that an action is visible and 

the user gets an error when executing the action. 

Authorization Object SM_CM_FUNC 

Authorization to perform various Quality Gate Management (QGM) and change request management functions. 

Defined fields 

• SUB_LAND - Name of the sub-landscape 

• BRANCH_NM - Name of the branch 

• CYCLE_TYPE - Type of change cycle 

 R - Major release 

 M - Minor release 

 E - Emergency release 

 O - Maintenance cycle 

 I - Implementation cycle 

 Q - Quality Gate Management 

• CM_ACTVT - Specific functions to be controlled. 

 CHCH - Modify change in QGM 

 CHCR - Create change in QGM 

 CHDE - Delete change in QGM 

 CHFI - Complete change in QGM 

 CHRA - Reassign change in QGM 

 CHWD - Withdraw change in QGM 

 CTPR - Assign to Change Request Management cycle 

 CYDP - Display QGM cycle 

 CYED - Edit QGM cycle 

 QBAP - Approve quality gate as Quality Advisory Board member in QGM 

 QMAP - Approve quality gate as Quality Manager in QGM 

 SCDP - Display QGM scenario 

 SCED - Edit QGM scenario 

 SSDP - Display CTS status switch 

 SSED - Edit CTS status switch 

 TACR - Create transport task in QGM 

 TLCF - Complete task list 

 TLCR - Create task list 

 TRAP - Approve/withdraw critical object 

 TRAS - Assign transport request in QGM 

 TRCH - Modify transport request in QGM 

 TRCR - Create transport request in QGM 
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 TRDC - Decouple transport request in QGM 

 TRDE - Delete transport request in QGM 

 TRIM - Set/reset import lock in QGM 

 TRRA - Reassign transport request in QGM (obsolete) 

 TRRL - Release transport request in QGM 

 TRTT - Create transport of copies in QGM 

 UCAA - Approve urgent change as Quality Advisory Board member in QGM 

 UCMA - Approve urgent change as Quality Manager in QGM 

Changes to Roles 

The objects SM_SDOC and SM_CM_FUNC must be added to your authorization roles. The concrete values for this 

authorization objects are based on your existing solution documentation and their structure. 

Use SM_SDOC to restrict access to solution documentation.  

SM_CM_FUNC is used for filtering possible change cycles. Enter CTPR (Assign to Change Request Management 

cycle) in field CM_ACTVT.  

But you could only see cycles assigned to branches, where you have the authorization to display the 

documentation (SM_SDOC). You also need the display authorization for all higher-level entries. 

4.8.12 Activation 

To use the described checks, they need to be activated. Therefore, you need to implement two BAdIs, which hold 

the implementation of the checks. Additionally, the checks need to be switched on in customizing. 

Activate BAdI for Authorization Check: CRM Business Transaction 

The business add-in CRM_ORDER_AUTH_CHECK is used to enhance the authorization check in the business 

transactions. The implementation /SALM/ITSM_MT_AUTHCK provides additional checks on current status values, 

selected business partners and refenced systems. 

To use these checks, the implementation needs to be activated first.  

 Run transaction SPRO, open SAP Reference IMG. 

 Navigate to SAP Solution Manager → Focused Build → Change Control Extensions → Multi Tenancy 

Extensions. 

 Start Activate BAdI for Authorization Check: CRM Business Transaction. 

 A list of all existing implementations of Business Add-in CRM_ORDER_AUTH_CHECK is displayed. Only one of 

the displayed implementations must be active. The active implementation is highlighted. In general, this is 

AI_SDK_EXT_AUTH_CHK, Extended Authorization Check, or your own implementation.  

 select the active implementation 

 Choose Activate/Deactivate 

 Please activate /SALM/ITSM_MT_AUTHCK.  

 Select the row for this implementation 

 Choose Activate/Deactivate 
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 Close window. 

 

If you have your own implementation deactivated by the previous steps, but you still need the contained 

authorization check, you can integrate your implementation via customizing.  

 Run transaction SPRO, open SAP Reference IMG. 

 Navigate to SAP Solution Manager → Focused Build → Change Control Extensions → Multi Tenancy 

Extensions. 

 Start Define Multi Tenancy Settings. 

 Select General Parameters. 

 Select or create an entry for parameter DEFAULT_AUTH_CHECK_BADI. There must be only one entry. 

 Enter the implementing class of the BAdI as value.  

For example: To call the implementation of AI_SDK_EXT_AUTH_CHK, you would need to add 

CL_IM_AI_SDK_EXT_AUTH_CHK.  

If there is no entry for DEFAULT_AUTH_CHECK_BADI, or if the value is empty, the implementation class of 

AI_SDK_EXT_AUTH_CHK will be called. 

Activate BAdI for Authorization checks on OneOrder Documents 

The enhancement implementation /SALM/ITSM_MT_ORDER_AUTH_CHECK also provides additional checks on the 

referenced configuration items of business transactions. 

To use these checks, the implementation needs to be activated first.  

 Run transaction SPRO, open SAP Reference IMG. 

 Navigate to SAP Solution Manager → Focused Build → Change Control Extensions → Multi Tenancy 

Extensions. 

 Start Activate BAdI for Authorization checks on OneOrder Documents. 

 If you see the "Do you want to activate the BAdI implementation …" message, it means BAdI is currently 

inactive. Choose Yes  to activate.  
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 If you see the "Do you want to deactivate the BAdI implementation …" message, it means BAdI is currently 

active. Choose Cancel  to close the dialog. The implementation remains active. 

Activate MTE 

Finally, you need to activate the multitenancy enhancements in customizing. 

 Run transaction SPRO, open SAP Reference IMG. 

 Navigate to SAP Solution Manager → Focused Build → Change Control Extensions → Multi Tenancy 

Extensions. 

 Start Define Multi Tenancy Settings. 

 Select General Parameters. 

There are three parameters to switch on the multitenancy checks. Enter value X to activate. 

 ACTIVATE_MTE 

o Activates Multi Tenancy in general. None of the functions (such as business partner or configuration 

item-dependent checks, status check for transaction types) can be used without this activation. 

o Please note that some restrictions are not controlled by this parameter. For example, the 

authorization to display a business partner of a specific authorization group is independent of this 

parameter. This will work even if MTE is deactivated. 

 ACTIVATE_MTE_BP 

o Activates the business partner-dependent check: The user's root organization needs to be entered in 

a specified partner function of an CRM ticket.  

o Parameter ACTIVATE_MTE must also be activated. 

 ACTIVATE_MTE_CI  

o Activates the checks based on configuration items: The organization of the current user needs to be 

assigned to the referenced object of a transaction. 

o Parameter ACTIVATE_MTE must also be activated. 

 

The following tables which checks where performed for a combination of these three parameters. 

ACTIVATE_MTE ACTIVATE_MTE_BP ACTIVATE_MTE_CI Executed Checks 

X - - Status Check for Transaction Types 

X X - Status Check for Transaction Types 

Business Partner Dependent Checks 

X - X Status Check for Transaction Types 

Configuration Item Dependent Checks 

X X X Status Check for Transaction Types 

Business Partner Dependent Checks 

Configuration Item Dependent Checks 

- - - None 

- X - None 

- - X None 

- X X None 
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 Configure Status Dependent Check Framework 

4.9.1 Use Cases 

Check for Mandatory Inputs 

Consistency check for mandatory field is not only not performed when creating new documents, but also later in 

the process. It can be executed on status change: As soon as the user tries to set a new status via action or 

directly the system checks whether there are any mandatory fields, business partner or texts which need to be 

filled when entering the new status.  

Some standard fields can be examined by the standard status-dependent check, but this framework can be used 

in user-defined fields too. 

• Fast entry fields 

• Business Partners 

• Texts 

Lock Fields Against Subsequent Changes 

Input fields might be locked against changes, but without additional development there is no possibility to do so 

dependent from the current status. 

• Fast entry fields 

• Business Partners 

4.9.2 Activating the Piece List 

Run transaction SCC1 in your working client and activate the piece list /SALM/CHARM_EXT, which will supply 

your system with the predefined customizing. The result of this activation can be verified in transaction SCC3. 

4.9.3 Consistency Checks for Change Transaction Types 

Make sure that the used change management transaction types have the consistency check 

/SALM/CONS_CHECK configured for the used status values. This check is used for all status dependent checks 

and the field locks described in this guide. 

In transaction SPRO call SAP Reference IMG and go to SAP Solution Manager  Capabilities (Optional)  Change 

Control Management  Change Request Management Framework  Make Settings for Change Transaction 

Types 
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Select your transaction type and choose Assign Consistency Checks. 

 

Add the check /SALM/CONS_CHECK for each status where it should be performed. This condition might be 

inserted for each existing status. As long as there is no further customizing (as described below), nothing will 

happen. 

 

4.9.4 Additional Field Checks 

In this customizing activity, you can add fields, which need to be checked when a certain status is reached. You 

can also disable the field for a status, while it can still be edited in other status.  

 

In transaction SPRO call SAP Reference IMG and go to SAP Solution Manager  Focused Build  Change Control 

Management Extensions  Status Dependent Check Framework 
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Choose Activity Additional Field Checks on next screen. 

 

 

Create an entry for each field and status you like to check. 

• First enter transaction type, status profile and user status.  

• Select your field by using the columns Object Name and Fieldname – object.  

• The column Mandatory indicates whether the specified field has to have a value when the status is reached. 

• The column Display indicates whether the specified field is disabled in the given status. If you want to keep the 

field disabled for all follow-up status, you need to add an entry for each status. 

 

Example 

You use the change management transaction ZMAD (copy of admin change). You like to check that the Description 

field has a value when the status In Development is set. 
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Add consistency check to ZMAD as described in chapter Activating the Piece List 

Run transaction SCC1 in your working client and activate the piece list /SALM/CHARM_EXT, which will supply 

your system with the predefined customizing. The result of this activation can be verified in transaction SCC3. 

Consistency Checks for Change Transaction Types 

 Select transaction type ZMAD. 

 Choose Assign Consistency Checks. 

 Add Entry: 

1. User Status E0002 (In Development): 

2. Sequence: 15 (or any other unused number). 

3. Status Transition Consistency Check: /SALM/CONS_CHECK 

4. Application Area: /SALM/ITSM_CC 

5. Message Number: 001 

6. Message Type: A Cancel 

 

Add check for input field in activity Additional Field Checks 

 

Trans Type:   ZMAD 

StatProf:   ZMADJHEAD 

UsrSt:    E0002 
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Object Name:   ORDERADM_H 

Field name – object:  DESCRIPTION 

Mandatory:   [Checked] 

Display:    [Checked]  

 

To disable field description in status E002, check the column Display too. 

 

4.9.5 Check of Business Partner Function 

In this Customizing activity, you can add business partner functions, which needs to be checked when a certain 

status is reached. You can also disable the business partner input field for a status, while it can still be edited in 

other status.  

 In transaction SPRO, call SAP Reference IMG and go to SAP Solution Manager  Focused Build  Change 

Control Management Extensions  Status Dependent Check Framework 

 

 Choose activity Check of Business Partner Function on next screen. 
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 Create an entry for each business partner function and status you like to check. 

 First enter transaction type, status profile and user status.  

 Select your business partner function by using the column Function.  

 The column Mandatory indicates whether the specified business partner function has to have a value 

when the status is reached. 

 The column Display indicates whether the field for the specified business partner function is disabled in 

the given status. If you want to keep the field disabled for all follow-up status, you need to add an entry for 

each status. 

 

 

Example 

Use the change management transaction ZMAD (copy of admin change), and check that the Change Manager is 

specified when the status To be tested is set. 
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 Add consistency check to ZMAD as described in chapter Activating the Piece List 

Run transaction SCC1 in your working client and activate the piece list /SALM/CHARM_EXT, which will supply 

your system with the predefined customizing. The result of this activation can be verified in transaction SCC3. 

Consistency Checks for Change Transaction Types. 

1. Select Transaction Type ZMAD. 

2. Choose Assign Consistency Checks. 

 Add Entry: 

o User Status E0004 (In Development):  

o Sequence: 15 (or any other unused number) 

o Status Transition Consistency Check: /SALM/CONS_CHECK 

o Application Area: /SALM/ITSM_CC 

o Message Number: 001 

o Message Type: A Cancel 

 

 Add check for business partner in activity Check of Business Partner Function. 

 

Trans Type:  ZMAD 

StatProf:  ZMADHEAD 

UsrSt:   E0004 
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Function:  SDCR0002 (Change Manager) 

Mandatory:  [Checked] 

Display:   [Unchecked] 

 If the business partner should be disabled in status E004, check the column Display too. 

 

4.9.6 Check of Text Fields 

In this customizing activity, you can add texts, which needs to be checked when a certain status is reached.  

In transaction SPRO call SAP Reference IMG and go to SAP Solution Manager  Focused Build  Change Control 

Management Extensions  Status Dependent Check Framework 

 

Choose Activity Check of Text Fields on next screen. 
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Create an entry for each text and status you like to check. 

• First enter transaction type, status profile and user status.  

• Select your text type by using the column ID.  

• The column Mandatory indicates whether the specified text has to have a value when the status is reached. 

 

Example 

You use the Change Management Transaction ZMAD (Copy of Admin Change). You like to check that the Test 

Instruction is entered when the status To be Tested is set. 
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Add consistency check to ZMAD as described in chapter Activating the Piece List 

Run transaction SCC1 in your working client and activate the piece list /SALM/CHARM_EXT, which will supply 

your system with the predefined customizing. The result of this activation can be verified in transaction SCC3. 

Consistency Checks for Change Transaction Types 

1. Select Transaction Type ZMAD 

2. Choose Assign Consistency Checks 

3. Add Entry: 

4. User Status E0004 (In Development):  

5. Sequence: 15 (or any other unused number) 

6. Status Transition Consistency Check: /SALM/CONS_CHECK 

7. Application Area: /SALM/ITSM_CC 

8. Message Number: 001 

9. Message Type: A Cancel 

 

Add check for text in activity Check of Business Partner Function 

Trans Type:  ZMAD 

StatProf:  ZMADHEAD 

UsrSt:   E0004 

ID:   CD02 (Test Instruction) 

Mandatory:  [Checked] 
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 Configuration of Change Request Management - 
Scorecard 

4.10.1 Use Case 

The scorecard provides an aggregated overview on current process types in the context of change request 

management with a possible drill down into the respective list view and further more into the details of each 

individual business transaction. For this purpose, the scorecard provides at least one top level aggregation 

attribute (usually the process type) and several second level aggregation attributes (such as priority, status). 

The following mock-up demonstrates this. 

 

4.10.2 Activating the Piece List 

Run transaction SCC1 in your working client and activate the piece list /SALM/CHARM_EXT, which will supply 

your system with the predefined customizing. The result of this activation can be verified in transaction SCC3. 

4.10.3 Customizing Scorecard 

Activate BAdI to aggregate data for Scorecard 

Make sure the implementation /SALM/ITSM_SCCD_IDX of definition CRM_ORDER_INDEX_BADI is activated. 

Activate if necessary. 
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Configure Scorecards 

The configuration of the Scorecard is to be done in a central view cluster accessible via SPRO or SM34: 

/SALM/ITSMSC_VC 

 

 

Changes in the Customizing Cluster have to be recorded into a transport request. 

Define Groups 

Here you define the aggregation attributes that should form a group in the scorecard. 

 

SC Group   = Group Identifier 

Title    = Description of the Group 

Component Name  = Field name of the BOL query result structure the values for this group will be retrieved 

from 

Table Name = Name of the table or view containing the descriptions of the attribute values 

Field Name = Language field name of the text table 

Field Name = description field name of the text table 

 

The following entries will be delivered by default: 

SC-Group Title Component Name Table Name Field 

Name 

Field Name 

PRCTP 

Process 

Types PROCESS_TYPE CRMC_PROC_TYPE_T LANGU P_DESCRIPTION 

PRIOT Priorities PRIORITY SCPRIOT LANGU TXT_LONG 

RELSE Release /AICRM/PROJECT_ID /SALM/ITSMSCVRLS  DESCRIPTION 

RESPO 

Responsible 

Person /AICRM/BP_NO_ BUT000  NAME1_TEXT 
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SC-Group Title Component Name Table Name Field 

Name 

Field Name 

STATU Status STATUS /SALM/ITSMSCVSTT SPRAS TXT30 

Note 

Please note that the business partner field /AIC/BP_NO_ used for the responsible person group RESPO is a 

generic one. Based on further configuration the field name will be completed with a 2-digit number varying from 

01 to 10. (For example, /AIC/BP_NO_03) 

 

Define Text Access Field Mapping 

Here you define how the fields of the data used for the ScoreCard will be mapped to the text table for each group 

to read the correct description for the field values. 

 

Scorecard Group  = Group Identifier 

Table Name  = Name of the table or view containing the descriptions of the attribute values 

Field Name  = Key field of the text table 

Field Name  = Field of the ScoreCard data to be mapped to the key field 

 

The following entries will be delivered by default: 

SC Group Table Name Field Name Field Name 

PRCTP CRMC_PROC_TYPE_T PROCESS_TYPE PROCESS_TYPE 

PRIOT SCPRIOT PRIORITY PRIORITY 

RELSE /SALM/ITSMSCVRLS SMI_PROJECT /AICRM/PROJECT_ID 

RESPO BUT000 PARTNER /AICRM/BP_NO_ 

STATU /SALM/ITSMSCVSTT ESTAT STATUS 

STATU /SALM/ITSMSCVSTT PROCESS_TYPE PROCESS_TYPE 

Define Usage Types 

Here you define the usage types for the ScoreCard. As the ScoreCard is able to be displayed in the context of 

Change Request Management, Incident Management and Requirements Management. 

 

SC Usage  = ScoreCard Usage Identifier 

Belongs To = Responsibility of business transactions presented to the user logged on (not in use anymore) 

External Object Name = BOL Query object name used to select the business transactions (not in use 

anymore) 

Bar Color  = HTML Color code used for the ScoreCard bar 

Number  = max. number of search result hits (not in use anymore) 

 

The following entries will be delivered by default: 
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SC Usage Belongs To External Object Name 

CHM  BTQAICSearch 

Note 

Please note that the ScoreCard usage identifier cannot be freely defined. It has to be one of the values defined by 

the class attribute /ALM/CL_SCORECARD_SERVICE=>GC_SC_USAGES. 

 

Define Assign Transaction Types 

Here you assign the transaction types that should be considered to be shown in the ScoreCard for a dedicated 

usage. 

 

ScoreCard Usage = ScoreCard usage identifier 

Trans. Type  = Business transaction type 

Object Type  = UI Object type that represents the transaction type 

Sort Order  = Numeric value to setup the sort order for display 

Sequence  = Numeric value between 01 and 10 defining the business partner field to be used 

 

The following entries will be delivered by default: 

SC Usage Trans. Type Object Type Sort Order Sequence 

CHM SMAD AIC_OB_CMCD 50 03 

CHM SMCG AIC_OB_CMCD 40 05 

CHM SMCR AIC_OB_CMCR 10 05 

CHM SMHF AIC_OB_CMCD 20 05 

CHM SMMJ AIC_OB_CMCD 30 05 

 

Define Status to Be Considered 

Here you configure which status values of each transaction type are relevant to be considered within the 

Scorecard. 

 

ScoreCard Usage = ScoreCard usage identifier 

Trans. Type  = Business transaction type 

UsrSt   = User Status 

Sort Order  = Numeric value to setup the sort order for display 

 

The following entries will be delivered by default: 

SC Usage Trans. Type UsrSt Sort Order 

CHM SMAD E0001 10 
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SC Usage Trans. Type UsrSt Sort Order 

CHM SMAD E0002 20 

CHM SMCG E0001 10 

CHM SMCG E0003 20 

CHM SMCR E0001 10 

CHM SMCR E0004 40 

CHM SMCR E0005 60 

CHM SMCR E0011 45 

CHM SMCR E0012 30 

CHM SMCR E0014 20 

CHM SMCR E0015 50 

CHM SMHF E0001 10 

CHM SMHF E0002 20 

CHM SMHF E0004 30 

CHM SMHF E0005 40 

CHM SMHF E0006 60 

CHM SMHF E0009 50 

CHM SMMJ E0001 10 

CHM SMMJ E0002 20 

CHM SMMJ E0004 30 

CHM SMMJ E0009 40 

CHM SMMJ E0011 50 

CHM SMMJ E0012 52 

CHM SMMJ E0013 54 

CHM SMMJ E0014 60 

Define Assign Groupings 

Here you define which groups should be displayed at which level for each usage type. 

 

Scorecard Usage  = ScoreCard usage identifier 

Level   = Level of the group (currently 1 or 2) 

Counter   = Number of the group entry 

SC Group  = ScoreCard group identifier 

Indicator  = Flag to indicate that the group label/title will be generic set from the attribute value of

   this group 
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The following entries will be delivered by default: 

SC Usage Level Counter SC Group Indication 

CHM 1 1 PRCTP Yes 

CHM 2 1 PRIOT No 

CHM 2 2 STATU No 

CHM 2 3 RELSE No 

CHM 2 4 RESPO No 

 Note 

On level 1 only one group can be assigned. 

4.10.4 Generating Scorecard data 

Once the configuration has been completed, or whenever it has been changed, the initial ScoreCard data has to be 

generated once. 

First in the view cluster /SALM/ITSMSC_VC within the step Define Usage Types the ScoreCard buffer should be 

refreshed: 

 

Note 

The Refresh ScoreCard Buffer option is only available in change mode. 

 

Once done, the buffered data can be rebuild using transaction SA38 and executing report CRM_INDEX_REBUILD. 

 

The Scorecard buffer will be automatically filled or updated once a score card relevant business transaction is 

changed. 
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 Configuring Release Batch Import 

4.11.1 Piece List Activation 

The standard customizing of SAP change request management and all other IT service management-relevant 

areas is delivered via a customizing piece list. This piece list needs to be activated as part of transaction 

SOLMAN_SETUP and will copy the standard customizing from Client 000 into the working client of SAP Solution 

Manager. 

 

Activating the piece list again will overwrite all existing standard customizing with the content of the piece list. 

Therefore it is recommended to copy all transaction types into the customer namespace, before starting to use 

SAP change request management.  

 

4.11.2 Required SAP Note Implementations 

Before you start to configure release batch import, review the according master note for SAP change request 

management that fits to your SP Level and implement the latest version before moving on with configuration. 

SAP Note Description SAP 

Solution 

Manager 

Managed 

System 

1818804 Change Request Management:  

Enable client restriction for import subsets  

 X 

http://service.sap.com/sap/support/notes/1818804
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SAP Note Description SAP 

Solution 

Manager 

Managed 

System 

1731806  Change Request Management:  

Support of multi-client import  

X X 

1741751 new remote infrastructure without domain link is required 

on Managed Systems 

 X 

1384598 Harmonizing RFC communication infrastructure in 

ChaRM/QGM 

X X 

1650265 TMS workflow: 'Ignore Invalid Component Version' missing X X 

2407691 Focused Build - Next status not set by Batch Import X  

2411350 Focused Build - No selection of documents caused by 

communication client 

X  

2413018 Incorrect buffer check in Batch Release Import X  

2435470 Focused Build - Multiple releases with the Release Batch 

Import cannot be used 

X  

4.11.3 Creating Import Variants 

The release batch import utilizes the status-dependent imports. 

The following tables show the best practice settings for the standard transaction types. 

Additional customer specific CRM user statuses must be mapped accordingly: 

Test System: 

Transaction Type Status Profile Status 

ZMTM ZMTMHEAD E0004 

ZMTM ZMTMHEAD E0009 

ZMMJ ZMMJHEAD E0004 

ZMMJ ZMMJHEAD E0006 

ZMMJ ZMMJHEAD E0009 

ZMMJ ZMMJHEAD E0011 

ZMMJ ZMMJHEAD E0012 

ZMMJ ZMMJHEAD E0013 

ZMMJ ZMMJHEAD E0014 

ZMHF ZMHFHEAD E0004 

http://service.sap.com/sap/support/notes/1731806
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Transaction Type Status Profile Status 

ZMHF ZMHFHEAD E0005 

ZMHF ZMHFHEAD E0006 

ZMHF ZMHFHEAD E0007 

ZMHF ZMHFHEAD E0008 

ZMHF ZMHFHEAD E0009 

Production System: 

Transaction Type Status Profile Status 

ZMTM ZMTMHEAD E0009 

ZMMJ ZMMJHEAD E0006 

ZMMJ ZMMJHEAD E0009 

ZMMJ ZMMJHEAD E0014 

ZMHF ZMHFHEAD E0006 

ZMHF ZMHFHEAD E0007 

ZMHF ZMHFHEAD E0008 

ZMHF ZMHFHEAD E0009 

Note 

Some Hints in regards to Status Dependent Import Control-> SCN blog 

http://scn.sap.com/community/it-management/alm/solution-manager/blog/2014/09/08/some-

hints-to-status-dependant-import-control 

In the Customizing of SAP Solution Manager, choose SAP Solution Manager → Focused Build → Release Batch 

Import → Configure Release Deployment and Batch Import. 

Create Import Variant for QAS 

Create new batch import variant /OST/QAS for the import to the quality assurance system(s): 

 

http://scn.sap.com/community/it-management/alm/solution-manager/blog/2014/09/08/some-hints-to-status-dependant-import-control
http://scn.sap.com/community/it-management/alm/solution-manager/blog/2014/09/08/some-hints-to-status-dependant-import-control
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Set your import variant to Active and activate Weekday Specifications as well: 

 

As next step, the import strategy for your newly created import variant /OST/QAS must be defined: 

 

Set the status dependent import control active for   

• Import Config. = /OST/IMPORT_QAS 

• System Role ID = T (Quality Assurance System, IMPORT_STA)   

• Import Strategy = Import via status of certain elements is used 

• Phase Check = Activate check box, in case you would like to establish a phase check for the import to the QAS 

System (optional) 

• Continue = Activate check box if additional transport requests should be imported, in case that the import of 

certain transports fails due to DGP or technical issues (optional). 

Define up front for which transactions types CRM user status this should be valid: 

 Caution 

Best practice is to always also put status values that are higher than the value where you want to perform 

the import, to make sure you are not blocking. 

Import Customizing: Status: 

Urgent Change (SMHF): 
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Please use the CRM user status values of the standard transaction type Urgent Change copied to the Customer 

Namespace (ZMHF). 

If the customer has adapted the SAP change request management standard workflow for urgent change, adapt 

the CRM user status values accordingly. 

 

Normal change (with TR) (SMMJ): 

 

Use the CRM user status values of the standard transaction type Normal Change copied to the customer 

namespace (ZMMJ). 

If the customer has adapted the SAP change request management standard workflow for normal change, adapt 

the CRM user status values accordingly. 

 

Defect Correction (SMTM): 
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Use the CRM user status values of the standard transaction type Defect Correction copied to the customer 

namespace (ZMTM). 

If the customer has adapted the SAP change request management standard workflow for defect correction, adapt 

the CRM user status values accordingly. 

 Caution 

Transports without change belonging to the same cycle type will be deployed in conjunction only when 

inserting an empty record into import strategies. 

Batch Import: Parameters: 

 

• Sequence:  

 Enter 10 in the case of a Consolidated Import. 

 In the case of a sequential import, for instance for SAP ERP and SAP BW, you need two entries, one with 

sequence 10 for SAP ERP, and one with sequence 20 for SAP BW. 

• Set the following checkboxes to Active: 

 Active? 

 Ignore CVers 

 

Valid Phases for Import of Project to certain System: 

This configuration step is optional for the Import to the Quality Assurance System. 
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Independent System Settings: 

 

Create an Entry for 

• Your QAS System and client, 

• Communication Client: Use the Import Client as Communication Client, 

• Sequence:  

 Enter '10' for a consolidated import. 

 If of a sequential import, for instance for SAP ERP and SAP BW, you need two entries, one with Sequence 

'10' for SAP ERP, and one with Sequence '20' for SAP BW. 

• RFC Type: Select Trusted RFC. 

 

This Customizing is only considered, if Maintain Landscape Data and Maintain System Clients in this View Cluster 

is not configured for your Import Variant. 

Otherwise, the configuration of Maintain Landscape Data and Maintain System Clients will always overrule the 

Independent System Settings. 

Date & Time Validity: 

 

Weekday Specifications: 
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Maintain Landscape Data: 

Finally, you must maintain the relevant Landscape Data for which the selected Import Strategy/Import Config. 

should be executed: 

 

Set the status dependent import control active for:   

• Import Config. = /OST/IMPORT_QAS, 

• Solution ID = Enter your Solution ID; you can also use Wildcard, 

• Cycle Type = Possible Values: Major Release, Minor Release, Emergency Release, Continual Cycle, Phased 

Cycle, QGM Change Cycle or 'All Types of Change Cycles'), and  

• System = Enter the relevant System(s), 

• Sequence: 

 Enter '10' in case of a Consolidated Import.  

 If a sequential import, for instance for SAP ERP and SAP BW is necessary, two entries, one with Sequence 

'10' for SAP ERP, and one with Sequence '20' for SAP BW are required! 

Please keep in mind, that in the latter case, you also need to define the Batch Import Parameters with analogous 

Sequences for the Import to SAP ERP and SAP BW. 

• Non-ABAP. 
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Note 

Wildcard (*) is valid for Solution ID 

Maintain System Clients: 

 

Set the status dependent import control active for: 

• Client = Enter the relevant Client for Import to QAS, 

• System Role ID = 'T' (for Quality Assurance System), 

• Communication Client = You should enter the relevant Client for Import to QAS, 

• RFC Type = Select 'Trusted RFC' as RFC Type, 

• Sequence 

 Enter '10' in case of a Consolidated Import. 

If a sequential import, for instance for SAP ERP and SAP BW is necessary, two new entries, one with Sequence '10' 

for SAP ERP, and one with Sequence '20' for SAP BW are required! 

Create Import Variant for Pre-Production System 

Create the new Batch Import Variant /OST/PRE_PROD for the Import to the Pre-Production System(s): 

 

Set your Import Variant to Active, and activate Weekday Specifications as well: 
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As next step the Import Strategy for your newly created Import Variant /OST/PRE_PROD must be defined: 

 

Set the status dependent import control active for:  

• Import Config. = /OST/Import_PRE_PROD, 

• System Role ID = '1' (Pre-Production (IMPORT_STA)),   

• Import Strategy = 'Import via Status of certain elements is used', 

• Phase Check = Activate Check Box, in case you would like to establish a Phase Check for Import to the Pre-

production System (optional), and  

• Continue = Activate Check Box, if further Transport Requests should be imported, in case that the import of 

certain Transports fails due to DGP or technical issues (optional). 

Now we need to define on top for which Transactions Types in which status this should be valid: 

 Caution 

Best Practice is to always also put Status Values that are higher than the one, where you want to perform 

the import to make sure you are not blocking. 

Import Customizing: Status: 

 

Urgent Change (ZMHF): 
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Please use the CRM user status values of the standard transaction type Urgent Change copied to the Customer 

Namespace (ZMHF). 

If the Customer has adapted the SAP Change Request Management Standard Workflow for Urgent Change, adapt 

the CRM user status values accordingly. 

 

Normal Change (with TR) (ZMMJ): 

 

Please use the CRM user status values of the standard transaction type Normal Change copied to the Customer 

Namespace (ZMMJ). 

If the Customer has adapted the SAP Change Request Management Standard Workflow for Normal Change, 

adapt the CRM user status values accordingly. 
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Defect Correction (ZMTM): 

 

Please use the CRM user status values of the standard transaction type Defect Correction copied to the Customer 

Namespace (ZMTM). 

If the Customer has adapted the SAP Change Request Management Standard Workflow for Defect Correction, 

adapt the CRM user status values accordingly. 

 

Batch Import: Parameters: 

 

• Sequence:  

 Enter 10 in case of a Consolidated Import. 

 If of a sequential import, for instance for SAP ERP and SAP BW, you need two entries, one with Sequence 

10 for SAP ERP, and one with Sequence 20 for SAP BW. 

• Set the following Checkboxes to 'Active': 

 Active?, as well as, 

 Ignore CVers. 

 

Valid Phases: 

This configuration step is optional for the Import to the Pre-Production System(s). 
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Independent System Settings: 

 

Create an Entry for 

• your Pre-Prod System and Client, 

• Communication Client: Use the Import Client as Communication Client, 

• Sequence 

 Enter 10 for a Consolidated Import, 

 If of a sequential import, for instance for SAP ERP and SAP BW, you need two entries, one with Sequence 

10 for SAP ERP, and one with Sequence 20 for SAP BW. 

• RFC Type: Select Trusted RFC. 

This Customizing is only considered, if Maintain Landscape Data and Maintain System Clients in this View Cluster 

are not configured for this Import Variant. 

Otherwise, the Configuration of Maintain Landscape Data/Maintain System Clients will always overrule the 

Independent System Settings. 

 

Date & Time Validity: 

 

Weekday Specifications: 
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Maintain Landscape Data: 

 

Finally, you must maintain the relevant Landscape Data for which the selected Import Strategy/Import Config. 

should be utilized: 

 

Set the status dependent import control active for:   

• Import Config. = /OST/IMPORT_PRE_PROD, 

• Solution ID = Enter your Solution ID; you can also use Wildcard, 

• Cycle Type = All Types of Changes (Possible Values: Major Release, Minor Release, Emergency Release, 

Continual Cycle, Phased Cycle, QGM Change Cycle or 'All Types of Change Cycles'), and  

• System = Enter the relevant System(s) 

• Sequence: 

 Enter 10 in case of a Consolidated Import, 

 If of a sequential import, for instance for SAP ERP and SAP BW, two entries, one with Sequence 10 for 

SAP ERP, and one with Sequence 20 for SAP BW are required! 

Please keep in mind, that in the latter case, you also need to define the Batch Import Parameters with analogous 

Sequences for the Import to SAP ERP and SAP BW. 

• Non-ABAP. 
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Note 

Wildcard (*) is valid for Solution ID 

Maintain System Clients: 

 

Set the status dependent import control active for: 

• Client = Enter the relevant Client for Import to the Pre-Production System(s), 

• System Role ID = '1' (for Pre-Production System), 

• Communication Client = Enter the relevant Client for Import to Pre-Production System(s), 

• RFC Type = Select Trusted RFC as RFC Type, 

• Sequence: 

 Enter 10 in case of a Consolidated Import, 

If a sequential import, for instance for SAP ERP and SAP BW is necessary, two new entries, one with Sequence 10 

for SAP ERP, and one with Sequence 20 for SAP BW are required. 

Create Import Variant for PRD 

Create the new Batch Import Variant /OST/PROD for the Import to the Production System(s): 

 

Set your Import Variant to Active and activate Weekdays Specifications as well: 
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As next Step the Import Strategy for your newly defined Batch Import Variant /OST/PROD hast to be defined: 

 

Set the status dependent import control active for:   

• Import Config. = /OST/IMPORT_PRODUCTiON, 

• System Role ID = 'P' (Production System),   

• Import Strategy = 'Import via Status of certain elements is used', 

• Phase Check = Activate Check Box, in case you would like to establish a Phase Check for Import to the 

Production System (highly recommended!), and  

• Continue = Activate Check Box, if further Transport Requests should be imported, in case that the import of 

certain Transports fails due to DGP or technical issues (optional). 

Now we need to define on top for which Transactions Types in which status this should be valid: 

 Caution 

Best Practice is to always also put Status Values that are higher than the one, where you want to perform 

the import to make sure you are not blocking. 

Import Customizing: Status: 

 

Urgent Change (ZMHF): 
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Normal Change (with TR) (ZMMJ): 

 

Defect Correction (ZMTM): 
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Batch Import: Parameters: 

 

• Sequence:  

 Enter 10 in case of a Consolidated Import. 

 If of a sequential import, for instance for SAP ERP and SAP BW, you need two entries, one with Sequence 

10 for SAP ERP, and one with Sequence 20 for SAP BW. 

• Set the following Checkboxes to 'Active': 

 Active?, as well as, 

 Ignore CVers. 

 

Valid Phases: 

For the import to the Production System(s) it is highly recommended(!) to establish a Phase Check. In order to do 

so a 2-Step Customizing is required: 

• At first, we have already activated the Checkbox 'Phase Chk' on the level of the Import Strategies. 

• In the following Customizing Step, you define the details of the Phase Check, which shall take place. For 

instance, if you use the SAP Release Management, the Phase Check will verify, if the Release Cycle Document 

(SMRE) is in CRM User Status 'E0006' ('Deploy'). If this is not the case, the Program 

/SALM/BATCH_IMPORT_TRIGGER will not perform any imports to the Production System(s): 
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If you use a Phase Cycle, the following Customizing Entry is required: 

Sequence Trans. Type StatProf  UsrSt 

10  SMIM  SMIMHEAD E0006 

 

Independent System Settings: 

 

Create an Entry for 

• your Production System(s) and Client, 

• Communication Client: Use the Import Client as Communication Client, 

• Sequence 

 Enter 10 for a Consolidated Import, 

 If of a sequential import, for instance for SAP ERP and SAP BW, you need two entries, one with Sequence 

10 for SAP ERP, and one with Sequence 20 for SAP BW. 

• RFC Type: Select Trusted RFC. 

 

This Customizing is only considered, if Maintain Landscape Data and Maintain System Clients in this View Cluster 

are not configured for this Import Variant. 
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Otherwise, the Configuration of Maintain Landscape Data/Maintain System Clients will always overrule the 

Independent System Settings. 

 

Date & Time Validity: 

 

Weekday Specifications: 

 

Maintain Landscape Data: 

 

Finally, you must enter the relevant Landscape Data for which the selected Import Strategy is to be used: 
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Set the status dependent import control active for:   

• Import Config. = /OST/IMPORT_PROD, 

• Solution ID = Enter your Solution ID; you can also use Wildcard, 

• Cycle Type = All Types of Changes (Possible Values: Major Release, Minor Release, Emergency Release, 

Continual Cycle, Phased Cycle, QGM Change Cycle or 'All Types of Change Cycles'), and  

• System = Enter the relevant System(s) 

• Sequence: 

 Enter 10 in case of a Consolidated Import, 

 If of a sequential import, for instance for SAP ERP and SAP BW, two entries, one with Sequence 10 for 

SAP ERP, and one with Sequence 20 for SAP BW are required! 

Please keep in mind, that in the latter case, you also need to define the Batch Import Parameters with analogous 

Sequences for the Import to SAP ERP and SAP BW. 

• Non-ABAP. 

 Caution 

Wildcard (*) is valid for Solution ID 

 

Maintain System Clients: 
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Set the status dependent import control active for: 

• Client = Enter relevant Client for productive Import, 

• System Role ID = 'P' (for Production System), 

• Communication Client = Enter relevant Client for productive Import, 

• RFC Type = Select Trusted RFC as RFC Type, 

• Sequence: 

 Enter 10 in case of a Consolidated Import, 

If a sequential import, for instance for SAP ERP and SAP BW is necessary, two new entries, one with Sequence 10 

for SAP ERP, and one with Sequence 20 for SAP BW are required. 

 Caution 

Wildcard (*) is valid for Solution ID and Client, even if offered for System as well. System field must be 

specified with a value and no wildcard! 

Special Setup in Case of TMW 

If you would like to use the TMW RFC Connection instead of TRUSTED RFC, check for RFC User: 
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Additional authorization is required for communication (reading buffer, etc.). The User behind the RFC which is 

used to the Managed System (TMW RFC for communication client) needs to have authorization for function group 

TMW_PROJECT_LOCK on the Managed System for authorization object S_RFC. Fall back is Client 000. 

 

 

On top the user need to have authorization for IMPORT! 

4.11.4 Starting Import based on Import Variant 

Go to transaction SE38 and enter Program /SALM/BATCH_IMPORT_TRIGGER. 

 

Choose Import Variant: /OST/QAS: 
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The Program /SALM/BATCH_IMPORT_TRIGGER is used to trigger imports for all relevant System Roles (QAS, 

Pre-production and Production System). 

However, for Pre-production and Production System, the Import should be controlled by the IT-Operator, but not 

be scheduled automatically by the System. 

Program /SALM/BATCH_IMPORT_TRIGGER - General Options 

 

• Release to Import 

Choose the Cycle Type which should be imported based on the entered Import Variant. 

You can also enter multiple releases, or use Wildcard. 

• Import into Production Systems 

Here it can be decided, if the Import would be performed into a Production System or not 



 

224 

CUSTOMER  

© 2018 SAP SE or an SAP affiliate company. All rights reserved. 

Focused Build for SAP Solution Manager 

Configuration of Standalone Extensions 

 

 

• Import Variant 

The Import variants is defined via the customizing for Release Batch Import, 

Defines, which systems should be considered for import, 

Provides restrictions which have to be fulfilled 

(e.g. system roles or CRM User Status of Change Documents). 

• Allows Transports of Task List without Change assigned 

Also transports, which are not assigned to a change document, will be imported. 

• Test Mode 

All checks will be performed, but no import is triggered. 

• Parallel import Process* 

This Option allows a parallelized import into multiple defined target systems. 

• Process only Test transports 

Only Transports of Copies (TOC) will be imported, 

During the transport selection all non TOCs will be removed from the selection. 

• Reside in buffer after import 

After import into the defined systems the transports will be left on the import buffer. 

Program /SALM/BATCH_IMPORT_TRIGGER - Scheduling Options 

 

• Enable Automatic Rescheduling 

After program is finished it will schedule itself again to run again as a job. 

• Minutes until auto restart 

If Automatic Rescheduling is enabled, this defines the number of minutes after which the program will run 

again, 

Enabled Active Automatic Rescheduling will be active permanently, so the Job has to be removed manually 

to stop the rescheduling. 
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Program /SALM/BATCH_IMPORT_TRIGGER - Check Options for Downgrade 
Protection 

 

• Downgrade Protection on 

Performs check on possible downgrades, 

Found downgrades will be logged. 

• Skip downgrade Transports 

If this option is disabled and if transports from the selection are affected from a downgrade, no import will be 

triggered, 

If this option is enabled transports which are affected from downgrades will be removed from the selection before 

the import is triggered, 

On productive systems: If a downgrade has been found in the transport selection skipping is not allowed. 

Thus, no import will be triggered. 

Program /SALM/BATCH_IMPORT_TRIGGER -  Relational Checks 

The Check Options for Relational Checks are only valid, when a customer has implemented Focused Build 

'Requirement-to Deploy'.  

They are not applicable, when utilizing the Focused Build Standalone Enhancement 'Release Batch Import'! 

Release Batch Import Log 

For each run of the Program /SALM/BATCH_IMPORT_TRIGGER an Application Log is being created. 

Please access the Application Log via transaction SLG1 with 

Object: /SALM/, and 

Subobject: /SALM/BATCH_DEPLOY 

 



 

226 

CUSTOMER  

© 2018 SAP SE or an SAP affiliate company. All rights reserved. 

Focused Build for SAP Solution Manager 

Configuration of Standalone Extensions 

 

 

 Configuration of Template Protection 

4.12.1 Verifying Basic Configuration for SAP Solution 
Manager 

Before starting with the Basic Configuration of your SAP Solution Manager system you should read the 

documentation and initial descriptions available in the Implementation Guide (transaction SPRO).  

Therefore, navigate to SAP Solution Manager Implementation Guide  SAP Solution Manager  Basic 

Configuration  Basic Configuration: Guided Procedure. 

 

Via the transaction SOLMAN_SETUP, you start the initial configuration of the SAP Solution Manager system. In the 

navigation area on the left, you can access the following guided procedures which contain configuration steps 

relevant for the Change Request Management scenario:  

 

System Preparation: In this guided procedure, you make settings preliminary for the Solution Manager 

Configuration, such as creation of dialog users with the required authorizations, implementation of the central 

Correction Note and Web Service configuration. 
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Basic Configuration: This guided procedure leads you through all configuration steps, which you have to perform 

to enable basic scenarios in SAP Solution Manager. As part of the Basic Configuration, you set up the connection 

to SAP, schedule relevant background jobs and activate piece lists which contain important settings, such as 

standard customizing. 

 

Managed System Configuration: In the Managed System Configuration, you connect Managed Systems to the 

Solution Manager via RFC. This is important, since SAP Change Request Management requires a READ, TMW and 

TRUSTED RFC Connection to every Managed System/Client. In order to ensure that SAP Change Request 

Management works perfectly with Managed Systems a minimum SP Level is required. Please check SAP Note 

907768 for further details. 

 

 

Please, confirm that you have successfully performed those three configuration steps according to the guided 

procedure documentations! 

In addition to the Basic Configuration for SAP Solution Manager you must perform the Basic Configuration for 

SAP Change Request Management. 

4.12.2 Piece List Activation 

The Standard Customizing of SAP Change Request Management and all other IT Service Management relevant 

areas is delivered via a customizing piece list. This piece list needs to be activated as part of transaction 

SOLMAN_SETUP and will copy the standard customizing from Client 000 into the working client of SAP Solution 

Manager. 

 

Activating the piece list again will overwrite all existing standard customizing with the content of the piece list – 

therefore it is strictly recommended to copy all transaction types into the customer namespace, before starting to 

use SAP Change Request Management.  
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Template Protection is delivered with predefined customizing which must be activated via piece list 

/SALM/TEMPLATEPROTEC (refer to chapter Error! Reference source not found. Error! Reference source not fo

und.). This predefined configuration allows direct usage of Simple IT Request without any further adjustments. 

4.12.3 SAP Change Request Management Setup as a 
Prerequisite for Template Protection 

Before you start to configure SAP Change Request Management, implement the according Master Note for SAP 

Change Request Management in the latest version, which fits to your SP Level. 

The configuration of SAP Change Request Management is a prerequisite for the utilization of Template 

Protection. 

4.12.4 Activation of Template Protection Checks 

In order to activate the Template Protection in your system, a BAdI Implementation for the Transport Generic 

Check Framework (/TMWFLOW/TRANS_DEFINED_CHECK) has to created. Within this implementation, the 

Template Protection Checks will be activated at the different actions of a Transport Request. You can include your 

own checks as well. 
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To create a BAdI Implementation, you need to navigate to ttransaction SE18 and create an implementation via 

Enhancement Implementation  Create. 

 

 

 

 

 

 

 

 

 

You need to define a Name and Description. If you like, you can also assign this Implementation to a Composite 

Enhancement Implementation. 

 

 

 

 

 

Define a BAdI Implementation, Implementation Class and select the BAdI Definition 

 

/TMWFLOW/TRANS_DEFINED_CHECK. 
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4.12.5 Check at Save of Objects 

The following implementation will activate the check at the time of saving objects. So when you maintain objects 

and save the changes to the transport request, the Template Protection checks will be executed in parallel to the 

Cross System Object Locks checks. 

To activate the Checks you need to create a BAdI Implementation and implement the method 

/TMWFLOW/IF_TRANS_CUSTOM_CHK~CHECK_BEFORE_SAVE_TRANS_REQ via double click. 

 

Confirm the popup. 

 

Implement the following code in addition to your own code. 

  METHOD /tmwflow/if_trans_custom_chk~check_before_save_trans_req. 

 

*Template Protection Checks 

    /salm/cl_tpp_generic_chk=>check_before_save_trans_req( 

      EXPORTING 

        iv_transport_request    = iv_transport_request 

        iv_src_sys_tms_sid      = iv_src_sys_tms_sid 

        iv_src_sys_client       = iv_src_sys_client 

        iv_src_sys_tms_domain   = iv_src_sys_tms_domain 

        it_locks_4_object       = it_locks_4_object 

        it_locks_4_table_key    = it_locks_4_table_key 

      IMPORTING 

        et_check_result         = et_check_result 

        et_error_message        = et_error_message ). 

 

  ENDMETHOD. 

 

Save and Activate the Method. 
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4.12.6 Check at Release of Transport Requests 

The following implementation will activate the check at the time of releasing transport requests. So when a 

Transport Request is being released within Change Request Management, Quality Gate Management or directly 

via the Task List, the Template Protection checks will be executed in addition to Downgrade Protection Checks. 

To activate the checks you need to create a BAdI Implementation and implement the method 

/TMWFLOW/IF_TRANS_CUSTOM_CHK~CHECK_BEFORE_RELEASE via double click. 

 

Confirm the popup. 

 

Implement the following code in addition to your own code. 

 

  METHOD /tmwflow/if_trans_custom_chk~check_before_release. 

 

    /salm/cl_tpp_generic_chk=>check_before_release( 

    EXPORTING 

      it_transport_request    = it_transport_request 

      iv_tasklist_id          = iv_tasklist_id 

      iv_cycle_guid           = iv_cycle_guid 

      iv_change_guid          = iv_change_guid 

      iv_immediate            = iv_immediate 

      iv_check_4_creating_toc = iv_check_4_creating_toc 

    IMPORTING 

      et_check_result         = et_check_result 

      et_error_message        = et_error_message ). 

 

  ENDMETHOD. 

 

Save and activate the Method. 
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4.12.7 Central Customizing for Template Protection 

Customizing Parameters 

Within transaction SM30 you can open the Maintenance View /SALM/TPP_CUST. This will give you access to 

central customizing parameters. The following list shows you all parameters available. 

 

Parameter Description Values 

DISABLED Disable the Template Protection Globally X  Activated 

  Deactivated 

Conflict Handling 

Within transaction SM30, you can open the Maintenance View /SALM/TPP_SG_CHD. This will give you access to 

the conflict handling for the Global-Local Scenario. 

 

In the Field Global System, you will need to define the system, for which the locks have been maintained. The 

desired setting will be inherited to all assigned local systems. To define a System you can define the System ID 

and Client separated by : . You can also use wildcards, both for System ID and for Client. 

In the Field Event you need to define the related Template Protection Check. ONSAVE means the time when saving 

objects to a transport request, whereas ONRELEASE means the time when releasing Transport Requests. 

In the Field Handling you can define, whether a Warning message (W) or Error message (E) should be shown. 

Depending on the Type of Message, the process may be cancelled, so that the object cannot be saved or the 

transport request cannot be released. 

4.12.8 Maintenance of Locks in Template Protection 

You can reach the Maintenance of the Template Protection via the Transaction /SALM/TEMPLATE_PROTECTION. 

Please make sure to add /n at the beginning of the Transaction. 

The Template Protection consists out of the following parts: 

Menu Bar 
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Treeview 
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Details of the selected treeview item 

 

Maintain System Hierarchies 

On Global System level you define all Objects, which should be locked on that system. On Local System level you 

define, the systems, on which checks should be performed in order to secure the global objects. 

At the first step you need to create a global system. To do so, you need to click with the right mouse button the 

folder Scenario: Global/Local and select Add Global system. 

 

Define a System ID and a Client. You can use wildcards for both fields. 
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To assign a local system, click with right mouse button on the global system and define the system in the same 

way. 

 

You can also add a Whitelist. All Objects maintained for the Whitelist will be ignored as part of the Template 

Protection Checks 

 

Define Scope - Transport Request based Scoping 

On the level of global systems and on the whitelist you can perform a transport request based scoping. With that 

scoping, you have the possibility, to select a transport request, managed by charm, and assign all objects to the 

global system or whitelist. 

To do so, start the scope definition via the right mouse button: 

 

In the following popup, select Transport Request. 

 

Now you can define a transport request, which should be added to the Template Protection. The F4 Help will show 

you all transport requests, which are created on a system matching the pattern of the Global System. So if you, 
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for example, use L71:* as a global system, you will see all transport requests which are created on any client of L71 

and managed by ChaRM. 

 

Define Scope - Manual Scoping 

You can manually define objects for global systems and whitelists via manually entering the objects using the 

manual scoping 

To do so, start the scoping as shown in the transport request based scoping. 

In the following popup select Manual Selection. 

 

Now you have the possibility to maintain Workbench Objects via the Tab Workbench Objects. Wildcards are 

supported at the end of the Object Name. 

 

You can maintain Customizing Objects via the Tab Customizing Objects. Wildcards are supported at the end of 

the Table Key. If you want to maintain cross client customizing, you need to do this in a separate run and make 

sure to deactivate the checkbox Client specific customizing. 
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Delete Locks and Hierarchies 

To delete locks out of a whitelist or a global system, you first need to select the corresponding node. In the detail 

view you can then select and delete the locks. 

 

Make sure to save the deletion via the button Save. After saving you will see a confirmation popup. 

 

Once a node is completely empty, you can delete it via the right mouse button. 
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 Configuring Cross Landscape Distribution 

Use Cases 

The cross landscape distribution is used to distribute transports from one landscape to another landscape. 

There can be several use cases where this function might be helpful. 

 

Cross Landscape Functional Developments 

In this case you develop a custom development Package in one landscape and want to distribute the same 

functionality to other landscapes. E.g. Functions for User Maintenance or Basis Reports that should be available in 

all Landscapes. 

 

Global Functional Development 

In this case you have different Landscapes that depend on each other but don’t have a direct transport 

connections as the also differ in some major parts. You still want to distribute changes from one global 

development Landscape to other local landscape. 

 

The XLD Function therefore support 2 different major modes. 

 

Strict Mode 

In strict mode you can provide a list of development packages and customizing tables for checks that are 

executed during distribution and change workflows to validate what objects are allowed to be. 

 

Non-Strict Mode 

In Non-Strict mode the XLD will allow you to distribute any change to any landscape that is configured on Solution 

Manager. This mode provides a lot of flexibility to distribute changes across different landscapes. This mode also 

provides a high risk that users distribute changes across landscapes that should not be distributed. It is your 
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responsibility to ensure that only user with the knowledge what should be distributed are allowed to execute the 

XLD Wizard. 

 Note 

The XLD Function does not do any checks if the distributed objects are changed in the target system or 

not. It will always import the version from the source dev system into the target dev system. 

When you setup XLD it is your or user responsibility to only allow a distribution when there are now 

conflicts between the 2 Landscapes. The general rule should be that objects that are changeable in a 

source system should never be changeable in any of the target systems. 

 

Technically the XLD Functions follows the 4 Steps automatically. 

 Create a ToC from the Source Transport 

 Release ToC from the Source System and add it to the Queue of the Target System 

 Import the ToC in the Target System 

 Merge Object List from ToC with the Transport of the Target Change 

4.13.1 Roles and Authorization 

XLD Function uses the RFC Infrastructure of the SAP Solution Manager. In particular it requires TMW RFCs to 

each Development system that you want to distribute to. 

 

In each of those System the TMW RFC User requires these additional Authorization: 

 

Authorization Object:  

S_RFC 

ACTVT = 16 

RFC_NAME = TMW_GET_OPEN_TRANSPORTS, /SALM/CM_XLD_MERGE_REQUESTS, 

/SALM/CM_XLD_TRANSMIT_QUEUE 

RFC_TYPE = FUNC 

 

These authorizations are not added via solman_setup or lmdb when you create the RFCs. 

 

In the SAP Solution Manager there is a specific authorization required to execute the XLD Function. 

For this we have create a Role SAP_OST_CM_TRANSPORT_M that you need to assign to each user that is allow to 

execute the Cross Landscape Distribution. 

4.13.2 Package Distribution for Managed System 

For the XLD to function correctly you need to export the development package /SALM/CHARM_XLD_MS to each 

development System that you want to distribute to. 
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For this you need to do a “manual” Cross Landscape distribution. 

 

 Export the Package /SALM/CHARM_XLD_MS and all its Content from SAP Solution Manager into  a Transport 

or ToC 

 Import the Transport into all Development Systems between you want to allow distribution. 

4.13.3 Prerequisite for TMS RFC Free Setup 

Do be able to distribute with XLD transports between any 2 developments systems be default these development 

systems need to have a domain link between each other.  

 

Just in case you don’t want to create domain links between every development system (due to a very huge 

landscape) there is also an option do this without domain links. 

 

Let’s assume you have 2 Development systems TDV and TQA. You want to setup a distribution from TDV to TQA. 

Therefore you need to create on the domain controller for TDV an external System Instance with the system id 

TQA (can be done Tx:STMS  system overview) and on the domain controller for TQA you need to create an 

external systems instance with system id TDV. Both external systems need to share the same transport directory. 

 

Finally activate in the Basic Settings of view cluster /SALM/CM_XLDCFG the Imp. Que. synchronization. 
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4.13.4 Customizing Cross Landscape Distribution 

For the Customizing there are 2 view cluster configured that can be access via SPRO or SM34. 

 

1. View Cluster for Customizing /SALM/CM_XLDCFG 

2. View Cluster for Master data /SALM/CM_XLDOBJ 

 

Changes in in the Customizing Cluster have to be recorded into a transport whereas all changes in the Master 

data Cluster can be done directly in the Productive Solution Manager. 

4.13.4.1 View Cluster for Customizing /SALM/CM_XLDCFG – 
Basic Settings 

Here you can set some basic customizing flags. 

 

Active = Activate XLD 

Open TR = Allow distribution of open transports (default is that only released transports can be distributed) 

Strict M. = Activate the Strict Mode for XLD. In Strict Mode only objects that are defined in the Master Data 

Settings can be distributed. It also allows to configure a consistency change that validates of all of those objects 

are correctly distributed. 

Imp. Que. = This is required to synchronies import queues when the target and source system use different 

transport directories. 
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4.13.4.2 View Cluster for Customizing /SALM/CM_XLDCFG – 
Target Change Documents 

When you run the XLD with selection for change documents. You can customize with this table what type of 

change documents are allowed and in what status they have to be. 

 

4.13.4.3 View Cluster for Customizing /SALM/CM_XLDOBJ – 
Allowed Target Change Cycle 

When you run the XLD with selection for change documents you need to select a change cycle. This customizing 

folder allows you to filter the displayed change cycles. If this table is empty all active change cycles are displayed. 
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4.13.4.4 View Cluster for Customizing /SALM/CM_XLDOBJ – 
Allowed Target Systems 

When you run the XLD with selection for transports you need to select a target system. This customizing folder 

allows you to filter the displayed target systems. If this table is empty all target systems are displayed that have 

been marked as development system in any of the logical component groups. 

 

4.13.4.5 View Cluster for Customizing /SALM/CM_XLDOBJ – 
Activate Blacklist Mode for Systems 

When you use the XLD with strict mode you can define here in which mode you want to define the object lists. 

 

 Whitelist (Flag is not set), you need to define all objects that should be allowed to be distributed. 

 Blacklist (Flag is set), you need to define the objects that are not allowed to be distributed. All objects that are 

not defined in the Blacklist can then be distributed. 
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4.13.4.6 View Cluster for Customizing /SALM/CM_XLDOBJ – 
Workbench Strict Mode Packages 

Workbench Objects can only be specified via Development Package. The setting here will then be valid for all 

objects in this Package. You can specified for each Package a Source (First Column) and Target System (3rd 

Column). If you need to distribute objects from one package to multiple systems you need to add multiple lines for 

the same package with different target systems. 

The last column you can temporally deactivate a package setting. 

 

4.13.4.7 View Cluster for Customizing /SALM/CM_XLDOBJ – 
Customizing Strict Mode Groups 

Customizing Objects (Tables, Views etc.) have to be defined in Customizing Groups. For this purpose you can 

create a new Group with a Group ID, Group Name and Group Description. IN the Subfolders you can then assign 

the customizing objects and target or source systems. 
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4.13.4.8 View Cluster for Customizing /SALM/CM_XLDOBJ – 
Assigned Customizing Obj. 

Is a subfolder for customizing groups and here you can define the customizing objects. 

 

A Customizing transport object is classified uniquely by its master type and master name. There are four master 

types, which also contain subobjects: 

 

View cluster master type CDAT -  A view cluster can contain multiple views as subobjects. 

View master type VDAT - A view can contain multiple tables as subobjects. Table content master type TDAT 

The master type TDAT - can contain multiple tables as subobjects. 

Table content master type TABU - The master type TABU references exactly one table. 

 

Examples: 

 

Master type object R3TR CDAT: 

Column Name Value 

PGID R3TR 

Obj. Type TABU 

Object Name SCMGATTRPROFA 

Table Name SCMGATTRPROFA 

Master Name SCMGVC_ATTRPROF 

Master Type CDAT 

Viewname SCMGV_ATTRPROFA 

 

This definition of a transport object references the view SCMGV_ATTRPROFA as a subobject of the view cluster 

SCMGVC_ATTRPROF. The table is part of the view SCMGV_ATTRPROFA. 
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Master type object R3TR VDAT: 

Column Name Value 

PGID R3TR 

Obj. Type TABU 

Object Name BAOPHASE 

Table Name BAOPHASE 

Master Name V_BAOPHASE 

Master Type VDAT 

Viewname V_BAOPHASE 

 

This definition of a transport object references the view V_BAOPHASE. This object describes only those entries in 

table BAOPHASE. The table is part of the view V_BAOPHASE. If you want to include all tables of a view you can also 

use a * entry as Table Name. 

 

Master type object R3TR TDAT: 

Column Name Value 

PGID R3TR 

Obj. Type TABU 

Object Name BAOPHASE 

Table Name TBDBE 

Master Name BDBG 

Master Type TDAT 

Viewname * 

 

This definition of a transport object references the TDAT object BDBG. The table is part of the master type object 

BDBG. 

 

Master type object R3TR TABU: 

Column Name Value 

PGID R3TR 

Obj. Type TABU 

Object Name UST04 

Table Name UST04 

Master Name UST04 
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Column Name Value 

Master Type TABU 

Viewname * 

 

This definition of a transport object references the TABU object UST04. The table is the entire content of the 

master type object UST04. 

 

For examples of client-specific transport objects and their subobjects, see table E071K (transaction SE16). 

 

4.13.4.9 View Cluster for Customizing /SALM/CM_XLDOBJ – 
Target & Source Systems 

In this customizing setting you can assign the target and source system for the selected customizing group. It is 

possible to add multiple target systems if required. 
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 Configuring Electronic Signature for Change Request 
Management 

The purpose of this document is to describe the Electronic Signature for CHARM functionality and configuration. 

This functionally might be used especially in controlled systems where a legally binding electronic signature is 

required for specific approvals and process steps. 

There for the Signature fulfills the requirements for Electronic Records and Electronic Signatures provided in 

Code of Federal Regulations Title 21 

(http://www.accessdata.fda.gov/scripts/cdrh/cfdocs/cfcfr/CFRSearch.cfm?CFRPart=11&showFR=1)  

Offical paragraphs that are applicable: 

21 CFR §11.10(e) System must assure that record changes (create, modify, delete) do not obscure previously 

recorded information by implementing secure, computer-generated, time-stamped audit trails. These audit 

trails must be retained for as long as the subject electronic records and be available for review and copying. 

21 CFR §11.100(a) & §11.300(a) System must ensure that each electronic signature be unique to one 

individual and not reused by, or reassigned to, anyone else. 

21 CFR Part §11.200(a, 1) System must assure that any electronic signature not based on biometrics must 

employ at least two distinct components (e.g., ID code and password) 

21 CFR §11.200(a, 1, ii) System must enforce workflows such that an individual executing one or more 

signings not performed during a single, continuous period of controlled system access, will execute each 

signing using all of the electronic signature components. 

21 CFR Part §11.300(e) Any devices that bear or generate identification code or password information must 

be tested to ensure that they function properly and have not been altered in an unauthorized manner. 

 

 

The Electronic Signature supports to Signature Scenarios in Change Request Management. 

 During an Approval Step, that uses the Approval Procedure. 

 During any Status switch within a change request or change document executed via actions. 

http://www.accessdata.fda.gov/scripts/cdrh/cfdocs/cfcfr/CFRSearch.cfm?CFRPart=11&showFR=1
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4.14.1 Activating the Piece List 

Call transaction SCC1 in your working client and activate the piece list /SALM/CHARM_EXT, which will supply 

your system with the predefined customizing. The result of this activation can be verified in transaction SCC3. 

4.14.2 Roles and Authorization 

Special Authorization to Execute Electronic Signature 

 

To execute a digital signature there is an additional authorization C_SIGN object required 

 

The Authorization Object requires the following Attributes: 

 

Object Attribute Value 

C_SIGN Activity 73 

 Application of the Digital Sig /SALM/CR 

 Digital Signature Object /SALM/CR 

The authorization is not included in a Role and need to be manually added when activating the electronic 

signature. 

4.14.3 Creating and Validating the Signature Object 

 Go to SM30 open View SIGNAPPL_V 

 

Validate that the Application Object /SALM/CR is available 

 Go to transaction ELSIG03N  
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Validate that Signature Object /SALM/CR is available and is set to System Signature with Authorization by SAP 

User ID/Password. 

 Go to SM30 open View SIGNOBJECT_V 

 

Validate that Appl. /SALM/CR with Object /SALM/CR is available and contains the following entries: 

Column Name Value 

Mata Table /SALM/DS_CR 

LogStruct. /SALM/DS_LOG 

Comment Possible 

Remark Possible 

Document Possible 

Description Signature for Change Management 

4.14.4 Activating Electronic Signature for the Approval 
Assignment Block 

To activate the Electronic Signature for an Approval Assignment Block you need to add a customizing entry to the 

table /salm/c_itr. 

 

You can define up to 10 different transaction types where you want to activate digital signature with attribute 

names DSIGTYP0 to DSIGTYP9. 
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Provide your CHARM Transaction Types such as SMCR or ZMCR. All transaction types for CHARM are possible. 

 

 

 

4.14.5 Activating Electronic Signature for an Action from the 
Action Profile 

You can assign the electronic signature with this customizing to any action from a change request or change 

document only. For this purpose, you need to call maintenance view AICV_UI_POPUP via SM34 or SPRO 

 

Add an entry for each action you want to add the electronic signature. 

Column Name Value Example 

Transaction Type Transaction Type of your 

transaction you like to add 

SMCR 

Action Profile Action Profile name from your 

transaction  

SMCR_ACTIONS 

Action Definition This is the actual technical name 

of the action you like to add the 

signature to 

SMCR_QUALIFY_CHANGE 

Sequence Sequence of the action in the 

action profile 

10 

BSP UI Component This is the signature /SALM/DS_SIGN 
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Column Name Value Example 

BSP Interface This is the signature interface /SALM/DS_SIGN/MainWindow 

BSP UI Usage This is the usage linked in 

/SALM/CMCR_H and 

/SALM/CMCD_H. You need to 

use these 2 components to use 

any Change Request 

Management enhancement 

CUSALMDIGITALSIGNATURE 

PPF Container Element Not used  

PPF Data Container Class Not used  

Dialog Window title (OTR Alias) OTR Alias for the popup title /SALM/CHARM_DS/POPUP_TITLE 

Before PPF Call Signature must be executed 

before the action. If the signature 

fails, action will not be executed 

Checked 

After PPF Call Do not use Not checked 

Activate Activate the customizing settings checked 

 



 

Focused Build for SAP Solution Manager 

Appendix 

 CUSTOMER  

© 2018 SAP SE or an SAP affiliate company. All rights reserved.  253 

 

5 Appendix 

 Useful SAP Notes 

SAP Note No. Description 

1384598 Information about the new remote infrastructure  

1803899  Report /RPM/CUST_TABLES_COPY deletes customizing entries  

907768  Change Request Management: Information about the required support package levels of 

managed systems  

2257213 Information about authorizations for SAP Solution Manager RFC users  

1483276 Use of Customizing Parameters in DNO_CUST04, AGS_WORK_CUSTOM and 

ICT_CUSTOM 

1604651 Bad Performance when loading runtime repositories 

1586185  Project selection fails for some transaction types 

2427162 Focused Build - Application not responding in Chrome browser 

2447548 Report for Replacing Ibase component in documents 

2456627 Document Type Administration Dump Object Types with Namespace 

 Adjust Category Schema 

 Launch Change and Release Management 

 

 Select Service Operations  Categorization Schemas 

http://service.sap.com/sap/support/notes/1384598
http://service.sap.com/sap/support/notes/1803899
http://service.sap.com/sap/support/notes/907768
http://service.sap.com/sap/support/notes/2257213
http://service.sap.com/sap/support/notes/1483276
http://service.sap.com/sap/support/notes/1604651
http://service.sap.com/sap/support/notes/1586185
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 Search for Schema ID: 'FOCUSED_BUILD', select the active one and then Create Version button 

 

 Select parent category you would like to create a new category for, then 'New'. Adjust new Category ID 

following existing naming convention and enter Name and Description. 

 

 To activate new version select the root ID of the Schema, enter Valid-From Date and Time and set Status to 

released.  
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The Schema will be available for new documents starting from specified Valid-From Date and Time. 

 Mandatory Standard Configuration for Test Suite 

In order to use Test Suite as part of the Requirement-to-deploy scenario in Focused Build ensure that at least 

following standard configuration tasks have been completed successfully. 

5.3.1 Test Classification 
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5.3.2 Analytics for Test Suite 

 

5.3.3 Analytics for ITSM 

This is required to get the data for Defect Management into BW. 

 Call transaction: SOLMAN_SETUP 

 Select Scenario IT Service Management 

 Step 4.1 

 

 

 Step 4.2 
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 Activating BAdI for Related Transaction in Solution 
Documentation Attributes Panel 

To change the visibility of related transactions in the attribute pane of structure elements such as for instance 

business process or business process step, follow the steps described below. 

 

Run transaction SM_WORKCENTER and select Configuration All Scenarios. 

 

Select Process Management and navigate to the chapter 6 Configure Solution Documentation Management. 

 

Select Process Management and navigate to the chapter 6 Configure Solution Documentation Management (ST < 

SP03) or 5 Configure Solution Documentation Management for systems on > SP03 
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De-select all potentially active implementations and activate   /SALM/SMUDE_LCO_BR BAdI implementation for 

requirements of ST-OST. 

 Package and Namespace Selection in bc-Set Activation 

If you are uploading and/or activating a bc-set in the scope of Focused Build you will be asked to select an 

appropriate package. 

Mostly you can use /SALM/CORE. 

 Language Settings 

Ensure that the default language for your browser is English: 
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 Hints and Pitfalls Regarding Virus Scan Profiles 

• Please refer to 

http://help.sap.com/saphelp_smp304svr/helpdata/en/7c/2d509370061014a2af8bb629919d56/content.h

tm?frameset=/en/6e/0e4c04ebf445e79fb57230a2fb4fa3/frameset.htm&current_toc=/en/7c/1feb92700

610148db1c136782f3f1f/plain.htm&node_id=262&show_children=false 

• Check if a virus scanner is defined in transaction VSCAN 

• Check virus scan profile in transaction VSCANPROFILE 

 Delete of obsolete projects 

After initially creating the project templates, the used projects can be deleted that they don’t appear in the 

Solution Readiness Dashboard. 

A prerequisite for deletion of projects is that the project is still in status CREATED. 

Just enter the project in Read only modus, select the top node of the project tree and press Delete. 

  



 

260 

CUSTOMER  

© 2018 SAP SE or an SAP affiliate company. All rights reserved. 

Focused Build for SAP Solution Manager 

Appendix 

 

 Adapting Project Reasons 

In project management, you can select various project reasons: 

 

You can configure the project reasons in Customizing. To adapt project reasons, do the following: 

 In the Customizing for SAP Solution Manager, choose SAP Customizing Implementation Guide → SAP 

Portfolio and Project Management → Project Management → Structure. → Define Project Reason. 

 Change the reasons for projects. 

 User Roles, Authorizations and Business Partners 

5.10.1 Authorization Roles and Users in SAP Solution 
Manager System 

Each employee who is involved in the Requirement-to-Deploy process needs an own user in the SAP Solution 

Manager system to be able to access the system. 

It must be clarified with the customer who (customer himself or partner or you as delivery team) will create and 

configure the needed authorization roles and users. 

Further information about the definition of users and authorization roles for Focused Build can be found in the 

Focused Build for SAP Solution Manager Security Guide.  

Authorization Roles 

With Focused Build the following composite roles get delivered for the Requirement-to-Deploy process: 

SAP_OST_FB_ARCHITECT_COMP 

SAP_OST_FB_ ANALYST_COMP 

SAP_OST_FB_DEV_COMP 

SAP_OST_FB_PROJ_M_COMP 

SAP_OST_FB_REL_M_COMP 

SAP_OST_FB_TESTER_COMP 

SAP_OST_FB_TEST_M_COMP 

SAP_OST_FB_TOOLLEAD_COMP 
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Beside below exceptions all these composite roles, including the single roles have to be copied into the customer 

(Z*) namespace.  

Exceptions: From the included single roles the following ones are ‘only’ used as navigation roles and should not be 

copied but to be used as they are: 

SAP_BPR_PPM 

SAP_OST_SM_CRM_UIU_ARCHITECT 

SAP_OST_SM_CRM_UIU_DEV 

SAP_OST_SM_CRM_UIU_PROJ_M 

SAP_OST_SM_CRM_UIU_REL_M 

SAP_OST_SM_CRM_UIU_SM_PRO 

SAP_OST_SM_CRM_UIU_TEST_M 

SAP_OST_SM_CRM_UIU_TESTER 

SAP_OST_SM_CRM_UIU_TOOLLEAD 

 

Use transaction PFCG to  

• copy the roles 

• generate the profiles (leave configuration as is). 

 

Template Users 

Use transaction SU01 to create the following template users for Focused Build and to assign the needed roles: 

User Last name First Name Composite Role 

ARCHITECT1 Template User Solution Architect 1 ZSAP_OST_FB_ARCHITECT_COMP 

ARCHITECT2 Template User Solution Architect 2 ZSAP_OST_FB_ARCHITECT_COMP 

ANALYST1 Template User Analyst 1 ZSAP_OST_FB_COMP_ANALYST_COMP 

ANALYST 2 Template User Analyst 2 ZSAP_OST_FB_COMP_ANALYST_COMP 

DEVELOPER1 Template User Developer 1 ZSAP_OST_FB_DEV_COMP 

DEVELOPER2 Template User Developer 2 ZSAP_OST_FB_DEV_COMP 

PROJMAN1 Template User Project Manager 1 ZSAP_OST_FB_PROJ_MANAGER_COMP 

PROJMAN2 Template User Project Manager 2 ZSAP_OST_FB_PROJ_MANAGER_COMP 

RELMAN1 Template User Release Manager 1 ZSAP_OST_FB_REL_MANAGER_COMP 

RELMAN2 Template User Release Manager 2 ZSAP_OST_FB_REL_MANAGER_COMP 

TESTER1 Template User Tester 1 ZSAP_OST_FB_TESTER_COMP 

TESTER2 Template User Tester 2 ZSAP_OST_FB_TESTER_COMP 

TESTCOORD1 Template User Test Coordinator 1 ZSAP_OST_FB_TEST_COORD_COMP 

TESTCOORD2 Template User Test Coordinator 2 ZSAP_OST_FB_TEST_COORD_COMP 
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User Last name First Name Composite Role 

TOOLLEAD1 Template User Tool Lead 1 ZSAP_OST_FB_TOOLLEAD_COMP 

TOOLLEAD2 Template User Tool Lead 2 ZSAP_OST_FB_TOOLLEAD_COMP 

 

Users 

Transaction BP_USER_GEN can be used to create further users if they already exist in another system. Within this 

transaction, the users created in chapter 0 can be used as template user to create further users.  

 

5.10.2 Authorization Roles and Users in Systems Belonging to 
the Project 

Dependent on his role, each employee who is involved in the Requirement-to-Deploy process might need an own 

user in the different systems involved in the project. Which authorizations / roles the different users need 

depends on the project, role and application.  

User Dev Test Maint QA PreProd Prod 

Architect X X X X X X 

Analyst X X X X X X 

Developer X X X X X  

Project Manager X X X X X x 

Release Manager X X X X X X 
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User Dev Test Maint QA PreProd Prod 

Tester  X  X   

Test Coordinator X X X X X  

Tool Lead X X X X X X 

 

Which authorizations the users get in which of the respective systems has to be verified with the project team. 

5.10.3 Defining Business Partners 

For each party that is involved in the CRM based transactions of the Requirement-to-Deploy process a business 

partner is needed. For the employees, the business partners can be created using transaction BP_GEN (a variant 

of transaction BP_USER_GEN). 

Create business partners to the template users created in chapter Authorization Roles and Users in SAP Solution 

Manager System  Template Users: 

 Run transaction BP_GEN 

 Choose RFC Destination NONE  

 Using multiple selection, select the template users  

 Choose Execute to create the business partners  

  

 If the protocol of the test run indicates no errors, go back to the selection screen, remove the check mark to 

Test Mode, and execute it again 

 Repeat the same for each relevant RFC destination (pointing to the systems involved with the project – see 

also chapter Authorization Roles and Users in SAP Solution Manager System  Template Users) with the 

same users 
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The business partners can be checked and manually adapted in transaction BP. For Requirement-to-Deploy it is 

important that the business partner exists with the BP roles Business Partner (Gen.), Contact Person and 

Employee: 

 

In BP role Business Partner (Gen.) on tab Identification, entries to all systems in which the user should be able to 

create requirements, test defects, etc. are shown. Entries have to be maintained according to the following 

specifications: 

IDType  CRM001 

Identification Number <SysID><blank><installation number><blank><client><blank><user> 

 

 Organizational Model (optional) 

Create an organization model in the SAP Solution Manager that represents an extract of the customer’s 

organization covering the Requirement-to-Deploy process. If you want to create a new Root Unit, call transaction 

SPRO and create a new Root Unit via IMG activity highlighted below: 
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If you would like to enhance an existing organization model you can directly use transaction PPOMA_CRM to do so. 

To create new organizational units and positions always select the upper organizational unit, click on Create and 

then choose either Organizational Unit or Position: 

 

Name the new unit respectively. 
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To assign business partners to the positions select the respective positions, click on Assign upper organizational 

unit, click on Create and then choose Business partner: 

 

Assign the respective business partner. 

Create the bellow organizational units and assign the respective positions and users/BPs: 

<Company> 

Business Unit A 

Financials 

Position: Analyst 

BP Analyst 1 

Position: Key User 

BP Tester 1 

Logistics 

Position: Analyst 

BP Analyst 2 

Position: Key User 

BP Tester 2 

IT 

Application Management 

Position: Tool Lead 

Financial 

Position: Architect 

BP  Architect 1 

Position: Developer 

BP Developer 1 

Position: Test Coordinator 

BP Test Coordinator 1 

Logistics 

Position: Architect 

BP  Architect 2 

Position: Developer 

BP Developer 2 

Position: Test Coordinator 

BP Test Coordinator 2 
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Operations 

Support 

PMO 

Position: Project Manager 

BP Project Manager 1 

BP Project Manager 2 

 

 Multitenancy Enhancement 

5.12.1 Report /SALM/ITSM_MT_BP_AUTH_GRP 

This report can be used to automatically assign authorization groups to business partners according to their 

position in the organizational structure. It is covered in the chapter titled, Assign Authorization Groups to 

Business Partners. 

Start report 

Open report via SPRO (SAP Solution Manager → Focused Build → Change Control Extensions → Multi Tenancy 

Extensions → Update Business Partner Authorization Groups) or transaction SE38 (Report Name 

/SALM/ITSM_MT_BP_AUTH_GRP) 
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Processing Modes 

Testmode  

As long as test mode is activated (checked) to changes will be written to database tables. 

You can use this mode to check, which business partners would be changed. You will also get a list of business 

partner which are assigned to more than one root organization. Within the same organization a business partner 

can be assigned several times. 

Assign authorization groups 

Authorization group will be updated by analyzing the current organizational assignment of existing business 

partners 

Delete authorization group assignments 

The value for business partner authorization group will be deleted for all business partners which are considered. 

This means that afterwards they do not have an authorization group. 

Business Partner 

Only assigned business partners  

With this open checked only business partner who are assigned to an organization are taken in to account. 

Unassigned business partners will be ignored.  

If you uncheck this option all unassigned business partners will get the configured default authorization group 

(refer to Customize Default Authorization Group). 

Root organizations 

The root organizations will be prefilled with your customized root organizations (see chapter Assign Authorization 

Groups to Root Organizations). In general there’s no need to change it. 

Please note, that added organizations need to be defined as root. Otherwise, they will be ignored. 

Business partner 

This search option for business partners is prefilled with *, which means that all business partners will be checked. 

Only business partner who match this criteria, will be taken into consideration. All others are ignored. 

If you want to perform the update for one or some specific business partners only, add a list here. 
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Necessary Authorizations 

The user who executes the report will probably need additional authorizations. Therefore, you need to create an 

authorization role in transaction PFCG. 

Authorization Object Authorization Values Comment 

S_TCODE Transaction Code     /SALM/MT_BP_AUTHGRP enter the report via 

transaction 

PLOG Infotype             * 

Planning Status      * 

Object Type          * 

Plan Version         01 

Function Code        DISP 

Subtype              * 

Read Business Partner data 

for processing 

B_BUPA_GRP Activity             02, 03 

Authorization Group  * 

Change authoriatzion group 

of business partner in 

database 

B_BUPA_RLT Activity             02, 03 

BP Role              * 

Change authoriatzion group 

of business partner in 

database 
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